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A guide for administrators and advanced users dealing with Red Hat JBoss BPM Suite setup,
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CHAPTER 1. BUSINESS PROCESS MODEL AND NOTATION
Business Process Model and Notation (BPMN) is a standard notation for business process modeling. It
aspires to link the gap between business analysts and programmers by providing a workflow language
that can be clearly understood by both.

1.1. COMPONENTS

Red Hat JBoss BPM Suite integrates multiple components to support business processes throughout
their entire life cycle and to provide process management features and tools for business analysts,
developers, and business users. The product can be deployed on various JEE-compliant servers; the
recommended option is Red Hat JBoss Enterprise Application Platform 6.

Red Hat JBoss BPM Suite consists of the following main components:

Execution Engine: Provides the runtime environment for Processes and Business Rules. It
encompasses a workflow library that can be embedded into a user web application. Runtime
manager is the root object and contains the following components:

Runtime Engine: Implements the core behavior of the computer language and it is provided
by the runtime manager.

Process Engine: The environment for business process model execution.

Task Service: Handles human task lifecycles.

Rule Engine: Can be used with the process engine or on its own.

Rules Evaluation: Executes business rules on the provided set of facts.

Complex Event Processing : Applies business rules on incoming stream of events.

Business Central: A web-based application that accommodates tooling for asset creation,
management, and monitoring by providing an integrated web environment.

Asset Repository: The central sharing location (Knowledge Store) for business assets,
processes, rules, forms, etc. Users access this repository through the Project Explorer view
of Business Central via Authoring → Project Authoring. By default, the product initializes a
local GIT repository as its Asset Repository. However, other repositories may be added or
removed as necessary.

Artifact Repository: A Maven based repository for storage of project jar artifacts.

Execution Server : Provides an execution environment for business process instances and
tasks.

Business Activity Monitor: Provides customizable view on business performance.

NOTE

Red Hat JBoss BRMS comes with its own Business Central application that is a subset of
the Business Central application in Red Hat JBoss BPM Suite.

1.2. PROJECT

A project is a container for asset packages (business processes, rules, work definitions, decision tables,
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fact models, data models, and DSLs) that lives in the Knowledge Repository. It is this container that
defines the properties of the KIE Base and KIE Session that are applied to its content. In the GUI, you
can edit these entities in the Project Editor.

As a project is a Maven project, it contains the Project Object Model file (pom.xml) with information on
how to build the output artifact. It also contains the Module Descriptor file, kmodule.xml, that contains
the KIE Base and KIE Session configuration for the assets in the project.

1.3. CREATING PROJECT

It is possible to create a project either in the Project Authoring  perspective of Business Central or using
the REST API calls.

Creating Project in Business Central

IMPORTANT

Note that only users with the admin role in Business Central can create projects.

Procedure: Using Business Central to Create Project

1. In Business Central, go to Authoring → Project Authoring.

2. In the Project Explorer, select the organizational unit and the repository in which you want to
create the project.

3. On the perspective menu, click New Item → Project.
The New Project dialog window opens.

CHAPTER 1. BUSINESS PROCESS MODEL AND NOTATION
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4. Define the Project General Settings and Group artifact version  details of the new project. These
parameters are stored in the pom.xml Maven configuration file.
See the detailed description of the parameters:

Project Name: name of the project (for example MortgageProject).

Project Description: description of the project, which may be useful for the project
documentation purposes.

Group ID: group ID of the project (for example org.mycompany.commons).

Artifact ID: artifact ID unique in the group (for example myframework). Avoid using a space
or any other special character that might lead to an invalid name.

Version: version of the project (for example 2.1.1).

5. Click Finish.
The project screen view is updated with the new project details as defined in the pom.xml file.
You can switch between project descriptor files and edit their content by clicking the Project
Settings: Project General Settings button at the top of the project screen view.

Creating Project Using REST API

IMPORTANT

Note that only users with the rest-all or rest-project role can create projects.

To create a project in the repository, issue the POST REST API call. Details of the project are defined by
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To create a project in the repository, issue the POST REST API call. Details of the project are defined by
the corresponding JSON entity.

Input parameter of the call is an Entity instance. The call returns a CreateProjectRequest instance.

Example 1.1. Creating Project Using Curl Utility

Example JSON entity containing details of a project to be created:

{
  "name"        : "MortgageProject",
  "description" :  null,
  "groupId"     : "org.mycompany.commons",
  "version"     : "2.1.1"
}

Execute the following command:

curl -X POST 'localhost:8080/business-central/rest/repositories/REPOSITORY_NAME/projects/' -
u USERNAME:PASSWORD -H 'Accept: application/json' -H 'Content-Type: application/json' -d 
'{"name":"MortgageProject","description":null,"groupId":"org.mycompany.commons","version":"2.1.1"
}'

For further information, refer to chapter Knowledge Store REST API , section Repository Calls of the Red
Hat JBoss BPM Suite Development Guide.

1.4. ADDING DEPENDENCIES

To add dependencies to your project, do the following:

1. Open the Project Editor for the given project:

a. In the Project Explorer view of the Project Authoring perspective, open the project
directory.

b. Click Open Project Editor to open the project view.

2. In the Project Screen view, select in the Project Settings drop-down box the Dependencies
item.

3. On the updated Project Screen, click the Add button to add a maven dependency or click the
Add from repository button to add a dependency from the Knowledge Store (Artifact
repository):

a. When adding a maven dependency, a user has to define the Group ID, Artifact ID and the 
Version ID in the Dependency dialogue window.

b. When adding a dependency from the Knowledge Store, select the dependency in the
displayed dialog box: the dependency will be added to the dependency table.

4. To apply the various changes, the dependencies must be saved.

Additionally, you can use the Package white list when working with dependencies. When you add a
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Additionally, you can use the Package white list when working with dependencies. When you add a
repository, you can click the gear icon and select Add all or Add none, which results in including all or
none of the packages from the added dependency.

WARNING

If working with modified artifacts, do not re-upload modified non-snapshot artifacts
as Maven will not know these artifacts have been updated, and it will not work if it is
deployed in this manner.

1.5. CREATING PACKAGE

To be able to import resources and reference them, create your resources, including processes, in a
package of a particular project. To create a package:

1. In Project Explorer, locate the project in which you want to create a package and open the
Repository View. Navigate to the src/main/resources/ directory.

2. Click New Item → Package.

3. In the Create New Package dialog window, enter a name of the package. The location of the
package in the repository is already correctly set in the text box below.

To add resources into the newly created package, make sure to select the package when creating the
resource.

For more information about creating processes, see Chapter 9, Process Creation, Import, and Export .
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CHAPTER 2. BUSINESS CENTRAL CONFIGURATION
All Business Central configuration settings are loaded from the 
EAP_HOME/standalone/deployments/business-central.war/WEB-INF/web.xml file. If you deploy
Business Central on Red Hat JBoss EAP server, files jboss-web.xml and jboss-deployment-
structure.xml contain configuration settings as well.

NOTE

Business Central can be run on different platforms. For more information, see Red Hat
JBoss BPM Suite Installation and Configuration Guide.

2.1. ACCESS CONTROL

The access control mechanism includes authorization and authentication. To grant a specific user
access to Red Hat JBoss BPM Suite, the user needs to have the respective roles assigned:

admin: Administrates Red Hat JBoss BPM Suite system and has full access rights to make any
changes necessary, including the ability to add and remove users from the system.

analyst: Creates and designs processes and forms, instantiates the processes, and deploys
artifacts. This role is very similar to the developer role, with the exception that analysts do not
have access to the asset repository and deployments.

developer: Implements code required by processes. Users with this role cannot access
administration tasks.

user: Claims, performs, and invokes other actions, such as escalation and rejection, on the
assigned tasks. The user role grants no access to authoring functions.

manager: Monitors the system and its statistics. Users with this role can access only
dashboards.

Creating users is described in section Creating Users of the Red Hat JBoss BPM Suite Installation and
Configuration Guide.

Roles assigned to a user can be updated in the EAP_HOME/standalone/configuration/application-
roles.properties file.

Workbench Configuration
Within Red Hat JBoss BPM Suite, users may set up roles using LDAP to modify existing roles. Users may
modify the roles in the workbench configuration to ensure the unique LDAP based roles conform to
enterprise standards by editing the deployments directory located at 
JBOSS_HOME/standalone/deployments/business-central.war/WEB-INF/classes/workbench-
policy.propeties.

If authenticating user via LDAP over Git, administrators must set system property org.uberfire.domain
to the name of login module it should use to authenticate users via the Git service. This must be set in
the standalone.xmlfile in EAP.

NOTE
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NOTE

You can further customize Business Central with parameters no_build or no_search. The
parameters disable the build and search functionality. Include one or both parameters in
the Business Central URL, for example http://SERVER:PORT/business-central/kie-
wb.jsp?no_build&no_search.

Authentication in Human Tasks
Every Task that needs to be executed is assigned to one or multiple roles or groups, so that any user
with the given role or the given group assigned can claim the Task instance and execute it. Tasks can
also be assigned to one or multiple users directly. JBoss BPM Suite uses the UserGroupCallback
interface to assign tasks to user.

WARNING

A group for a Human Task must not be named after an existing user of the system.
Doing so causes intermittent issues.

LDAP Configuration
You can configure LDAP domain during the installation of Red Hat JBoss BPM Suite. See the Red Hat
JBoss BPM Suite Installation Guide for further information. When already installed, Business Central
uses JBoss Security Domains defined in 
EAP_HOME/standalone/configuration/standalone/configuration/standalone.xml by default. The
security domain is referenced in business-central.war/WEB-INF/jboss-web.xml.

To configure LDAP on your existing Red Hat JBoss BPM Suite installation:

1. Define an LDAP security domain.

a. In standalone.xml, locate <security-domains>.

b. Add your login module:



<!-- Including an LDAP based security domain to enable LDAP based authentication and 
authorization for users of Business Central console  -->
 1
 <security-domain name="ldap" cache-type="default">
  <authentication>
   2
   <login-module code="org.jboss.security.auth.spi.LdapExtLoginModule" flag="required">
    <module-option name="java.naming.provider.url" value="ldap://10.10.10.10:389"/>
    <module-option name="java.naming.factory.initial" 
value="com.sun.jndi.ldap.LdapCtxFactory"/>
    <module-option name="java.naming.security.authentication" value="simple"/>
    <module-option name="bindDN" value="uid=admin,ou=system"/>
    <module-option name="bindCredential" value="secret"/>
    <module-option name="baseCtxDN" value="ou=People,dc=jboss,dc=org"/>
    <module-option name="baseFilter" value="(uid={0})"/>
    <module-option name="rolesCtxDN" value="ou=Groups,dc=jboss,dc=org"/>
    <module-option name="roleFilter" value="(member={0})"/>
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1

2

Name of your security domain referenced in jboss-web.xml.

A required attribute for external LDAP authentication.

For more information about the LDAP login module, see Ldap Login Module from the Red
Hat JBoss EAP Login Module Reference.

c. Locate <hornetq-server> and add the following lines:

d. Refer to your LDAP security domain in jboss-web.xml:

2. If you require LDAP integration in task services, provide the task service configuration.

a. Open EAP_HOME/standalone/deployments/business-central.war/WEB-INF/beans.xml.

b. Change <class>org.jbpm.services.cdi.producer.JAASUserGroupInfoProducer</class>
to <class>org.jbpm.services.cdi.producer.LDAPUserGroupInfoProducer</class>.

c. Create a jbpm.usergroup.callback.properties file in 
EAP_HOME/standalone/deployments/business-central.war/WEB-
INF/classes/jbpm.usergroup.callback.properties and provide your usergroup callback
properties, for example:

java.naming.provider.url=ldap://localhost:10389
ldap.bind.user=uid\=admin,ou\=system
ldap.bind.pwd=secret
ldap.user.ctx=ou\=People,dc\=jboss,dc\=org
ldap.role.ctx=ou\=Groups,dc\=jboss,dc\=org
ldap.user.roles.ctx=ou\=Groups,dc\=jboss,dc\=org
ldap.user.filter=(uid\={0})
ldap.role.filter=(cn\={0})
ldap.user.roles.filter=(member\={0})
ldap.search.scope=SUBTREE_SCOPE

d. Create a jbpm.user.info.properties file in 

    <module-option name="roleAttributeID" value="cn"/>
    <module-option name="roleNameAttributeID" value="cn"/>
    <module-option name="roleRecursion" value="2"/>
    <module-option name="roleAttributeIsDN" value="false"/>
    <module-option name="parseRoleNameFromDN" value="false"/>
    <module-option name="java.naming.referral" value="follow"/>
    <module-option name="searchScope" value="SUBTREE_SCOPE"/>
   </login-module>
  </authentication>
 </security-domain>
...

<security-domain>ldap</security-domain>
<security-enabled>true</security-enabled>

<jboss-web>
    <security-domain>ldap</security-domain>
</jboss-web>
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d. Create a jbpm.user.info.properties file in 
EAP_HOME/standalone/deployments/business-central.war/WEB-
INF/classes/jbpm.user.info.properties and provide your user info properties, for example:

java.naming.provider.url=ldap://localhost:10389
ldap.bind.user=uid\=admin,ou\=system
ldap.bind.pwd=secret
ldap.user.ctx=ou\=People,dc\=jboss,dc\=org
ldap.role.ctx=ou\=Groups,dc\=jboss,dc\=org
ldap.user.filter=(uid\={0})
ldap.role.filter=(cn\={0})
ldap.search.scope=SUBTREE_SCOPE

3. Ensure correct roles assigned to the users in your LDAP server, for example admin, analyst, and
others.

You can define your own roles in EAP_HOME/standalone/deployments/business-central.war/WEB-
INF/classes/workbench-policy.properties.

2.2. BUSINESS CENTRAL PROFILE CONFIGURATION

Red Hat JBoss BPM Suite 6 (or better) server is capable of starting the Business Central application in
three different modes:

Full profile: Default profile that is active without additional configuration required (UI and
remote services e.g. REST).

Execution server profile : Disables completely UI components of the application and allows only
remote access e.g. via REST interface.

UI server profile: Disables remote services e.g REST and allows only UI access to the application.

To change the profile use the following configuration steps.

Procedure: Configuring Business Central Profiles

1. Select the desired web.xml inside BPMS_HOME/standalone/deployments/business-
central.war/WEB-INF/. The following files are provided:

web.xml (default) for full profile

web-exec-server.xml for execution server profile

web-ui-server.xml for UI server profile

2. To activate a profile other than the default full profile, the web-<PROFILE>.xml file must be
renamed to web.xml. The following steps demonstrate one way to enable the execution server
profile:

a. Backup the web.xml file from the full profile

$ mv web.xml web-full.xml

b. Rename the web-exec-server.xml file:

$ mv web-exec-server.xml web.xml
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3. Start application server with additional system property to instruct the profile manager to
activate given profile.

Dorg.kie.active.profile=full - To activate full profile or skip the property completely

Dorg.kie.active.profile=exec-server - To activate execution server profile

Dorg.kie.active.profile=ui-server - To activate UI server profile

2.3. BRANDING BUSINESS CENTRAL APPLICATION

The Business Central web application can be customized by overriding some of its default styles. The
personalized Business Central branding allows you to get a consistent appearance across all your
applications, while it is also possible to create a different user interfaces for each team within your
company. The customizable elements are built by using HTML files and images, which enables an easy
and flexible customization of the application without having to recompile the code.

The following Business Central application elements can be customized:

In the login screen, the foreground corner images, company logo, and project logo can be
changed.

The upper application banner displayed after logging in can be personalized.

In help pop-up windows, the label text and splash help images can be customized.

2.3.1. Customizing Business Central Login Page

Procedure: Changing Foreground Corner Images

1. Start the EAP server and open Business Central in a web browser.

2. To change the upper right corner foreground image, copy the substitute PNG file named bg-
login.png to the EAP_HOME/standalone/deployments/business-central.war/img/ directory
in your Red Hat JBoss BPM Suite installation.

3. To change the lower right corner foreground image, copy the substitute PNG file named bg-
login-2.png to the EAP_HOME/standalone/deployments/business-central.war/img/
directory in your Red Hat JBoss BPM Suite installation.

4. Force a full reload of the login page, bypassing the cache, to view the changes. For example, in
most Linux and Windows web browsers, press Ctrl+F5.

Procedure: Changing Company Logo and Project Logo

1. Start the EAP server and open Business Central in a web browser.

2. Navigate to the EAP_HOME/standalone/deployments/business-central.war/img/ directory in
your Red Hat JBoss BPM Suite installation.

3. To change the company logo that appears at the upper right hand corner of the login page,
replace the default image login-screen-logo.png with a new image in the PNG format.

4. To change the project logo that appears above the login text fields, replace the default image 
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4. To change the project logo that appears above the login text fields, replace the default image 
RH_JBoss_BPMS_Logo.svg with a new SVG file.

5. Force a full reload of the login page, bypassing the cache, to view the changes.

2.3.2. Customizing Business Central Application Header

1. Start the EAP server, open Business Central in a web browser, and log in with your user
credentials.

2. Copy your new application header image in the SVG format to the 
EAP_HOME/standalone/deployments/business-central.war/banner/ directory in your Red
Hat JBoss BPM Suite installation.

3. Open EAP_HOME/standalone/deployments/business-central.war/banner/banner.html file
in a text editor.

4. In the banner.html file, edit the following <img> tag to provide the name of your new header
image:

<img src="banner/logo.svg"/>

5. Force a full reload of the page, bypassing the cache, to view the changes.

2.3.3. Customizing Business Central Splash Help Windows

Each splash page and its corresponding HTML file are located in the 
EAP_HOME/standalone/deployments/business-central.war/plugins/ directory. The files contain
information about the images and the text to be displayed. For example, the 
authoring_perspective.splash.js splash page points to the authoring_perspective.splash.html file,
which contains the names, captions, and location of all the image files that appear in the splash help
pop-up windows of the Business Central Authoring perspective.

Procedure: Changing Splash Help Images and Captions

1. Start the EAP server, open Business Central in a web browser, and log in with your user
credentials.

2. Copy the new splash help images to the EAP_HOME/standalone/deployments/business-
central.war/images/ directory in your Red Hat JBoss BPM Suite installation.

3. Open the corresponding HTML file from the plugins directory in a text editor.

4. Edit the HTML file to point to your new splash help image. For example, to change the first
image that appears in the Authoring perspective splash help, edit the following <img> tag in the
authoring_perspective.splash.html file to add your new image:

5. To change the image caption that appears on the splash help, edit the <h4> and <p> tag
contents in the <div> tag below the correspoding <img> tag:

<img src="images/authoring_perspective1.png" alt="">

<div class="carousel-caption">
  <h4>Authoring</h4>
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6. Force a full reload, bypassing the cache, and access the splash help pop-up windows to view the
changes.

2.4. DEPLOYMENT DESCRIPTORS

Processes and rules within Red Hat JBoss BPM Suite 6 onwards are stored in Apache Maven based
packaging, and are known as knowledge archives or KJAR. The rules, processes, assets, etc. are part of a
jar file built and managed by Maven. A file kept inside the META-INF directory of the KJAR called 
kmodule.xml can be used to define the knowledge bases and sessions. This kmodule.xml file, by
default, is empty.

Whenever a runtime component such as Business Central is about to process the KJAR, it looks up 
kmodule.xml to build the runtime representation.

Deployment Descriptors, a new feature introduced in the 6.1 branch of Red Hat JBoss BPM Suite, allows
you fine grained control over your deployment and supplements the kmodule.xml file. The presence of
these descriptors is optional and your deployment will proceed successfully without them. The
properties that you can set using these descriptors are purely technical in nature and include meta
values like persistence, auditing and runtime strategy.

These descriptors allow you to configure the execution server on multiple levels (server level default,
different deployment descriptor per KJAR and so on). This allows you to make simple customizations to
the execution server’s out-of-the-box configuration (possibly per KJAR).

You define these descriptors in a file called kie-deployment-descriptor.xml and place this file next to
your kmodule.xml file in the META-INF folder. You can change this default location (and the filename)
by specifying it as a system parameter:

-Dorg.kie.deployment.desc.location=file:/path/to/file/company-deployment-descriptor.xml

2.4.1. Deployment Descriptor Configuration

Deployment descriptors allow the user to configure the execution server on multiple levels:

Server level: The main level and the one that applies to all KJARs deployed on the server.

Kjar level: This allows you to configure descriptors on a per KJAR basis.

Deploy time level : Descriptors that apply while a KJAR is being deployed.

The granular configuration items specified by the deployment descriptors take precedence over the
server level ones, except in case of configuration items that are collection based, which are merged. The
hierarchy works like this: deploy time configuration > KJAR configuration > server configuration .

NOTE

The deploy time configuration applies to deployments done via the REST API.

For example, if the persistence mode (one of the items you can configure) defined at the server level is 
NONE but the same mode is specified as JPA at the KJAR level, the actual mode will be JPA for that
KJAR. If nothing is specified for the persistence mode in the deployment descriptor for that KJAR (or if

  <p>Modularized and customizable workbench</p>
</div>
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there is no deployment descriptor), it will fall back to the server level configuration, which in this case is 
NONE (or to JPA if there is no server level deployment descriptor).

Can You Override this Hierarchal Merge Mode Behavior?
Yes. In the default way, if there are deployment descriptors present at multiple levels, the configuration
properties are merged with the granular ones overriding the coarse values, and with missing
configuration items at the granular level being supplied with those values from the higher levels. The
end result is a merged Deployment Descriptor configuration. This default merge mode is called the 
MERGE_COLLECTIONS mode. However, you can change it (see Section 2.4.2, “Managing Deployment
Descriptors”) if it does not suit your environment to one of the following modes:

KEEP_ALL: In this mode, all higher level values override all lower level values (server level values
replace KJAR level values)

OVERRIDE_ALL: In this mode, all lower level values override all higher level values (KJAR values
replace server level values)

OVERRIDE_EMPTY: In this mode, all non empty configuration items from lower levels replace
those at higher levels, including items that are represented as collections.

MERGE_COLLECTIONS (DEFAULT): In this mode, all non empty configuration items from
lower level replace those from higher levels (like in OVERRIDE_EMPTY), but collection
properties are merged (combined).

Deployment Descriptors from dependent KJARs are placed lower than the actual KJAR being deployed,
but they still have higher hierarchy than the server level.

Do I Need to Provide a Full Deployment Descriptor for All Kjars?
No, and this is where the beauty of the merge between different files can help you. Providing partial
Deployment Descriptors is possible and recommended. For example, if you want to only override the
audit mode in a KJAR, then you just need to provide that and the rest of the values will be merged from
server level or higher level KJARs.

It is worth noting that when using OVERRIDE_ALL merge mode, all configuration items should be
specified since the relevant KJAR will always use them and will not merge with any other deployment
descriptor in the hierarchy.

What Can You Configure?
High level technical configuration details can be configured via deployment descriptors. The following
table lists these along with the permissible and default values for each.

Table 2.1. Deployment Descriptors

Configuration XML Entry Permissible Values Default Value

Persistence unit name
for runtime data

persistence-unit Any valid persistence
package name

org.jbpm.domain

Persistence unit name
for audit data

audit-persistence-unit Any valid persistence
package name

org.jbpm.domain

Persistence mode persistence-mode JPA, NONE JPA

Audit mode audit-mode JPA, JMS or NONE JPA
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Runtime Strategy runtime-strategy SINGLETON,
PER_REQUEST or
PER_PROCESS_INSTA
NCE

SINGLETON

List of Event Listeners
to be registered

event-listeners Valid listener class
names as ObjectModel

No default value

List of Task Event
Listeners to be
registered

task-event-listeners Valid listener class
names as ObjectModel

No default value

List of Work Item
Handlers to be
registered

work-item-handlers Valid Work Item Handler
classes given as 
NamedObjectHandle
r

No default value

List of Globals to be
registered

globals Valid Global variables
given as 
NamedObjectModel

No default value

Marshalling strategies to
be registered (for
pluggable variable
persistence)

marshalling-strategies Valid ObjectModel
classes

No default value

Required Roles to be
granted access to the
resources of the KJAR

required-roles String role names No default value

Additional Environment
Entries for Knowledge
Session

environment-entries Valid 
NamedObjectModel

No default value

Additional configuration
options of Knowledge
Session

configurations Valid 
NamedObjectModel

No default value

Configuration XML Entry Permissible Values Default Value

How Do You Provide Values For Collections-Based Configuration Items?
In the table of valid configuration items earlier, you would have noticed that the valid values for the
collection based items are either ObjectModel or NamedObjectModel. Both are similar and provide a
definition of the object to be built or created at runtime, with the exception that the 
NamedObjectModel object details name the object to be looked. Both these types are defined using an
identifier, optional parameters and resolver (to resolve the object).

Identifier

Defines all the information about the object, such as fully qualified class name, Spring bean id or an
MVEL expression.
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Parameters

Optional parameters that should be used while creating instances of objects from this model.

Resolver

Identifier of the resolver that will be used to create object instances from the model, that is
reflection, mvel, or Spring.

As an example, if you have built a custom marshaling strategy and want your deployments to use that
strategy instead of the default, you will need to provide that strategy as an ObjectModel, with the
identifier being com.mycompany.MyStrategy, resolver being reflection (the easiest and the default)
and any parameters that are required for your strategy to work. Reflection will then be used to create an
instance of this strategy using the fully qualified class name that you have provided as the identifier.

<marshalling-strategy>
 <resolver>reflection</resolver>
 <identifier>com.myCompany.MyStrategy</identifier>
 <parameters>
    <parameter xsi:type="xs:string" xmlns:xs="http://www.w3.org/2001/XMLSchema">
      param
    </parameter>
  </parameters>
</marshalling-strategy>

In the case that reflection based on resolver is not enough (as demonstrated in the previous example),
you can use a resolver based on MVEL expression as the identifier of the object model. While evaluating
expressions, you can substitute out-of-the-box parameters. For example:

<marshalling-strategy>
  <resolver>mvel</resolver>
  <identifier>new com.myCompany.CustomStrategy(runtimeManager)</identifier>
</marshalling-strategy>

The Spring based resolver allows you to look up a bean by its identifier from a Spring application context.
Whenever JBoss BPM Suite is used with Spring, this resolver helps in deploying KJARs into the runtime.
As an example (note that the identifier in this case is a named bean in the Spring context):

<marshalling-strategy>
 <resolver>spring</resolver>
 <identifier>customStrategy</identifier>
</marshalling-strategy>

2.4.2. Managing Deployment Descriptors

Deployment Descriptors can be edited via the Business Central in one of two ways. Either graphically (by
clicking on Authoring → Project Authoring → Deployment Descriptor or by clicking on Authoring →
Administration menu and then clicking through to the META-INF folder in the File Explorer. Click on the
kie-deployment-descriptor.xml file to edit it manually.

Every time a project is created, a stock kie-deployment-descriptor.xml file is generated with default
values as described earlier.

Overriding Hierarchical Merge Mode Behavior
To change the default mode of MERGE_COLLECTIONS to one of KEEP_ALL, OVERRIDE_ALL, or 
OVERRIDE_EMPTY, you can use the following methods, depending on the requirement.
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Set the system property org.kie.dd.mergemode to one of these values. This merge mode will
become default for all KJARs deployed in the system, unless you override it at a KJAR level via
the next method.

When deploying a new deployment unit via Business Central (Deploy → Deployments) you can
select what merge mode should be used for that particular KJAR.

When deploying via the REST API, you can add mergemode query parameter to the command
URL to one of these modes to set the merge mode for that deployment.

Restricting Access to the Runtime Engine
One of the configuration items discussed earlier, required-roles, can be edited via the Deployment
Descriptors. This property restricts access to the runtime engine on a per KJAR or per server level by
ensuring that access to certain processes is only granted to users that belong to groups defined by this
property.

The security role can be used to restrict access to process definitions or restrict access at runtime.

The default behavior is to add required roles to this property based on repository restrictions. You can of
course, edit these properties manually if required, as described above by providing roles that match
actual roles defined in the security realm.

2.5. MANAGING DEPLOYMENT OVERRIDE POLICY

If a user tries to deploy an artifact with a GAV (Group-Id, Artifact-Id and Version) that already exists in
the system, the deployment will fail and an error message will be displayed in the Messages panel.

This feature prevents the user from overwriting an existing deployment by mistake.

By default this feature is enabled, that is, by default the system will prevent the user from overwriting an
existing installation with the same GAV.

However, there may be cases when the user may want to overwrite existing deployments with the same
GAV. Although you cannot enable overwriting on a per-deployment basis, you can set this up for the
system as a whole by using the system setting org.kie.override.deploy.enabled. This setting, is false by
default. Change it to true to enable overwriting of deployments with the same GAV by providing it at
startup time of your server (-Dorg.kie.override.deploy.enabled=true).

2.6. EXTENDING BUSINESS CENTRAL

Starting with version 6.1 of Red Hat JBoss BPM Suite, Business Central can be configured to add new
screens, menus, editors, splashscreens and perspectives by the Administrator. These elements can
extend functionality of Business Central and can be accessed through the Extensions → Plugin
Management.

You can now define your own Javascript and HTML based plugins to extend Business Central and add
them without having to worry about copying files in the underlying filesystem. Let us add a new screen in
the system to show you the basics of this functionality.

2.6.1. Plugin Management

You access the Plugin Management screen by clicking on Extensions → Plugin Management. This
brings up the Plugin Explorer screen that lists all the existing plugins under their respective categories:

Perspective Plugin
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Screen Plugin

Editor Plugin

Splashscreen Plugin

and Dynamic Menu

Open any of these, and you will see the existing plugins in each category, including the uneditable
system generated ones.

Let us create a new plugin that echoes "Hello World" when users visit the screen for that plugin. In
general, the steps to creating a new plugin are:

1. Create a new screen

2. Create a new perspective (and add the new screen to it)

3. Create a new menu (and add the new perspective to it)

4. Apps (optional)

Adding a New Screen

Click the  button and select New Screen. You will be prompted to enter the name of this new
screen. Enter "HelloWorldJS" and press the OK button. The Screen plugin editor will open, divided into 4
sections: Template, CSS, JavaScript and Media.

NOTE

All manually created elements go into their respective categories in case you want to edit
them later. In this case, to open the Screen plugin editor again if you close it, open the
Screen Plugin category and scroll past the system generated screens to your manually
created plugin and click on it to open the Screen plugin editor again.

Template is where your HTML goes, CSS is for styling, JavaScript is for your functions and Media is for
uploading and managing images.

Since we are making a simple Hello World plugin, enter the following code in the Template section: 
<div>My Hello World Screen</div>. This can be any HTML code, and you can use the supplied 
Angular and Knockout frameworks. For the purposes of this example, we are not using any of those
frameworks, but you can choose to by selecting them from the drop down in the Template section.

Enter your JavaScript code in the JavaScript section. Some common methods and properties are
defined for you, including main, on_close and on_open. For this demo, select the on_open and enter
the following: function () { alert('Hello World'); }

Click the Save button to finish creating the screen. After you save the screen, refresh business central
so that the Screen Plugin is listed in the Screen Component of Perspective plugin.

Adding New Perspective
Once a screen has been created, you need to create a perspective on which this screen will reside.
Perspectives can also be created similar to the way a screen is created by clicking on the New button
and then selecting New Perspective. You can now provide a name for this perspective, say 
HelloWorldPerspective. This will open the Perspective plugin editor, similar to the Screen plugin editor.

The Perspective Editor is like a drag and drop grid builder for screens and HTML components. Remove
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The Perspective Editor is like a drag and drop grid builder for screens and HTML components. Remove
any existing grids and then drag a 6×6 grid on the right hand side to the left hand side.

Next, open the Components category and drag a Screen Component on the right hand side to the left
hand side (in any grid). This will open the Edit Component dialog box that allows you to select the
screen created in the previous step (HelloWorldJS). Click the OK button and then click Save to save
this perspective. To tag your perspective, enter Home in the tag name field and click Tags. Click OK
and save the changes.

You can open this perspective again from the Perspective plugins listed on the left hand side.

Adding New Menu
The final step in creating our plugin is to add a dynamic menu from where the new screen/perspective
can be called up. To do so, go to Extensions → Plugin Management and then click on the New button to
select New Dynamic Menu. Give this dynamic menu a name ( HelloWorldMenu) and then click the OK
button. The dynamic menu editor opens up.

Enter the perspective name (HelloWorldPerspective) as the Activity Id and the name for the drop
down menu (HelloWorldMenuDropDown). Click OK and then Save.

This new menu will be added to your workbench the next time you refresh Business Central. Refresh it
now to see HelloWorldMenu added to your top level menu. Click on it to reveal
HelloWorldMenuDropDown, which when clicked will open your perspective/screen with the message 
Hello World.

You have created your first Plugin!

Working with Apps (Optional)
If you create multiple plugins, you can use the Apps directory feature to organize your own components
and plugins, instead of having to rely on just the top menu entries.

When you save a new perspective, you can add labels (tags) for them and these labels (tags) are used to
associate a perspective with an App directory. You can open the App directories by clicking on
Extensions → Apps.

The Apps directory provides an alternate way to open your perspective. When you created your 
HelloWorldPerspective, you entered the tag Home. The Apps directory by default contains a single
directory called Home with which you associated your perspective. This is where you will find it when you
open the Apps directory. You can click on it to run the perspective now.

You can create multiple directories and associate perspectives with those directories depending on
functional and vertical business requirements. For example, you could create an HR directory and then
associate all HR related perspectives with that directory to better manage Apps.

You can create a new directory by clicking the  button.

2.6.2. The JavaScript (JS) API for Extensions

The extensibility of Business Central is achieved by an underlying JavaScript (JS) API which is
automatically loaded if it is placed in the plugins folder of the Business Central webapp (typically: 
INSTALL_DIR/business-central.war/plugins/), or it can be loaded via regular JavaScript calls.

This API is divided into multiple sets depending on the functionality it performs.

Register Perspective API

Allows for the dynamic creation of perspectives. The example below creates a panel using the 
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Allows for the dynamic creation of perspectives. The example below creates a panel using the 
registerPerspective method:

$registerPerspective({
    id: "Home",
    is_default: true,
    panel_type: "org.uberfire.client.workbench.panels.impl.MultiListWorkbenchPanelPresenter",
    view: {
        parts: [
            {
                place: "welcome",
                min_height: 100,
                parameters: {}
            }
        ],
        panels: [
            {
                width: 250,
                min_width: 200,
                position: "west",
                panel_type: 
"org.uberfire.client.workbench.panels.impl.MultiListWorkbenchPanelPresenter",
                parts: [
                    {
                        place: "YouTubeVideos",
                        parameters: {}
                    }
                ]
            },
            {
                position: "east",
                panel_type: 
"org.uberfire.client.workbench.panels.impl.MultiListWorkbenchPanelPresenter",
                parts: [
                    {
                        place: "TodoListScreen",
                        parameters: {}
                    }
                ]
            },
            {
                height: 400,
                position: "south",
                panel_type: 
"org.uberfire.client.workbench.panels.impl.MultiTabWorkbenchPanelPresenter",
                parts: [
                    {
                        place: "YouTubeScreen",
                        parameters: {}
                    }
                ]
            }
        ]
    }
});
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Editor API

Allows you to dynamically create editors and associate them with a file type. The example below
creates a sample editor and associates it with filename file type.

$registerEditor({
    "id": "sample editor",
    "type": "editor",
    "templateUrl": "editor.html",
    "resourceType": "org.uberfire.client.workbench.type.AnyResourceType",
    "on_concurrent_update":function(){
        alert('on_concurrent_update callback')
        $vfs_readAllString(document.getElementById('filename').innerHTML, function(a) {
            document.getElementById('editor').value= a;
        });
    },
    "on_startup": function (uri) {
        $vfs_readAllString(uri, function(a) {
            alert('sample on_startup callback')
        });
    },
    "on_open":function(uri){
        $vfs_readAllString(uri, function(a) {
            document.getElementById('editor').value=a;
        });
        document.getElementById('filename').innerHTML = uri;
    }
});

In addition to on_startup and on_open methods seen in the previous example, the API exposes the
following callback events for managing the editor’s lifecycle:

on_concurrent_update;

on_concurrent_delete;

on_concurrent_rename;

on_concurrent_copy;

on_rename;

on_delete;

on_copy;

on_update;

on_open;

on_close;

on_focus;

on_lost_focus;

on_may_close;
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on_startup;

on_shutdown;

You can display this editor via an HTML template:

<div id="sampleEditor">
    <p>Sample JS editor (generated by editor-sample.js)</p>
    <textarea id="editor"></textarea>

    <p>Current file:</p><span id="filename"></span>
    <button id="save" type="button" 
onclick="$vfs_write(document.getElementById('filename').innerHTML, 
document.getElementById('editor').value,  function(a) {});">Save</button>
    <br>

    <p>This button change the file content, and uberfire send a callback to the editor:</p>
    <button id="reset" type="button" 
onclick="$vfs_write(document.getElementById('filename').innerHTML, 'Something else',  
function(a) {});">Reset File</button>
</div>

PlaceManager API

The methods of this API allow you to request that the Business Central display a particular
component associated with a target: $goToPlace("componentIdentifier");

Register plugin API

The methods of this API allow you to create dynamic plugins (that will be transformed in Business
Central screens) via the JS API.

The plugin references the angular.sample.html template:

$registerPlugin( {
    id: "my_angular_js",
    type: "angularjs",
    templateUrl: "angular.sample.html",
    title: function () {
        return "angular " + Math.floor(Math.random() * 10);
    },
    on_close: function () {
        alert("this is a pure JS alert!");
    }
});

<div ng-controller="TodoCtrl">
    <span>{{remaining()}} of {{todos.length}} remaining</span>
    [ <a href="" ng-click="archive()">archive</a> ]
    <ul class="unstyled">
        <li ng-repeat="todo in todos">
            <input type="checkbox" ng-model="todo.done">
            <span class="done-{{todo.done}}">{{todo.text}}</span>
        </li>
    </ul>
    <form ng-submit="addTodo()">
        <input type="text" ng-model="todoText" size="30" placeholder="add new todo here">
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A plugin can be hooked to Business Central events via a series of JavaScript callbacks:

on_concurrent_update;

on_concurrent_delete;

on_concurrent_rename;

on_concurrent_copy;

on_rename;

on_delete;

on_copy;

on_update;

on_open;

on_close;

on_focus;

on_lost_focus;

on_may_close;

on_startup;

on_shutdown;

Register splash screens API

use the methods in this API to create splash screens.

Virtual File System (VFS) API

        <input class="btn-primary" type="submit" value="add">
    </form>
    <form ng-submit="goto()">
        <input type="text" ng-model="placeText" size="30" placeholder="place to go">
        <input class="btn-primary" type="submit" value="goTo">
    </form>
</div>

$registerSplashScreen({
    id: "home.splash",
    templateUrl: "home.splash.html",
    body_height: 325,
    title: function () {
        return "Cool Home Splash " + Math.floor(Math.random() * 10);
    },
    display_next_time: true,
    interception_points: ["Home"]
});
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with this API, you can read and write a file saved in the file system using an asynchronous call.

2.7. CONFIGURING TABLE COLUMNS

Business Central allows you to configure views that contain lists of items in the form of tables. You can
resize columns, move columns, add or remove the default list of columns and sort the columns. This
functionality is provided for all views that contain tables.

Once you make changes to the columns of a table view, these changes are persisted for the current
logged in user.

Adding and Removing Columns

Tables that allow columns to be configured have the  button in the top right corner. Clicking on this
button opens up the list of columns that can added or removed to the current table with a check box
next to each column:

Resizing Columns
To resize columns, place your cursor between the edges of the column header and move in the direction
that you want:

Moving Columns
To re-order and drag and drop a column in a different position, hover your mouse over the rightmost
area of the column header:

$vfs_readAllString(uri,  function(a) {
  //callback logic
});

$vfs_write(uri,content,  function(a) {
  //callback logic
})
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You can now grab the column and move it:

Drop it over the column header that you want to move it to.

Sorting Columns
To sort columns, click on the desired column’s header. To reverse-sort, click on the header again.
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CHAPTER 3. INTELLIGENT PROCESS SERVER
The Intelligent Process Server is a standalone, built-in component that can be used to instantiate and
execute rules through interfaces available for REST, JMS, or a Java client side application, as well as to
manage processes, jobs, and Business Resource Planner functionality through solvers. Created as a web
deployable WAR file, this server can be deployed on any web container. The current version of the
Intelligent Process Server is included with default extensions for both Red Hat JBoss BRMS and Red
Hat JBoss BPM Suite.

This server has a low footprint with minimal memory consumption and therefore can be deployed easily
on a cloud instance. Each instance of this server can open and instantiate multiple KIE containers which
allows you to execute multiple rule services in parallel.

You can provision the Intelligent Process Server instances through Business Central. In this chapter, the
steps required to set up the Intelligent Process Server, provision and connect to the server through
Business Central, control what artifacts go in each instance, and go through its lifecycle are provided.

NOTE

For more information, see the Intelligent Process Server and Realtime Decision Server
chapter of the Red Hat JBoss BPM Suite Development Guide .

3.1. DEPLOYING INTELLIGENT PROCESS SERVER

The Intelligent Process Server is distributed as a web application archive (WAR) file kie-server.war.
When you install Red Hat JBoss BPM Suite, the WAR file is installed and deployed in your web container
by default.

You can copy the WAR file and deploy it in any other web container, such as Red Hat JBoss Web Server
or another Red Hat JBoss EAP install. Note that the WAR file must be compatible with the container.

1. Once you have deployed the WAR file, create a user with the role kie-server in the web
container.

NOTE

You can change the kie-server user role in the web.xml file or in Keycloak.

1. Verify that you can access the decision engine: open http://SERVER:PORT/kie-
server/services/rest/server/ in a web browser and enter the user name and the password
specified in the previous step.

2. Once authenticated, an XML response in the form of engine status opens:

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<response type="SUCCESS" msg="Kie Server info">
  <kie-server-info>
    <capabilities>BPM</capabilities>
    <capabilities>KieServer</capabilities>
    <capabilities>BRM</capabilities>
    <location>http://localhost:8230/kie-server/services/rest/server</location>
    <name>KieServer@/kie-server</name>
    <id>15ad5bfa-7532-3eea-940a-abbbbc89f1e8</id>
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3.2. INSTALLING INTELLIGENT PROCESS SERVER IN OTHER
CONTAINERS

3.2.1. Red Hat JBoss Web Server 2.X/3.X, Tomcat 8.X/9.X

Use the following procedure to install the Intelligent Process Server in a Tomcat container.

1. Follow the steps described in section Generic Deployable Bundle Installation of Red Hat JBoss
BPM Suite Installation Guide to download and extract the generic deployable archive containing
kie-server.war.

2. Configure users and roles. Make sure that the TOMCAT_HOME/conf/tomcat-users.xml file
contains the following role and user definition. The user name and password should be unique,
however, the role must be defined as kie-server:

3. Start the server: run TOMCAT_HOME/bin/startup.sh or in a Windows system 
TOMCAT_HOME/bin/startup.bat. To make sure that the application was deployed successfully,
see Tomcat logs in the TOMCAT_HOME/logs directory. See Section 3.3.1, “Bootstrap
Switches” for the list of bootstrap switches that can be used to properly configure the instance.
For example:

$ ./startup.sh -Dorg.kie.server.id=first-kie-server -
Dorg.kie.server.location=http://localhost:8080/kie-server/services/rest/server

4. To verify that the server is running, open http://SERVER:PORT/kie-
server/services/rest/server/ in a web browser and enter the user name and the password
specified before. You should see a simple XML message with basic information about the server.

IMPORTANT

It is not possible to use the JMS interface if the Intelligent Process Server was installed
on Tomcat or any other web container. The web container version of the WAR file
contains only the REST interface.

3.3. INTELLIGENT PROCESS SERVER SETUP

3.3.1. Bootstrap Switches

The Intelligent Process Server accepts a number of bootstrap switches (system properties) to configure
the behavior of the server.

Table 3.1. Bootstrap Switches for Disabling Intelligent Process Server Extensions

    <version>6.4.0.Final-redhat-5</version>
  </kie-server-info>
</response>

<role rolename="kie-server"/>
<user username="serveruser" password="my.s3cr3t.pass" roles="kie-server"/>
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Property Values Default Description

org.drools.server.ext.dis
abled

true, false false If set to true, disables the BRM support (for
example rules support).

org.jbpm.server.ext.disa
bled

true, false false If set to true, disables the BPM support (for
example processes support).

org.optaplanner.server.e
xt.disabled

true, false false If set to true, disables the BRP support (for
example planner support).

org.jbpm.ui.server.ext.di
sabled

true, false false If set to true, disables the Intelligent Process
Server UI extension.

org.kie.executor.disable
d

true, false false Disables the Red Hat JBoss BPM Suite
executor.

NOTE

Some controller properties listed below are marked as required. Set these properties
when you handle Intelligent Process Server container creation and removal in Business
Central. If you use the Intelligent Process Server separately without any interaction with
Business Central, the properties do not have to be set.

Table 3.2. Bootstrap Switches Required for Using a Controller

Property Values Default Description

org.kie.server.id String N/A An arbitrary ID to be assigned to the server.
If a remote controller is configured, this is the
ID under which the server will connect to the
controller to fetch the KIE container
configurations. If not provided, the ID is
automatically generated.

org.kie.server.user String kieserver The user name used to connect with the
Intelligent Process Server from the
controller, required when running in managed
mode. Set this property in Business Central
system properties. Setting this property is
required when using a controller.

org.kie.server.pwd String kieserver1
!

The password used to connect with the
Intelligent Process Server from the
controller, required when running in managed
mode. Set this property in Business Central
system properties. Setting this property is
required when using a controller.
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org.kie.server.token String N/A This property enables you to use a token-
based authentication between the controller
and the Intelligent Process Server instead of
the basic user name/password
authentication. The controller sends the
token as a parameter in the request header.
Note that long-lived access tokens are
required as the tokens are not refreshed.

org.kie.server.location URL N/A The URL of the Intelligent Process Server
instance used by the controller to call back
on this server, for example: 
http://localhost:8230/kie-
server/services/rest/server. Setting this
property is required when using a controller.

org.kie.server.controller Comma-
separated
list

N/A A comma-separated list of URLs to the
controller REST endpoints, for example 
http://localhost:8080/business-
central/rest/controller. Setting this
property is required when using a controller.

org.kie.server.controller.
user

String kieserver The user name to connect to the controller
REST API. Setting this property is required
when using a controller.

org.kie.server.controller.
pwd

String kieserver1
!

The password to connect to the controller
REST API. Setting this property is required
when using a controller.

org.kie.server.controller.
token

String N/A This property enables you to use a token-
based authentication between the Intelligent
Process Server and the controller instead of
the basic user name/password
authentication. The server sends the token
as a parameter in the request header. Note
that long-lived access tokens are required as
the tokens are not refreshed.

org.kie.server.controller.
connect

Long 10000 The waiting time in milliseconds between
repeated attempts to connect the Intelligent
Process Server to the controller when the
server starts.

Property Values Default Description

Table 3.3. Bootstrap Switches for Persistence Properties
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Property Values Default Description

org.kie.server.persistenc
e.ds

String N/A A data source JNDI name. Set this property
when enabling the BPM support.

org.kie.server.persistenc
e.tm

String N/A A transaction manager platform for
Hibernate properties set. Set this property
when enabling the BPM support.

org.kie.server.persistenc
e.dialect

String N/A The Hibernate dialect to be used. Set this
property when enabling the BPM support.

org.kie.server.persistenc
e.schema

String N/A The database schema to be used.

IMPORTANT

Make sure the new data source for the Intelligent Process Server points to a different
database schema than the data source used by Business Central by modifying the 
org.kie.server.persistence.ds property in order to avoid conflicts. This does not apply if
you configured unified execution servers as described in Section 3.3.4, “Unified
Execution Servers”.

Table 3.4. Bootstrap Switches for Executor Properties

Property Values Default Description

org.kie.executor.interval Integer 3 The time between the moment the Red Hat
JBoss BPM Suite executor finishes a job and
the moment it starts a new one, in a time unit
specified in the org.kie.executor.timeunit
property.

org.kie.executor.timeunit java.util.c
oncurrent.
TimeUnit
constant

SECONDS The time unit in which the 
org.kie.executor.interval property is
specified.

org.kie.executor.pool.siz
e

Integer 1 The number of threads used by the Red Hat
JBoss BPM Suite executor.

org.kie.executor.retry.co
unt

Integer 3 The number of retries the Red Hat JBoss
BPM Suite executor attempts on a failed job.

Table 3.5. Callback Bootstrap Switches
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Property Values Default Description

org.jbpm.ht.callback mvel

ldap

db

jaas

props

custom

jaas Specifies the implementation of user group
callback to be used:

mvel: Default; mostly used for
testing.

ldap: LDAP; requires additional
configuration in the 
jbpm.usergroup.callback.prop
erties file.

db: Database; requires additional
configuration in the 
jbpm.usergroup.callback.prop
erties file.

jaas: JAAS; delegates to the
container to fetch information
about user data.

props: A simple property file;
requires additional file that will keep
all information (users and groups).

custom: A custom implementation;
specify the fully qualified name of
the class in the 
org.jbpm.ht.custom.callback
property.

org.jbpm.ht.custom.callb
ack

Fully
qualified
name

N/A A custom implementation of the 
UserGroupCallback interface in case the 
org.jbpm.ht.callback property is set to 
custom.

Table 3.6. Other Bootstrap Switches

Property Values Default Description

kie.maven.settings.custo
m

Path N/A The location of a custom settings.xml file
for Maven configuration.

kie.server.jms.queues.re
sponse

String queue/KIE
.SERVER.
RESPONS
E

The response queue JNDI name for JMS.

org.drools.server.filter.cl
asses

true, false false When set to true, the Drools Intelligent
Process Server extension accepts custom
classes annotated by the XmlRootElement
or Remotable annotations only.
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org.kie.server.bypass.au
th.user

true, false false Allows to bypass the authenticated user for
task-related operations, for example queries.

org.kie.server.domain String N/A The JAAS LoginContext domain used to
authenticate users when using JMS.

org.kie.server.repo Path . The location where Intelligent Process Server
state files will be stored.

org.kie.server.sync.depl
oy

true, false false Instructs the Intelligent Process Server to
hold the deployment until the controller
provides the containers deployment
configuration. This property affects only the
servers running in managed mode. The
options are as follows:

false; the connection to the
controller is asynchronous. The
application starts, connects to the
controller, and once successful,
deploys the containers. The
application accepts requests even
before the containers are available.

true; the deployment of the server
application joins the controller
connection thread with the main
deployment and awaits its
completion. This option can lead to
a potential deadlock in case more
applications are on the same server
instance. It is strongly
recommended to use only one
application (the server) on one
server instance.

Property Values Default Description

3.3.2. Managed Intelligent Process Server

A managed instance requires an available controller to start the Intelligent Process Server.

A controller manages the Intelligent Process Server configuration in a centralized way. Each controller
can manage multiple configurations at once, and there can be multiple controllers in the environment.
Managed Intelligent Process Server can be configured with a list of controllers, but will only connect to
one at a time.

IMPORTANT

Controllers should be synchronized to ensure that the same set of configuration is
provided to the server, regardless of the controller to which it connects.

When the Intelligent Process Server is configured with a list of controllers, it will attempt to connect to
each of them at startup until a connection is successfully established with one of them. If a connection
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cannot be established, the server will not start, even if there is a local storage available with
configuration. This ensures consistence and prevents the server from running with redundant
configuration.

NOTE

To run the Intelligent Process Server in standalone mode without connecting to
controllers, see Section 3.3.3, “Unmanaged Intelligent Process Server” .

Configuring Intelligent Process Server Managed by Business Central

WARNING

This section provides a sample setup that you can use for testing purposes. Some of
the values are unsuitable for a production environment, and are marked as such.

Configure the Business Central to manage an Intelligent Process Server instance by performing the
following steps:

Configuring Intelligent Process Server Managed by Business Central

1. Make sure users with the following roles exist:

In Business Central, a user with the role rest-all.

On the Intelligent Process Server, a user with the role kie-server.

NOTE

In production environments, use two distinct users, each with one role. In this
sample situation, we use only one user named controllerUser that has both the 
rest-all and the kie-server roles.

If such users do not exist, create them.

On Red Hat JBoss EAP, go to EAP_HOME/bin/ and execute:



$ ./add-user.sh -a --user controllerUser --password controllerUser1234; --role kie-
server,rest-all
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WARNING

Plain-text passwords are not secure. For production environments, use
a password vault. For more information, see the Password Vault
chapter of the Red Hat JBoss Enterprise Application Platform 6.4 How
To Configure Server Security guide.

On Red Hat JBoss Web Server, see Section 3.2.1, “Red Hat JBoss Web Server 2. X/3.X,
Tomcat 8.X/9.X”.

On IBM WebSphere Application Server, see the Creating Users and Groups section of the
Red Hat JBoss BPM Suite IBM WebSphere Installation and Configuration Guide .

On Oracle WebLogic Server, see the Configuring Security Settings section of the Red Hat
JBoss BPM Suite Oracle Weblogic Installation and Configuration Guide.

2. Set the following JVM properties. The location of Business Central and the Intelligent Process
Server may be different. In such case, ensure you set the properties on the correct server
instances.

On Red Hat JBoss EAP, modify the <system-properties> section in:

EAP_HOME/standalone/configuration/standalone*.xml for standalone mode.

EAP_HOME/domain/configuration/domain.xml for domain mode.

On Red Hat JBoss Web Server, see Section 3.2.1, “Red Hat JBoss Web Server 2. X/3.X,
Tomcat 8.X/9.X”.

On IBM WebSphere Application Server, see section Adding Custom JVM Properties  of the
Red Hat JBoss BPM Suite IBM WebSphere Installation and Configuration Guide .

On Oracle WebLogic Server, see section Setting Environment Variables of the Red Hat
JBoss BPM Suite Oracle WebLogic Installation and Configuration Guide.

Table 3.7. JVM Properties for Intelligent Process Server Instance

Property Value Note

org.kie.server.id default-kie-server The Intelligent Process Server
ID.

org.kie.server.controller http://localhost:8080/busin
ess-central/rest/controller

The location of Business
Central.

org.kie.server.controller.u
ser

controllerUser The user name with the role 
rest-all as mentioned in the
previous step.
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org.kie.server.controller.p
wd

controllerUser1234; The password of the user
mentioned in the previous step.

org.kie.server.location http://localhost:8080/kie-
server/services/rest/server

The location of the Intelligent
Process Server.

Property Value Note

Table 3.8. JVM Properties for Business Central Instance

Property Value Note

org.kie.server.user controllerUser The user name with the role 
kie-server as mentioned in
the previous step.

org.kie.server.pwd controllerUser1234; The password of the user
mentioned in the previous step.

3. Verify the successful start of the Intelligent Process Server by sending a GET request to 
http://SERVER:PORT/kie-server/services/rest/server/. Once authenticated, you get an XML
response similar to this:

4. Verify successful registration by logging into Business Central and selecting Deploy →
Execution Servers. If successful, you can see the registered server ID.

3.3.3. Unmanaged Intelligent Process Server

An unmanaged Intelligent Process Server is a standalone instance, and therefore must be configured

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<response type="SUCCESS" msg="Kie Server info">
    <kie-server-info>
        <capabilities>BRM</capabilities>
        <capabilities>BPM-UI</capabilities>
        <capabilities>BPM</capabilities>
        <capabilities>BRP</capabilities>
        <capabilities>KieServer</capabilities>
        <location>http://localhost:8080/kie-server/services/rest/server</location>
        <messages>
            <content>Server KieServerInfo{serverId='local-server-123', version='6.4.0.Final-
redhat-3', location='http://localhost:8080/kie-server/services/rest/server'}started successfully 
at Fri Jun 03 13:48:44 CEST 2016</content>
            <severity>INFO</severity>
            <timestamp>2016-06-03T13:48:44.606+02:00</timestamp>
        </messages>
        <name>local-server-123</name>
        <id>local-server-123</id>
        <version>6.4.0.Final-redhat-3</version>
    </kie-server-info>
</response>
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individually using REST/JMS API from the Intelligent Process Server itself. There is no controller
involved. The configuration is automatically persisted by the server into a file and that is used as the
internal server state, in case of restarts.

The configuration is updated during the following operations:

Deploy KIE Container

Undeploy KIE Container

Start KIE Container

Stop KIE Container

NOTE

If the Intelligent Process Server is restarted, it will attempt to re-establish the same state
that was persisted before shutdown. Therefore, KIE Containers that were running will be
started, but the ones that were stopped will not.

3.3.4. Unified Execution Servers

Since Red Hat JBoss BPM Suite version 6.4, it is possible to configure both Business Central and the
Intelligent Process Server to use the same data source. This enables you to work with your processes
using both applications. In such a setup, it is recommended to use Business Central for operations that
require a graphical user interface and the Intelligent Process Server for all remote calls.

WARNING

The following restrictions apply:

The Container ID must be the same as the deployment unit ID.

The SINGLETON runtime strategy cannot be used.

Triggering the execution of a part of a single process instance, between two
safe points, on both the execution servers results in a successful execution
on the first execution server only. The other execution server will throw an
exception and will not modify the process data in the database.

Do not deploy both Business Central and Intelligent Process Server in the same
application server in a production environment. Deploying both Business Central
and Intelligent Process Server in the same application server is only applicable for
development environments. Furthermore, unified execution settings require the
exact same configurations (such as database, scheduler, executor, KJAR
deployments, and so on) regardless of whether the deployment uses a single
application server or not.

When configuring unified execution servers, the Intelligent Process Server must be managed by
Business Central according to Section 3.3.2, “Managed Intelligent Process Server”, and the following
system properties need to be set:
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On Red Hat JBoss EAP, modify the <system-properties> section in:

EAP_HOME/standalone/configuration/standalone*.xml for standalone mode.

EAP_HOME/domain/configuration/domain.xml for domain mode.

On Red Hat JBoss Web Server, see Section 3.2.1, “Red Hat JBoss Web Server 2. X/3.X, Tomcat
8.X/9.X”.

On IBM WebSphere Application Server, see the Adding Custom JVM Properties  section of the
Red Hat JBoss BPM Suite IBM WebSphere Installation and Configuration Guide .

On Oracle WebLogic Server, see the Setting Environment Variables section of the Red Hat
JBoss BPM Suite Oracle WebLogic Installation and Configuration Guide.

3.4. CREATING CONTAINERS

Once the Intelligent Process Server is registered, you can start adding containers. Containers are self-
contained environments that have been provisioned to hold instances of your packaged and deployed
rule instances.

To create a container:

1. Log in to Business Central.

2. In the main menu on the top, click Deploy → Execution Servers.

3. Select your server from the SERVER TEMPLATES section on the left side of the page.

4. Click Add Container in the KIE CONTAINERS section.
The New Container dialog window opens.

5. Enter a name of your container and search for the project you want to deploy in the container.
Click Select next to the project to automatically enter the project’s details.
Alternatively, you can enter Group Name, Artifact Id, and Version manually.

WARNING

When entering the container’s version number, do not use the LATEST or 
RELEASE keywords. This feature has been deprecated and can cause
deployment issues.

6. Click Next to configure the runtime strategy, KieBase, KieSession, and merge mode for your
container. You can skip this step.

7. Click Finish.

After the container is successfully created, click Start at the upper right hand corner to start it.

Figure 3.1. Container in Started Mode
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Figure 3.1. Container in Started Mode

To verify that the container is running, send a [GET] request to the endpoint.

Example 3.1. Server Response

3.5. MANAGING CONTAINERS

Containers within the Intelligent Process Server can be started, stopped, and updated from Business
Central.

3.5.1. Starting, Stopping, and Deleting Containers

<response type="SUCCESS" msg="Info for container myContainer">
  <kie-container container-id="myContainer" status="STARTED">
    <messages>
      <content>Container myContainer successfully created with module 
org.jbpm:CustomersRelationship:1.0.</content>
      <severity>INFO</severity>
      <timestamp>2016-03-02T11:43:40.806+01:00</timestamp>
    </messages>
    <release-id>
      <artifact-id>CustomersRelationship</artifact-id>
      <group-id>org.jbpm</group-id>
      <version>1.0</version>
    </release-id>
    <resolved-release-id>
      <artifact-id>CustomersRelationship</artifact-id>
      <group-id>org.jbpm</group-id>
      <version>1.0</version>
    </resolved-release-id>
    <scanner status="DISPOSED"/>
  </kie-container>
</response>
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A container is stopped by default. To start the container:

1. Log in to Business Central.

2. In the main menu on the top, click Deploy → Execution Servers.

3. Select your server from the SERVER TEMPLATES section on the left side of the page.

4. Find the container you want to start under the KIE CONTAINERS section on the left.

5. Click Start at the upper right hand corner.
Alternatively, click Stop to stop a running container. Once a container is stopped, you can click
Remove to remove it.

3.5.2. Upgrading Containers

It is possible to update deployed containers without restarting the Intelligent Process Server, which can
be used in cases where business rule changes cause new versions of packages to be provisioned. You
can have multiple versions of the same package provisioned and deployed.

To upgrade a container:

1. Log in to Business Central.

2. In the main menu on the top, click Deploy → Execution Servers.

3. Select your server from the SERVER TEMPLATES section on the left side of the page.

4. Find the container you want to upgrade under the KIE CONTAINERS section on the left.

5. Click on the Version Configuration tab at the top.

6. Enter a new version and click Upgrade.
Optionally, if you want a deployed container to always have the latest version of your
deployment without manually editing it, set the Version value to LATEST and click Scan Now. If
a newer version of a container deployment is found in the repository during the scanning, the
container is automatically upgraded to this newer version. To start the scanner in the
background, click Start Scanner and specify a scan interval in milliseconds.

The Version value can be set to LATEST if you are creating a deployment for the first time.

3.5.3. Managing Multiple Containers

The Intelligent Process Server allows you to create and provision multiple containers.

Select your server under the REMOTE SERVERS section to view all containers and their statuses.

Figure 3.2. Managing Multiple Containers
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Figure 3.2. Managing Multiple Containers
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CHAPTER 4. REPOSITORY HOOKS
In Business Central, it is possible to trigger a chosen action every time a particular event happens. For
this purpose, you can configure the repository to use scripts called hooks.

4.1. CONFIGURING GIT HOOKS

Business Central can automatically push changes to a remote repository using the Git hooks. Git hooks
support has been introduced with the release of Red Hat JBoss BPM Suite 6.2.0.

NOTE

Please note that currently only the post-commit hook is supported. Post-commit hooks
are triggered after finishing the entire commit process.

The following procedure shows how to configure the post-commit hook to automatically push your
changes to the remote repository.

1. In Business Central, go to Authoring → Administration.

2. Below the main menu, click Repositories → Clone repository.

3. In the displayed Clone repository dialog box, fill in the repository information:

Repository Name

Organizational Unit

Git URL: For example https://github.com/USERNAME/REPOSITORY_NAME.git

IMPORTANT

It is important to use the HTTPS or Git protocol instead of a SCP-style SSH
URL. Business Central does not support the basic SSH URL and fails with
Invalid URL format .

Figure 4.1. An invalid SCP-style SSH URL.
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Figure 4.1. An invalid SCP-style SSH URL.

User Name: your Git user name

Password: your Git password

4. Change to the created repository:

cd JBOSS_HOME/bin/.niogit/REPOSITORY_NAME.git

5. Change the remote URL:

git remote set-url origin git@github.com:USERNAME/REPOSITORY_NAME.git

Make sure that you can access the remote repository through command line using SSH. For
example, the private SSH key for the repository should exist under the ~/.ssh/ directory.

If you created a new repository, you may encounter the following error:

fatal: No such remote 'origin'

To resolve it, add the remote origin URL:

git remote add origin git@github.com:USERNAME/REPOSITORY_NAME.git

6. Verify that the remote repository was successfully added:

git remote -v

The command should list the following:
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origin  git@github.com:USERNAME/REPOSITORY_NAME.git (fetch)
origin  git@github.com:USERNAME/REPOSITORY_NAME.git (push)

7. Create a file named post-commit with the permissions set to rwxr--r-- under 
JBOSS_HOME/bin/.niogit/REPOSITORY_NAME.git/hooks with the following content:

#!/bin/sh
git push origin master

8. Make sure that the configuration was successful by creating a new guided rule in Business
Central:

a. Go to Authoring → Project Authoring → New Item → Guided Rule.

b. Fill in the required information in the displayed Create new Guided Rule window.

c. Click Ok.

All of the changes should be pushed automatically.

For further information about remote Git repositories, see How to configure the BxMS 6 server to use a
remote Git repository for storing assets?.

It is also possible to specify the system property org.uberfire.nio.git.hooks. Its value determines a
directory with default hook files, which will be copied to the newly created Git repositories. See the
example of a standalone.xml file with this setting below:

<system-properties>
  <property name="org.uberfire.nio.git.hooks" value="/opt/jboss-as/git-hooks">
  </property>
  ...
</system-properties>
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CHAPTER 5. COMMAND LINE CONFIGURATION
The kie-config-cli tool is a command line configuration tool that provides capabilities to manage the
system repository from the command line and can be used in an online or offline mode.

Online mode (default and recommended)

On startup, the tool connects to a Git repository using a Git server provided by kie-wb. All changes
are made locally and published to upstream only after explicitly executing the push-changes
command. Use the exit command to publish local changes. To discard local changes on exit, use the
discard command.

Offline mode (installer style)

Creates and manipulates the system repository directly on the server (there is no discard option).

The tool is available on the Red Hat Customer Portal . To download the kie-config-cli tool, do the
following:

1. Go to the Red Hat Customer Portal  and log in.

2. Click DOWNLOADS at the top of the page.

3. In the Product Downloads page that opens, click Red Hat JBoss BPM Suite.

a. From the Version drop-down menu, select 6.4.0.

b. In the displayed table, navigate to the Supplementary Tools row and then click Download.

Extract the zip package for supplementary tools you downloaded from the Red Hat Customer Portal . It
contains the directory kie-config-cli-6.MINOR_VERSION-redhat-x-dist with file kie-config-cli.sh.

5.1. STARTING THE KIE-CONFIG-CLI TOOL IN ONLINE MODE

1. To start the kie-config-cli tool in online mode, navigate to the kie-config-cli-
6.MINOR_VERSION-redhat-x-dist directory where you installed the tool and then execute the
following command.

2. In a Unix environment run:

./kie-config-cli.sh

In a Windows environment run:

./kie-config-cli.bat

By default, the tool starts in online mode and asks for user credentials and a Git URL to connect to (the
default value is git://localhost/system). To connect to a remote server, replace the host and port with
appropriate values.

Example: git://kie-wb-host:9148/system

5.2. STARTING THE KIE-CONFIG-CLI TOOL IN OFFLINE MODE

To operate in offline mode, append the offline parameter to the command as below.

1. Navigate to the kie-config-cli-6.MINOR_VERSION-redhat-x-dist directory where you installed
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1. Navigate to the kie-config-cli-6.MINOR_VERSION-redhat-x-dist directory where you installed
the tool.

2. In a Unix environment, run:

./kie-config-cli.sh offline

In a Windows environment, run:

./kie-config-cli.bat offline

Executing this command changes the tool’s behaviour and displays a request to specify the folder where
the system repository (.niogit) is located. If .niogit does not yet exist, the folder value can be left empty
and a brand new setup is created.

5.3. COMMANDS AVAILABLE FOR THE KIE-CONFIG-CLI TOOL

The following commands are available for managing the Git repository using the kie-config-cli tool:

add-deployment: Adds a new deployment unit

add-repo-org-unit: Adds a repository to the organizational unit

add-role-org-unit: Adds role(s) to an organizational unit

add-role-project: Adds role(s) to a project

add-role-repo: Adds role(s) to a repository

create-org-unit: Creates new organizational unit

create-repo: Creates a new git repository

discard: Does not publish local changes, cleans up temporary directories and closes the tool

exit: Publishes work, cleans up temporary directories and closes the tool

fetch-changes: Fetches changes from upstream repository

help: Prints available commands with descriptions

list-deployment: Lists available deployments

list-org-units: Lists available organizational units

list-repo: Lists available repositories

push-changes: Pushes changes to upstream repository (in online mode only)

remove-deployment: Removes existing deployment

remove-org-unit: Removes existing organizational unit

remove-repo: Removes an existing repository from config only

remove-repo-org-unit: Removes a repository from the organizational unit
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remove-role-org-unit: Removes role(s) from an organizational unit

remove-role-project: Removes role(s) from a project

remove-role-repo: Removes role(s) from a repository
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CHAPTER 6. MIGRATION
Migrating your projects from Red Hat JBoss BPM Suite 5 to Red Hat JBoss BPM Suite 6 requires
careful planning and step by step evaluation of the various issues. You can plan for migration either
manually, or by using automatic processes. Most real world migration will require a combination of these
two processes.

Because Red Hat JBoss BPM Suite 6 uses Git for storing assets, artifacts and code repositories
including processes and rules, you should start by creating an empty project in Red Hat JBoss BPM
Suite 6 as the basis for your migration with dummy files as placeholders for the various assets and
artifacts. Running a Git clone of this empty project into your favorite IDE will initiate the migration
process.

Based on the placeholder files in your cloned project, you can start adding assets at the correct
locations. The Red Hat JBoss BPM Suite 6 system is smart enough to pick these changes and apply
them correctly. Ensure that when you are importing old rule files that they are imported with the right
package name structure.

Since Maven is used for building projects, the projects assets like the rules, processes and models are
accessible as a simple JAR file.

This section lists the generally accepted step by step ways to migrate your project. These are just
guidelines though, and actual migration may vary a lot from this.

In general, you should:

1. Migrate the data first: These are your business assets.

2. Next, migrate your runtime processes.

3. Finally, convert old API calls to new ones one by one.

Let us look at these steps in more detail in the next few sections:

6.1. DATA MIGRATION

To migrate data from Red Hat JBoss BPM Suite 5, do the following:

1. Download the migration tool by logging in at the Red Hat Customer Portal  and then navigating
to Red Hat JBoss BPM Suite Software Downloads section. Click on Red Hat JBoss BPM Suite
Migration Tool to download the zip archive.

2. Unzip the downloaded zip archive in a directory of your choice and navigate to this directory in a
command prompt. This directory contains four folders:

bin - contains the launch scripts.

jcr-exporter-libs - contains the libs specific to the export-from-JCR part of the migration.

vfs-importer-libs - contains the libs specific to the import-into-Git part of the migration.

conf - contains global migration tool configuration.

3. For production databases, copy the JDBC driver for the database that is used by the JCR
repository into the jcr-exporter-libs directory of the migration tool.

4. Execute the following command:
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./bin/runMigration.sh -i <source-path> -o <destination-path> -r <repository-name>

Where:

<source-path> is a path to a source JCR repository.

<desintation-path> is a path to a destination Git VFS. This folder must not exist already.

<repository-name> an arbitrary name for the new repository.

The repository is migrated at the specified destination.

Besides the -i command, you can also use -h to print out a help message and -f which forces an
overwrite of the output directory, thus eliminating the need for manual deletion of this directory.

Importing the Repository in Business Central
The repository can be imported in business central by cloning it. In the Administration perspective, click
on the Repositories → Clone Repository menu to start the process.

NOTE

Assets can also be migrated manually as they are all just text files. The BPMN2
specification and the DRL syntax did not change between the different versions.

Importing the Repository in JBDS
To import the repository in JBoss Developer Studio, do the following

1. Start JBoss Developer Studio.

2. Start the Red Hat JBoss BPM Suite server (if not already running) by selecting the server from
the server tab and click the start icon.

3. Select File → Import… and navigate to the Git folder. Open the Git folder to select Projects
from Git and click next.

4. Select the repository source as Existing local repository and click next.

5. Select the repository that is to be configured from the list of available repositories.

6. Import the project as a general project in the next window and click next. Name this project and
click Finish.

6.2. RUNTIME MIGRATION

To run Red Hat JBoss BPM Suite 5 processes in Red Hat JBoss BPM Suite 6, do the following:

1. Set the system property jbpm.v5.id.strategy to true in the JBoss BPM Suite standalone.xml
file:

<property name="jbpm.v5.id.strategy" value="true"/>

2. Add the Maven dependencies. For a list of Maven dependencies, see example Embedded jBPM
Engine Dependencies in chapter Dependency Management of the Red Hat JBoss BPM Suite
Development Guide.
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3. Load the KieSession as shown here:

4. Continue the normal execution of the process using KieSession methods:

6.3. API AND BACKWARDS COMPATIBILITY

Migrating to Version 6.1
In version 6.1, 5.X APIs are no longer officially supported.

Red Hat JBoss BPM Suite no longer provides backward compatibility with the rule, event, and process
application programming interface (API) from Red Hat JBoss BRMS 5. The content of the knowledge-
api JAR file is no longer supported in version 6.1 and is replaced by APIs contained in the kie-api JAR
file that were introduced in Red Hat JBoss BPM Suite 6.0.

If you used the legacy 5.x API (located in knowledge-api.jar), please migrate (rewrite) the API calls to
the new KIE API. Please be aware that several other APIs have changed between Red Hat JBoss BRMS
5.x and Red Hat JBoss BPM Suite 6.x, namely the task service API and the REST API.

Migrating to Version 6.0
The Red Hat JBoss BPM Suite 6 system provides backward compatibility with the rule, event and
process interactions from JBoss BRMS 5. You should eventually migrate (rewrite) these interactions to
the all new revamped core API because this backward compatibility is likely to be deprecated.

If you cannot migrate your code to use the new API, then you can use the API provided by the purpose
built knowledge-api JAR for backwards compatible code. This API is the public interface for working
with JBoss BPM Suite and JBoss BRMS and is backwards compatible.

If you are instead using the REST API in Red Hat JBoss BPM Suite 5, note that this has changed as well
and there is no mechanism in it for backwards compatibility.

6.4. MIGRATING TASK SERVICE

Red Hat JBoss BPM Suite 6 provides support for a locally running task server only. This means that you
do not need to setup any messaging service in your project. This differs from Red Hat JBoss BPM Suite
5 because it provided a task server that was bridged from the core engine by using, most commonly, the
messaging system provided by HornetQ.

To help you bridge the gap until you can migrate this in your current architecture, there is a helper or
utility method, LocalHTWorkItemHandler.

Since the TaskService API is part of the public API you will now need to refactor your imports because of
package changes and refactor your methods due to API changes themselves.

import org.kie.api.runtime.KieSession;
import org.kie.internal.persistence.jpa.JPAKnowledgeService;
...

KieSession ksession = JPAKnowledgeService.loadStatefulKnowledgeSession(sessionID, 
kbase, sessionConf, env);

ksession.signalEvent("SomeEvent", null);
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CHAPTER 7. DATA MANAGEMENT

7.1. DATA BACKUPS

When applying a backup mechanism to Red Hat JBoss BPM Suite, ensure you back up the following
resources:

Any customized deployment descriptors (such as, web.xml, jboss-web.xml, jboss.xml).

Any customized properties files.

NOTE

Consider backing up the entire business-central.war and dashbuilder.war files.

The JBOSS-HOME/bin/.niogit folder. This directory contains Git repositories that Business
Central manages internally to store project and configuration data.

NOTE

The location of the .niogit directory may be different based on your
configuration. See the org.uberfire.nio.git.dir system property .

7.2. SETUP INDEXES

Setup Foreign Key Indexes
Some databases, for instance Oracle and PostgreSQL, do not automatically create an index for each
foreign key. This can result in deadlocks occurring. To avoid this situation, it is necessary to create an
index on all foreign keys, especially in the Oracle database.

Setup Indexes for Process and Task Dashboard
Process and Task Dashboard in 6.1 has been refactored in order to cope with high volume of task and
process instances. In order to get good response times while querying the database the following JBoss
BPM Suite tables need to be indexed: processinstancelog and bamtasksummary.

Note that ALL the columns in these two tables need to be indexed and not just the primary and foreign
keys.

7.3. SETTING UP AND EDITING THE DATABASE

For information on how to change the database for Red Hat JBoss BPM Suite, see Persistence Setups
of the Red Hat JBoss BPM Suite Installation Guide .

7.4. DDL SCRIPTS

DDL scripts for database tables for Red Hat JBoss BPM Suite are available for download on the
Customer Portal. These scripts allow you to study the tables and use them to create the tables and
indexes manually or in databases that are not directly supported.

To download these scripts:

1. Login to the Customer Portal.
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2. Click on Red Hat JBoss BPM Suite and select the version of the product for your requirements.

3. Click on Download in the row Red Hat JBoss BPM Suite 6.4.0 Supplementary Tools  to download
the supplementary tools.

Unzip the file on your machine. The DDL scripts are located in the ddl-scripts directory. Database
scripts are provided for DB2, H2, MySQL5, Oracle, PostgreSQL, and SQLServer.

The complete Entity Relationship diagram can be viewed in this Red Hat Solution .
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CHAPTER 8. ASSET REPOSITORY
Business Rules, Process definition files, and other assets and resources created in Business Central are
stored in Asset repository, which is otherwise known as the Knowledge Store.

The Knowledge Store is a centralized repository for your business knowledge. The Knowledge Store
connects to the Git repository to store various knowledge assets and artifacts at a single location.
Business Central provides a web front-end that allows you to view and update the stored content. You
can access the content by using the Project Explorer from the unified environment of Red Hat JBoss
BPM Suite.

All business assets are stored in repositories. These repositories are then saved in directories called
organizational units. By default, the Knowledge Store in Business Central does not contain any
organizational unit. Therefore, to be able to create your own business assets, you need to create an
organizational unit and a repository first.

8.1. CREATING AN ORGANIZATIONAL UNIT

It is possible to create an organizational unit either in the Administration perspective of Business
Central, using the kie-config-cli tool, or the REST API calls.

Creating an Organizational Unit in Business Central

IMPORTANT

Note that only users with the admin role in Business Central can create organizational
units.

Procedure: Using Business Central to Create an Organizational Unit

1. In Business Central, go to Authoring → Administration.

2. On the perspective menu, click Organizational Units → Manage Organizational Units.

3. In the Organization Unit Manager view, click Add.
The Add New Organizational Unit dialog window opens.

Figure 8.1. Add New Organizational Unit_Dialog Window
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Figure 8.1. Add New Organizational Unit_Dialog Window

4. Enter the two mandatory parameters (name and default group ID) and click Ok.

Creating an Organizational Unit Using the kie-config-cli Tool
Organizational units can be created using the kie-config-cli tool as well. To do so, run the create-org-
unit command. The tool then guides you through the entire process of creating an organizational unit by
asking for other required parameters. Type help for a list of all commands.

For more information about the kie-config-cli tool, see Chapter 5, Command Line Configuration .

Creating an Organizational Unit Using the REST API

IMPORTANT

Note that only users with the rest-all role can create organizational units.

To create an organizational unit in Knowledge Store, issue the POST REST API call. Details of the
organizational unit are defined by the JSON entity.

Input parameter of the call is a OrganizationalUnit instance. Call returns a 
CreateOrganizationalUnitRequest instance.

Example 8.1. Creating an Organizational Unit Using the Curl Utility

Example JSON entity containing details of an organizational unit to be created:

{
  "name"         : "helloWorldUnit",
  "owner"        : "tester",
  "description"  :  null,
  "repositories" :  []
}
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Execute the following command:

curl -X POST 'localhost:8080/business-central/rest/organizationalunits/' -u 
USERNAME:PASSWORD -H 'Accept: application/json' -H 'Content-Type: application/json' -d 
'{"name":"helloWorldUnit","owner":"tester","description":null,"repositories":[]}'

For further information, refer to chapter Knowledge Store REST API , section Organizational Unit Calls of
Red Hat JBoss BPM Suite Development Guide .

8.2. CREATING A REPOSITORY

There are three ways to create a repository: through the Administration perspective of Business
Central, the kie-config-cli tool, or using the REST API calls.

Creating a Repository in Business Central

IMPORTANT

Note that only users with the admin role in Business Central can create repositories.

Procedure: Using Business Central to Create a Repository

1. In Business Central, go to Authoring → Administration.

2. On the perspective menu, click Repositories → New repository.
The New Repository pop-up window is displayed.

Figure 8.2. New Repository Dialog Window

3. Specify the two mandatory parameters:

Repository name

NOTE

Make sure that the repository name is a valid file name. Avoid using a space or
any special character that might lead to an invalid name.

Organizational unit: Specifies the location of the newly created repository.

4. Click Finish.
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You can view the newly created repository either in the File Explorer or the Project Explorer.

Creating Repository Using kie-config-cli Tool
To create a new Git repository using the kie-config-cli tool, run the create-repo command. The tool
then guides you through the entire process of creating a repository by asking for other required
parameters. Type help for a list of all commands.

For more information about the kie-config-cli tool, see Chapter 5, Command Line Configuration .

Creating Repository Using REST API

IMPORTANT

Note that only users with the rest-all role can create repositories.

To create a repository in the Knowledge Store, issue the POST REST API call. Details of the repository
are defined by the JSON entity. Make sure you established an authenticated HTTP session before
executing this call.

Input parameter of the call is a RepositoryRequest instance. Call returns a 
CreateOrCloneRepositoryRequest instance.

Example 8.2. Creating Repository Using Curl Utility

Example JSON entity containing details of a repository to be created:

{
  "name"                   : "newRepository",
  "description"            :  null,
  "gitURL"                 :  null,
  "requestType"            : "new",
  "organizationalUnitName" : "helloWorldUnit"
}

Execute the following command:

curl -X POST 'localhost:8080/business-central/rest/repositories/' -u USERNAME:PASSWORD -H 
'Accept: application/json' -H 'Content-Type: application/json' -d 
'{"name":"newRepository","description":null,"requestType":"new","gitURL":null,"organizationalUnitNa
me":"helloWorldUnit"}'

For further information, refer to chapter Knowledge Store REST API , section Repository Calls of Red Hat
JBoss BPM Suite Development Guide.

8.3. CLONING A REPOSITORY

It is possible to clone a repository either in Business Central or using the REST API calls. The kie-config-
cli tool cannot be used to clone arbitrary repositories. Run git clone, or use one of the following options
instead:

Cloning a Repository in Business Central

IMPORTANT
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IMPORTANT

Note that only users with the admin role in Business Central can clone repositories.

Procedure: Using Business Central to Clone a Repository

1. In Business Central, go to Authoring → Administration.

2. On the perspective menu, choose Repositories → Clone repository.
The Clone Repository pop-up window is displayed.

Figure 8.3. Clone Repository Dialog Window

3. In the Clone Repository dialog window, enter the repository details:

a. Enter the Repository Name to be used as the repository identifier in the Asset repository
and select the Organizational Unit it should be added to.

b. Enter the URL of the Git repository:

For a local repository, use file:///PATH_TO_REPOSITORY/REPOSITORY_NAME.

For a remote or preexisting repository, use 
https://github.com/USERNAME/REPOSITORY_NAME.git or 
git://HOST_NAME/REPOSITORY_NAME.

IMPORTANT
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IMPORTANT

It is important to use the HTTPS or Git protocol instead of a SCP-style
SSH URL. Business Central does not support the basic SSH URL and
fails with Invalid URL format.

NOTE

The file protocol is only supported for READ operations. WRITE operations
are not supported.

c. If applicable, enter the User Name and Password of your Git account to be used for
authentication.

4. Click Clone.
A confirmation prompt with the notification that the repository was created successfully is
displayed.

5. Click Ok.
The repository is now being indexed. Some workbench features may be unavailable until the
indexing has completed.

You can view the cloned repository either in the File Explorer or the Project Explorer.

NOTE

If you are deploying Business Central on WebLogic server, set the following Java system
property in the setDomainEnv.sh file (for Linux) or setDomainEnv.cmd file (for
Windows):

JAVA_OPTIONS="%JAVA_OPTIONS% -DUseSunHttpHandler=true"

This enables the WebLogic server to use the HTTP handlers.

Cloning a Repository Using the REST API
To clone a repository, issue the POST REST API call. This call creates or clones (according to the value
of the requestType parameter) the repository defined by the JSON entity.

The input parameter of the call is a RepositoryRequest instance. The Call returns a 
CreateOrCloneRepositoryRequest instance.

IMPORTANT

Note that, only users with the rest-all role can clone repositories.

Example 8.3. Cloning a Repository Using the Curl Utility

Example JSON entity containing details of a repository to be cloned:

{
  "name"                   : "clonedRepository",
  "description"            :  null,
  "requestType"            : "clone",
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  "gitURL"                 : "git://localhost:9418/newRepository",
  "organizationalUnitName" : "helloWorldUnit"
}

Execute the following command:

curl -X POST 'localhost:8080/business-central/rest/repositories/' -u USERNAME:PASSWORD -H 
'Accept: application/json' -H 'Content-Type: application/json' -d 
'{"name":"clonedRepository","description":null,"requestType":"clone","gitURL":"git://localhost:9418/ne
wRepository","organizationalUnitName":"helloWorldUnit"}'

For further information, refer to chapter Knowledge Store REST API , section Repository Calls of Red Hat
JBoss BPM Suite Development Guide.

8.4. REMOVING A REPOSITORY

Repositories can be removed using any of the following procedures.

Removing a Repository in Business Central
The simplest way to remove a repository is using the RepositoryEditor in Business Central.

Procedure: Using Business Central to Remove a Repository

1. In Business Central, go to Authoring → Administration.

2. Select Repositories from the tree menu on the left.

3. In the RepositoryEditor on the right side of the page, locate the repository you want to delete
from the list of available repositories.

4. From the drop-down menu, select master → Delete.
The following message will appear:

Are you sure you want to remove Repository "REPOSITORY_NAME"? Some editors may 
become inoperable if their content is inaccessible.

5. Press OK to delete the repository.

Removing a Repository Using the kie-config-cli Tool
Repositories can be removed using the kie-config-cli tool as well. To do so, run the remove-repo
command.

For further information about the kie-config-cli tool, see Chapter 5, Command Line Configuration .

Removing a Repository Using the REST API

IMPORTANT

Note that only users with the rest-all role can remove repositories.

To remove a repository from the Knowledge Store, issue the DELETE REST API call. Make sure you
established an authenticated HTTP session before executing this call.
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The call returns a RemoveRepositoryRequest instance.

Example 8.4. Removing a Repository Using the Curl Utility

Execute the following command:

curl -X DELETE 'localhost:8080/business-central/rest/repositories/REPOSITORY_NAME' -u 
USERNAME:PASSWORD -H 'Accept: application/json' -H 'Content-Type: application/json'

For further information, refer to chapter Knowledge Store REST API , section Repository Calls of Red Hat
JBoss BPM Suite Development Guide.

8.5. MANAGING ASSETS

NOTE

To activate and use the feature described below, login to Business Central with a user
that has the kiemgmt role assigned.

To make management of projects easier, Red Hat JBoss BPM Suite now provides a way to manage
multiple projects based on standards. This allows you to create repository structures using industry
standard best practices for maintenance, versioning and distribution of your projects.

To start with, repositories can now be managed or unmanaged.

Managed and Unmanaged Repositories
Unmanaged Repositories are the repository structures that you are used to. They can contain multiple
unrelated projects.

Managed Repositories, on the other hand, provide version control at the project level and project
branches for managing the release cycle. Further, Managed Repositories can be restricted to just a
single project or encompass multiple projects. When you create a Managed Repository, the asset
management configuration process is automatically launched in order to create the repository branches.
Corresponding project structure is created as well.

NOTE

Multi-project repositories must be managed.

Procedure: Creating an Unmanaged Repository

1. In Business Central, go to Authoring → Administration.

2. Click Repositories → New Repository.
The New Repository window is displayed.

3. Enter the repository name and select an organizational unit the repository belongs to.

4. Click Finish.

Procedure: Creating a Managed Repository
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1. In Business Central, go to Authoring → Administration.

2. Click Repositories → New Repository.
The New Repository window is displayed.

3. Enter the repository name and select an organizational unit the repository belongs to.

4. Select the Managed Repository check box and click Next to enter additional details of the
Managed Repository.

5. Choose either the Single-project Repository or the Multi-project Repository radio button.
If the project you are creating is simple and self-contained, select the Single-project
Repository radio button. Note that you will not be able to add more projects to this repository
later.

For more complex projects, where there is likely to be a parent project that encompasses
smaller ones, select the Multi-project Repository radio button.
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6. Enter the details of the managed project along with the GAV (Group, Artifact, Version) details.
Note that all projects created in a Multi-project Repository will be managed together, with
their version numbers being incremented together as well. Details of the parent project will be
inherited by all future projects that you create in this Managed Repository.

7. Click Finish .

NOTE

If you create an unmanaged repository and add a pom.xml file (a parent Project Object
Model (POM) file) directly under the repository directory, Red Hat JBoss BPM Suite
converts the repository to a managed repository. For instructions about changing the
repository status back to unmanaged, see the Red Hat Knowledgebase article An
Unmanaged Repository Unexpectedly Turned Into "Managed" in BRMS / BPM Suite.

Managed Branches
With Managed Repositories comes the added advantage of Managed Branches. As in Git, you can
choose to work on different branches of your project (for example: master, dev and release). This
process of branching can also be automated for you, by selecting the checkbox while creating a new
Managed Repository (for both single and multi-projects).

You can switch between branches by selecting the desired branch while working in the Project Explorer.

Repository Structure
If you do not select automatic branch management while creating a repository, you can create branches
manually afterwards. For Managed Repositories, you can do so by using the Configure button. This
button, along with Promote and Release buttons, is provided in the Repository Structure view. You
can access this view, by clicking on Repository → Repository Structure in the Project Explorer
perspective menu.

Clicking on the Configure button allows you to create branches or edit automatically created ones.
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You can promote assets from the master branch to other branches using the Promote button. Similarly,
you can Release branches and deploy them on the server using the Release button.

Both these functions are controlled internally by the use of pre-defined processes that are deployed on
your instance. For example, when you click on Promote button after having done work on your
development branch, a Promote Changes process is started in the background. A user, with the role of 
kiemgmt will have a user task appear in this task list to review the assets being promoted. This user can
claim this task, and decide to promote all, some or none of the assets. The underlying process will
cherry-pick the commits selected by the user to a release branch. This user can also request another
review of these assets and this process can be repeated multiple times till all the assets are ready for
release. The flow for this process is shown below:

Similarly, when you click on the Release button, a release process flow is initiated. This process flow
builds the project and updates all the Maven artifacts to the next version, and deploys the project to the
runtime, if runtime deployment details are supplied.
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WARNING

Project branches to be released must start with the keyword release.

8.6. MAVEN REPOSITORY

Maven is a software project management tool which uses a project object model (POM) file to manage:

Builds

Documentation

Reporting

Dependencies

Releases
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SCMs

Distribution

A Maven repository is used to hold or store the build artifacts and project dependencies and is generally
of two types:

Local

Refers to a local repository where all the project dependencies are stored and is located with the
current installation in the default folder as "m2". It is a cache of the remote downloads, and also
contains the temporary build artifacts which have not yet been released.

Remote

Refers to any other type of repository that can be accessed by a variety of protocols such as file:// or
http://. These repositories can be at a remote location set up by a third-party for downloading of
artifacts or an internal repository set up on a file or HTTP server, used to share private artifacts
between the development teams for managing internal releases.

8.7. CONFIGURING DEPLOYMENT TO A REMOTE NEXUS
REPOSITORY

Nexus is a repository manager frequently used in organizations to centralize storage and management
of software development artifacts. It is possible to configure your project so that artifacts produced by
every build are automatically deployed to a repository on a remote Nexus server.

To configure your project to deploy artifacts to a remote Nexus repository, add a 
distributionManagement element to your project’s pom.xml file as demonstrated in the code example
below.

Replace the URLs in the example with real URLs of your Nexus repositories. The repository specified in
the snapshotRepository element is used when the -SNAPSHOT qualifier is appended to the project’s
current version number. In other cases the repository specified in the repository element is used.

If your Nexus server requires authentication, you will also need to modify your projects Maven settings
to add your credentials in the settings-security.xml file, using a master password. By default, this file is
in the $M2_HOME/conf folder, unless you have changed its location by modifying the 
kie.maven.settings.custom system property. It is also possible to create new user-specific 
settings.xml and settings-security.xml files in the ~/.m2 folder. In that case, these files will override
the original ones.

See the following example of the settings-security.xml:

<distributionManagement>
  <repository>
    <id>deployment</id>
    <name>Internal Releases</name>
    <url>http://your_nexus_host:8081/nexus/content/repositories/releases</url>
  </repository>
  <snapshotRepository>
    <id>deployment</id>
    <name>Internal Releases</name>
    <url>http://your_nexus_host:8081/nexus/content/repositories/snapshots/</url>
  </snapshotRepository>
</distributionManagement>
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IMPORTANT

Note that keeping your server authentication credentials (for example the passwords) as
a plain text in the settings.xml file is not recommended. All the information should be
hashed with a master password in the settings-security.xml file.

For further information about password encryption and creating a master password, see
the Apache Maven documentation, article Password Encryption.

With this configuration in place, clicking the Build & Deploy button in Business Central executes a
Maven build and deploys the built artifacts both to the local repository and to one of the Nexus
repositories specified in the pom.xml file.

<servers>
  <server>
    <id>deployment</id>
    <username>admin</username>
    <password>{COQLCE6DU6GtcS5P=}</password>
  </server>
</servers>
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CHAPTER 9. PROCESS CREATION, IMPORT, AND EXPORT

9.1. CREATING PROCESS

NOTE

Decide whether you want to create a process in a package of a particular project. See
Section 1.5, “Creating Package” for more information.

To create a process:

1. In Business Central, click Authoring → Project Authoring.

2. In Project Explorer, locate the project in which you want to create the process.

3. Click New Item → Business Process at the top of Project Explorer.
The Create New Business Process dialog window opens.

4. Enter a name and select a package (optional). Click Ok.
Process Editor with the newly created process opens.

9.2. IMPORTING PROCESS

Importing Process in BPMN2 or JSON Format in Process Editor

1. In Business Central, click Authoring → Project Authoring.

2. In Project Explorer, locate the project and the respective package into which you want to import
the process.

3. If you want to merge the process with any other existing process, open the already existing
process in Process Editor. If you want to import a process without changing any of the existing
processes, create a new process.

4. In Process Editor, click the Import icon  and choose the format of the imported process.
The Import dialog window opens.

NOTE

The available Migrate jPDL 3.2 to BPMN2 tool is a technical preview feature and
therefore is not supported.

5. Click Choose File and locate the process file, or paste the process definition into the available
text box. Click Import.

6. The Replace existing model? dialog window opens. To overwrite the opened process with the
imported process, click Yes. To merge the two processes, click No.

When importing processes, Process Editor provides visual support for process elements and therefore
requires information about elements' position on the canvas. If the information is not provided, you need
to edit the process position on the canvas manually.

Importing Process into Git Repository
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Importing Process into Git Repository

1. Clone the repository.

2. Add the process BPMN2 file into the 
REPOSITORY/PROJECT/src/main/resources/PACKAGE directory.

3. Commit the changes.

4. Push the changes.

9.3. EXPORTING PROCESS

To export a business process:

1. In Business Central, click Authoring → Project Authoring.

2. Open the process in Process Editor.

3. Click  and select View Process Sources.
The Process Sources dialog window opens.

4. Click Download BPMN2 to download the process.
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CHAPTER 10. SCHEDULER SERVICE
The Red Hat JBoss BPM Suite engine employs scheduler service to execute jobs at a scheduled time
and date. Red Hat JBoss BPM Suite has three types of scheduler service:

ThreadPoolSchedulerService

Default scheduler service that manages its own thread pool to allocate available worker threads for
the scheduled task. This service is best for a single node use case.

EjbSchedulerService

Scheduler service implementation backed by EJB Timer Service. You can enable this if you have a 
jbpm-services-ejb-timer-XXX.jar file in your application. This service is only available under Java EE
container and uses the container’s thread pool. This service is best for a single node use case.

QuartzSchedulerService

Scheduler service implementation backed by Quartz job scheduler. You can enable this when Quartz
is configured. For more information, see Setting Quartz in the Red Hat JBoss BPM Suite Installation
Guide. This service is required for a cluster use case.

NOTE

For WebSphere, use clustered EjbSchedulerService instead of QuartzSchedulerService,
even in a cluster use case. For more information, see How to set up BPM Suite Timers to
work in Websphere Application Server clustering on the Red Hat website.
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PART III. INTEGRATION
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CHAPTER 11. DEPLOYING RED HAT JBOSS BPM SUITE TO
AMAZON EC2 WEB SERVICE

Amazon Elastic Compute Cloud (hereinafter referred to as Amazon EC2) is a web service providing a
computing environment in the Amazon Web Services (AWS) cloud. Deploying Red Hat JBoss BPM Suite
to Amazon EC2 has been supported since version 6.2.

Amazon EC2 can be used to create a virtual machine and its computing environments called instances.
Templates for this instances are then known as Amazon Machine Images or AMIs. The service allows you
to modify the instance to use a required configuration of CPU, memory, storage, and other properties.
The cost of the service is calculated based on the used compute capacity.

For more information about Amazon EC2 and all the provided features, see the official AWS
Documentation.

11.1. GETTING STARTED WITH AMAZON EC2

Logging into AWS

1. Go to the Amazon Web Services main page, click Sign in to the Console and enter your user
credentials.

2. On the AWS home page that opens, choose EC2 Virtual Servers in the Cloud in the left hand
corner.
You are redirected to the EC2 Dashboard.

Figure 11.1. Amazon EC2 Dashboard

EC2 Dashboard provides an overview of your AWS account as well as the information about the overall
service health and scheduled events. The Resources section of the dashboard contains links to all
running instances, created key pairs, security groups, and more. To launch a virtual server, click the
Launch Instance quick link in the Create Instance section. The main menu on the left side of the page
contains links necessary for configuring instances and images, setting up networks and controlling
security issues.

IMPORTANT
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IMPORTANT

Note that login information in Amazon EC2 is encrypted. Before creating or starting an
instance, you need to import your public key to AWS in order to be able to connect to the
instance.

Importing Public Key

1. In the main menu on the left, click Key Pairs under the NETWORK & SECURITY drop-down
menu.

2. Click Import Key Pair at the top of the page.
The Import Key Pair dialog window opens.

3. Define the name of the key pair and either upload the public key from file, or copy and paste the
content of your public key into the Public key contents text field.

4. Click Import.
The imported key pair appears in the displayed list of key pairs.

Alternatively, you can create your own key pair using Amazon EC2. For more information, see the
Amazon EC2 Key Pairs  chapter in the AWS Documentation.

11.2. CREATING AND STARTING VIRTUAL MACHINE INSTANCES

To deploy Red Hat JBoss BPM Suite to Amazon EC2, you must have a valid membership in the JBoss
Cloud Access program. The program provides a number of supported AMIs created by Red Hat, while
each of them has Red Hat Enterprise Linux 6 and Red Hat JBoss EAP 6 (together with other required
software) pre-installed.

For further information about supported Amazon EC2 instance types, see the Deploy JBoss EAP 6 on
Amazon EC2 chapter of Red Hat JBoss Enterprise Application Platform 6.4 Administration and
Configuration Guide.

To create a virtual machine instance, do the following:

Creating Virtual Machine Instance

1. In the main menu, click AMIs under the IMAGES drop-down menu.

2. Choose one of the supported AMIs.
For example RHEL-6.7_HVM_GA-JBEAP-6.4.7-20160421-x86_64-1-Access2-GP2 (ami-
50bba23a).

3. Click Launch.
The Choose an Instance Type window opens. An instance type is a custom configuration of
CPU, memory, storage, and networking capacity of your virtual machine instance.

4. Choose one of the listed instance types.
Instance type depends on the needs of your application. KIE Server and Business Central are
usually two separated instances in AWS and each of them requires different settings. However,
at least 2 vCPUs (the number of virtual CPUs) and 7.5 GiB of memory is recommended.

It is possible to launch the instance directly from here by clicking Review and Launch. If you
want to change additional settings, see the following steps.
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5. Click Next: Configure Instance Details.
In this step, you can choose a number of launched instances, network (either EC2-Classic or
VPC, the Amazon Virtual Private Cloud), or enable detailed monitoring. If you want to keep the
default settings, continue to the next tab.

6. Click Next: Add Storage.
This screen allows you to add more Amazon Elastic Block Store (Amazon EBS) volumes and
modify the settings of the root volume. The minimum recommended size of the root volume is 
30 GiB.

IMPORTANT

Make sure that the set volume size is greater than the size of the used snapshot.

7. Click Next: Tag Instance and specify the tags for the instance that can help you search and
filter the instances later. For example, the key Name can indicate a logical name of the instance
in the instance list.

8. Click Next: Configure Security Group.
A security group is a virtual firewall containing a number of firewall rules that control the traffic
for your instance. Each instance can have one or more security groups assigned and these
groups can be modified at any time.

You need to create a new security group in order to be able to deploy Red Hat JBoss BPM
Suite:

Creating New Security Group

1. If not already selected, select the Create a new security group check box.

2. Fill in the Security group name and Description.

3. Keep the default SSH type TCP protocol rule.

4. Define three new firewall rules by clicking Add Rule:

Default SSH access to Business Central:

Type: Custom TCP Rule

Protocol: TCP

Port Range: 8001

Default HTTP port of Red Hat JBoss EAP:

Type: Custom TCP Rule

Protocol: TCP

Port Range: 8080

Default Git port:

Type: Custom TCP Rule

Protocol: TCP
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Port Range: 9418

WARNING

All the configured ports must be allowed in the PORTS_ALLOWED
property of user data. For more information, see Configuring User Data .

9. Click Review and Launch.

10. Review your instance details and if you want to launch the instance, click Launch.

A list of all created instances can be found under the Instances option in the main menu on the left. You
can filter, search and launch the instances as well as view the instance description and edit the settings.

Figure 11.2. List of Instances Searched by Name

In case you created a custom security group and defined new firewall rules with specific ports, you have
to allow these ports in user data for the new virtual machine instance.

Configuring User Data

1. In the main menu, go to INSTANCES → Instances.

2. In the list of instances, find and select the instance you want to configure.

3. Click Actions → Instance Settings → View/Change User Data.
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4. In the View/Change User Data dialog window that opens, define the PORTS_ALLOWED
property. For example:

PORTS_ALLOWED="8001 8080 9418"

5. Click Save.

To start the created instance, do the following:

Starting Virtual Machine Instance

1. In the main menu, go to INSTANCES → Instances.

2. Select the instance from the list and click Actions → Instance State → Start.
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3. In the Start Instances dialog window that opens, click Yes, Start to confirm that you want to
start the instance.

4. Wait until the result of a status check changes to 2/2 checks passed.

NOTE

Do not forget to stop your instance after you no longer need it.

11.3. INSTALLING RED HAT JBOSS BPM SUITE ON VIRTUAL MACHINE
INSTANCE

First, follow the steps below to connect to your instance:

Connecting to Instance

1. Start the instance.

2. Click Connect to view details required for accessing your instance.
The Connect To Your Instance pop-up window opens.

3. Copy the public DNS address.

4. Execute the following command:

~]$ ssh ec2-user@PUBLIC_DNS_ADDRESS

5. Enter yes to confirm that you want to connect to your instance.

Installing Red Hat JBoss BPM Suite on VM Instance

1. Connect to the instance on which you want to install Red Hat JBoss BPM Suite.

2. Update your instance in order to get the latest version of Red Hat JBoss EAP 6.x by executing
the following command:

~]$ sudo yum -y update

3. Switch to root:
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~]$ sudo su

4. Copy the following configuration files to /etc/jbossas/standalone/ and /etc/jbossas/domain/:

standalone.xml

standalone-full.xml

standalone-full-ha.xml

standalone-ha.xml

standalone-osgi.xml

Follow the instructions:

a. Download Red Hat JBoss BPM Suite 6.3.0 Deployable for EAP 6 from Customer Portal.

b. Change directory to the location of the downloaded zip file.

c. Copy the zip file into the /tmp/ directory of your virtual machine instance:

~]$ scp jboss-bpmsuite-6.3.0.GA-deployable-eap6.x.zip ec2-
user@PUBLIC_DNS_ADDRESS:/tmp

d. Go to the /tmp/ directory of your VM instance and unzip the file:

~]# unzip jboss-bpmsuite-6.3.0.GA-deployable-eap6.x.zip

e. Change directory to jboss-eap-6.4/standalone/configuration/ and copy all the
configuration files listed above into /etc/jbossas/standalone/ and /etc/jbossas/domain/,
for example:

~]# cp standalone.xml /etc/jbossas/standalone/

Enter y to overwrite the file.

f. Make sure that the files were overwritten: standalone.xml should contain the following:

5. Copy the required applications (for example Business Central) to 
/usr/share/jbossas/standalone/deployments/:

a. Change directory to /tmp/jboss-eap-6.4/standalone/deployments/.

b. Copy Business Central:

~]# cp -r business-central.war /usr/share/jbossas/standalone/deployments/

~]# cp -r business-central.war.dodeploy /usr/share/jbossas/standalone/deployments/

<system-properties>
  <property name="org.kie.example" value="true"/>
  <property name="org.jbpm.designer.perspective" value="full"/>
  <property name="designerdataobjects" value="false"/>
</system-properties>
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6. Set the proper Red Hat JBoss EAP binding address.
Each virtual machine has private and public IP addresses. The public IP address can be accessed
outside the AWS, while the private IP address is accessible only inside the virtual network of
your Amazon EC2 account.

IMPORTANT

Every time you start the instance, the addresses change. Refer to the Red Hat
JBoss Enterprise Application Platform 6.4 Administration and Configuration
Guide for more information.

One way to set the address is by doing the following:

a. Run ifconfig and copy the inet addr address (for example 10.233.159.148).

b. Open /etc/jbossas/standalone/standalone.xml and set the proper binding address:

7. Enable Git and SSH access to Business Central: add the following system properties (with your
private IP address) into /etc/jbossas/standalone/standalone.xml.

Once the setup has been done, you can create a new AMI from your instance.

Creating new AMI from Configured Instance

1. In the main menu, go to INSTANCES → Instances.

2. Locate your configured instance and click Actions → Image → Create Image.

3. In the Create Image dialog window, specify the image details and click Create Image.

<interfaces>
  ...
  <interface name="public">
    <inet-address value="10.233.159.148"/>
  </interface>
  ...
</interfaces>

<property name="org.uberfire.nio.git.daemon.host" value="10.233.159.148"/>
<property name="org.uberfire.nio.git.ssh.host" value="10.233.159.148"/>
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11.4. RUNNING RED HAT JBOSS BPM SUITE ON VIRTUAL MACHINE
INSTANCE

Running Red Hat JBoss BPM Suite on VM Instance

1. Start Red Hat JBoss EAP by executing the command:

~]# /etc/init.d/jbossas start

Alternatively, you can use the command with option stop (or restart) to stop (or restart) the
Red Hat JBoss EAP.

The following message appears:

Starting jbossas:                                          [  OK  ]

If the deployment finished successfully, the business-central.war.dodeploy file in 
/usr/share/jbossas/standalone/deployments/ changes to business-central.war.deployed.

2. To log in to Business Central, navigate to http://PUBLIC_DNS_ADDRESS:8080/business-
central in a web browser.
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CHAPTER 12. INTEGRATING RED HAT JBOSS BPM SUITE
WITH RED HAT JBOSS FUSE

Red Hat JBoss Fuse integration allows users of Red Hat JBoss Fuse to complement their integration
solution with additional features provided by Red Hat JBoss BPM Suite and Red Hat JBoss BRMS.

Red Hat JBoss BPM Suite integration is provided by two features.xml files:

drools-karaf-features-VERSION-features.xml
This file provides core Red Hat JBoss BPM Suite and Red Hat JBoss BRMS features, which
defines the OSGi features that can be deployed into Red Hat JBoss Fuse. This file is a part of
the Red Hat JBoss BPM Suite and Red Hat JBoss BRMS product. OSGi users can install
features from this file in order to install Red Hat JBoss BRMS engine or Red Hat JBoss BPM
Suite engine into Red Hat JBoss Fuse and use it in their applications.

karaf-features-VERSION-features.xml
This file provides additional features used for integrating Red Hat JBoss BPM Suite and Red
Hat JBoss BRMS with Apache Camel, primarily in Red Hat JBoss Fuse. This file is part of the
Integration Pack and it defines OSGi features that enable integration with Apache Camel and
SwitchYard. In addition to the karaf-features XML file, the Integration Pack also contains a 
features.xml file for quick starts.

drools-karaf-features-VERSION-features-fuse-6_3.xml
This file is used for integration of Red Hat JBoss BPM Suite with Red Hat JBoss Fuse 6.3.0.

For further information about integration of Red Hat JBoss BPM Suite with Red Hat JBoss Fuse, see
the Install Integration Pack chapter of the Red Hat JBoss Fuse Integration Guide .

12.1. CORE RED HAT JBOSS BPM SUITE AND RED HAT JBOSS BRMS
FEATURES

Core Red Hat JBoss BPM Suite and Red Hat JBoss BRMS features are provided by one of the following
files:

For integration with Red Hat JBoss Fuse 6.2.1, use the drools-karaf-features-VERSION-
features.xml file.

For integration with Red Hat JBoss Fuse 6.3.0, use the drools-karaf-features-VERSION-
features-fuse-6_3.xml file
VERSION is the version of Red Hat JBoss BPM Suite you are using, for example 6.5.0.Final-
redhat-9. See the Supported Component Versions  chapter of the Red Hat JBoss BPM Suite
Installation Guide.

The files are present in the product Maven repository (org/drools/drools-karaf-features) or the jboss-
brms-bpmsuite-VERSION-redhat-VERSION-fuse-features.zip file. These files provide the following
features:

drools-common

drools-module

drools-templates

drools-decisiontable
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drools-jpa

kie

kie-ci

kie-spring

kie-aries-blueprint

jbpm-commons

jbpm-human-task

jbpm

droolsjbpm-hibernate

h2

The following table provides example of use cases for some of the features listed above.

Table 12.1. Features and Use Case Examples

Feature Use Case

drools-module Use the Red Hat JBoss BRMS engine for rules
evaluation, without requiring persistence, processes,
or decision tables.

drools-jpa Use the Red Hat JBoss BRMS engine for rules
evaluation with persistence and transactions, but
without requiring processes or decision tables. The 
drools-jpa feature already includes drools-
module, however you may also need to install the 
droolsjbpm-hibernate feature, or ensure there is a
compatible hibernate bundle installed.

drools-decisiontable Use the Red Hat JBoss BRMS engine with decision
tables.

jbpm Use the Red Hat JBoss BPM Suite (or Red Hat
JBoss BRMS engine with processes). The jbpm
feature already includes drools-module and 
drools-jpa. You may also need to install the 
droolsjbpm-hibernate feature, or ensure that
there is a compatible hibernate bundle installed.

jbpm and jbpm-human-task Use the Red Hat JBoss BPM Suite (or Red Hat
JBoss BRMS engine with processes) with Human
Task.
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core engine JARs and kie-ci Use Red Hat JBoss BRMS or Red Hat JBoss BPM
Suite with KieScanner (KIE-CI) to download kJARs
from a Maven repository.

kie-spring Use KIE-Spring integration. See the section called
“kie-spring Feature Further Information” for more
information.

kie-spring and kie-aries-blueprint Use KIE-Aries-Blueprint integration.

Feature Use Case

kie-spring Feature Further Information

Use org.drools.osgi.spring.OsgiKModuleBeanFactoryPostProcessor instead of 
org.kie.spring.KModuleBeanFactoryPostProcessor to postprocess KIE elements in an OSGi
environment.

Do not install the drools-module feature before the kie-spring feature. Otherwise, the drools-
compiler bundle does not detect packages exported by kie-spring.
Run osgi:refresh drools-compiler_bundle_ID if you have installed the features in the incorrect
order to force drools-compiler to rebuild its Import-Package metadata.

12.2. ADDITIONAL FEATURES FOR SWITCHYARD AND APACHE CAMEL
INTEGRATION

The following additional features for integration with SwitchYard and Apache Camel on Red Hat JBoss
Fuse are provided by the integration pack:

fuse-bxms-switchyard-common-knowledge

fuse-bxms-switchyard-rules

fuse-bxms-switchyard-bpm

kie-camel

jbpm-workitems-camel

The integration pack features are defined in the karaf-features-VERSION-features.xml file. This file
(and supporting repositories) is located in
http://repository.jboss.org/nexus/content/repositories/public, which is already configured for use on
Red Hat JBoss Fuse out of the box in INSTALLATION_DIRECTORY/etc/org.ops4j.pax.url.mvn.cfg.

The file can also be downloaded from either the Red Hat JBoss Fuse product page or Red Hat JBoss
BPM Suite product page on the Red Hat Customer Portal.

12.3. INSTALLING AND UPDATING CORE INTEGRATION FEATURES

NOTE
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NOTE

This section refers to features in the drools-karaf-features-VERSION-features.xml file.
For additional integration features, see Section 12.4, “Installing Additional Integration
Features”.

If you have already installed an older version of the core Red Hat JBoss BPM Suite and Red Hat JBoss
BRMS features (for example, drools-karaf-features-6.2.0.Final-redhat-6-features.xml), you need to
remove them and all associated files before installing the most recent features.xml file.

Procedure: Removing Existing drools-karaf-features Installation

1. Start the Red Hat JBoss Fuse console using:

$ ./INSTALLATION_DIRECTORY/bin/fuse

2. Unistall old features or applications that used the previous features.xml file. For example:

JBossFuse:karaf@root> features:uninstall drools-module
JBossFuse:karaf@root> features:uninstall jbpm
JBossFuse:karaf@root> features:uninstall kie-ci

3. Search for references of bundles using drools, kie, or jbpm, and remove them:

karaf@root> list -t 0 -s | grep drools
karaf@root> list -t 0 -s | grep kie
karaf@root> list -t 0 -s | grep jbpm

To remove the bundles:

karaf@root> osgi:uninstall BUNDLE_ID

4. Remove the old drools-karaf-features URL:

karaf@root> features:removeurl mvn:org.drools/drools-karaf-features/6.2.0.Final-redhat-
VERSION/xml/features

5. Restart Red Hat JBoss Fuse.

To install the drools-karaf-features:

Procedure: Installing Core Red Hat JBoss BPM Suite and Red Hat JBoss BRMS Features

1. Configure required repositories:

Edit the INSTALLATION_DIRECTORY/etc/org.ops4j.pax.url.mvn.cfg file in your Red Hat
JBoss Fuse installation and add the following entry to the 
org.ops4j.pax.url.mvn.repositories variable (note that entries are separated by , \):

https://maven.repository.redhat.com/ga/

2. Start Red Hat JBoss Fuse:

$ ./INSTALLATION_DIRECTORY/bin/fuse
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3. Add a reference to the core features file by running the following console command:
For Red Hat JBoss Fuse 6.2.1, use:

JBossFuse:karaf@root> features:addurl mvn:org.drools/drools-karaf-
features/VERSION/xml/features

For Red Hat JBoss Fuse 6.3.0, use:

JBossFuse:karaf@root> features:addurl mvn:org.drools/drools-karaf-
features/VERSION/xml/features-fuse-6_3

For example:

features:addurl mvn:org.drools/drools-karaf-features/6.4.0.Final-redhat-10/xml/features-fuse-
6_3

To see the current drools-karaf-features version, see the Supported Component Versions
chapter of the Red Hat JBoss BPM Suite Installation Guide .

4. You can now install the features provided by this file by running, for example, the following
console command:

JBossFuse:karaf@root> features:install jbpm

12.4. INSTALLING ADDITIONAL INTEGRATION FEATURES

Use the following procedure for additional integration with SwitchYard and Apache Camel.

Procedure: SwitchYard and Apache Camel Integration

1. Download the fuse-integration package that is aligned with your version of Red Hat JBoss
Fuse.

NOTE

For instance, if you want to use the 6.2.0.redhat-117 version of Red Hat JBoss
Fuse, you need to install the fuse-6.2.0.redhat-117 Red Hat JBoss Fuse
integration features.

2. Add the remote Maven repository that contains the fuse dependencies to your karaf instance:

Edit FUSE_HOME/etc/org.ops4j.pax.url.mvn.cfg

3. Update the Drools features URL:

JBossFuse:karaf@root> features:addurl 
mvn:org.switchyard.karaf/mvn:org.switchyard.karaf/switchyard/SWITCHYARD_VERSION/xml/c
ore-features
JBossFuse:karaf@root> features:addurl mvn:org.jboss.integration.fuse/karaf-
features/1.0.0.redhat-VERSION/xml/features

Additionally, update the drools-karaf-features URL. For Red Hat JBoss Fuse 6.2.1, use:
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JBossFuse:karaf@root> features:addurl mvn:org.drools/drools-karaf-
features/VERSION/xml/features

For Red Hat JBoss Fuse 6.3.0, use:

JBossFuse:karaf@root> features:addurl mvn:org.drools/drools-karaf-
features/VERSION/xml/features-fuse-6_3

To see the current drools-karaf-features version, see the Supported Component Versions
chapter of the Red Hat JBoss BPM Suite Installation Guide .

4. You can now install the features provided for SwitchYard and Apache Camel integration by
running, for example, the following console command:

JBossFuse:karaf@root> features:install fuse-bxms-switchyard-rules
JBossFuse:karaf@root> features:install kie-camel
JBossFuse:karaf@root> features:install jbpm-workitems-camel

12.5. CONFIGURING DEPENDENCIES

When you configure KIE, Red Hat JBoss BRMS, or Red Hat Jboss BPM Suite in your application, you can
follow one of the following approaches to build your OSGi application bundles:

Bundle required dependencies into your application bundle. In this approach, you declare all
required artifacts as runtime dependencies in your pom.xml. Hence, you need not import the
packages that provide these artifacts that you have already added as dependencies.

Import the required dependencies into the application bundle. This is a preferred approach for
building OSGi bundles as it adheres to the principles of OSGi framework. In this approach, you
declare only the API JARs (such as org.kie:kie-api) as dependencies in your application bundle.
You will need to install the required Red Hat JBoss BRMS and Red Hat JBoss BPM Suite
bundles and then import them in your application.

WARNING

The MVELUserGroupCallback class fails to initialize in an OSGi environment. Do
not use or include MVELUserGroupCallback as it is not designed for production
purposes.

12.6. INSTALLING RED HAT JBOSS FUSE INTEGRATION QUICK START
APPLICATIONS

The following features for Red Hat JBoss Fuse integration quick start applications are provided by 
org/jboss/integration/fuse/quickstarts/karaf-features/VERSION/karaf-features-VERSION-
features.xml:

fuse-bxms-quickstart-switchyard-bpm-service

fuse-bxms-quickstart-switchyard-rules-camel-cbr
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fuse-bxms-quickstart-switchyard-rules-interview

fuse-bxms-quickstart-switchyard-rules-interview-container

fuse-bxms-quickstart-switchyard-rules-interview-dtable

fuse-bxms-quickstart-switchyard-library

fuse-bxms-quickstart-switchyard-helpdesk

fuse-bxms-quickstart-camel-blueprint-drools-decision-table

fuse-bxms-quickstart-camel-spring-drools-decision-table

fuse-bxms-quickstart-camel-jbpm-workitems

This file (and supporting repositories) is located in
http://repository.jboss.org/nexus/content/repositories/public, which is already configured for use on
Red Hat JBoss Fuse out of the box in INSTALLATION_DIRECTORY/etc/org.ops4j.pax.url.mvn.cfg.

Procedure: Installing Quick Start Applications

1. Add a reference to the features file by running the following console command:

JBossFuse:karaf@root> features:addurl mvn:org.jboss.integration.fuse.quickstarts/karaf-
features/1.0.0.redhat-VERSION/xml/features

2. You can now install the quick start applications provided by this features file by running, for
example, the following console command:

JBossFuse:karaf@root> features:install fuse-bxms-quickstart-switchyard-bpm-service

Procedure: Downloading and Installing Quick Start ZIP Files

1. Download the quick start application ZIP file.

2. Unpack the contents of the quick starts directory into your existing 
INSTALLATION_DIRECTORY/quickstarts directory.

3. Unpack the contents of the system directory into your existing 
INSTALLATION_DIRECTORY/system directory.

12.6.1. Testing Your First Quick Start Application

Procedure: Testing Quick Start Application

1. Start Red Hat JBoss Fuse:

$ ./INSTALLATION_DIRECTORY/bin/fuse

2. Install and start the switchyard-bpm-service by running the following console command:

JBossFuse:karaf@root> features:install fuse-bxms-quickstart-switchyard-bpm-service

NOTE
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NOTE

Any dependent features specified by the application’s features file will be
installed automatically.

3. Submit a web service request to invoke the SOAP gateway.

a. Open a terminal window and navigate to the associated quick start directory that was
unpacked from the quick start application ZIP file (in this case, switchyard-bpm-service).

b. Run the following command:

$ mvn clean install

NOTE

You will need the following repositories configured in your settings.xml file:

http://maven.repository.redhat.com/ga/

http://repository.jboss.org/nexus/content/repositories/public/

c. Run the following command:

$ mvn exec:java -Pkaraf

4. You will receive the following response:

SOAP Reply:
<soap:Envelope xmlns:soap="http://schemas.xmlsoap.org/soap/envelope/">
  <SOAP-ENV:Header xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/"/>
  <soap:Body>
    <ns2:submitOrderResponse xmlns:ns2="urn:switchyard-quickstart:bpm-service:1.0">
      <orderId>test1</orderId>
      <accepted>true</accepted>
      <status>Thanks for your order, it has been shipped!</status>
    </ns2:submitOrderResponse>
  </soap:Body>
</soap:Envelope>
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CHAPTER 13. INTEGRATING RED HAT JBOSS BPM SUITE
WITH RED HAT SINGLE SIGN-ON

Red Hat Single Sign-On (RH-SSO) is a Single Sign-On solution that you can use for securing your
browser applications and your REST web services. This chapter describes how you can integrate RH-
SSO with Red Hat JBoss BPM Suite and leverage its features.

Integrating with RH-SSO brings an integrated SSO and IDM (Identity Management) environment for
Red Hat JBoss BPM Suite. The session management feature of RH-SSO allows you to use different
Red Hat JBoss BPM Suite environments on the web by authenticating only once.

For more information on RH-SSO, see the RH-SSO documentation.

Red Hat Single Sign On Integration Points
You can integrate RH-SSO with Intelligent Process Servers using the following integration points:

Business Central authentication through an RH-SSO server
Authenticating Red Hat JBoss BPM Suite Business Central through RH-SSO involves securing
both the Business Central web client and remote services through RH-SSO. This integration
enables you to connect to Business Central using either web interface or a remote service
consumer through RH-SSO.

Intelligent Process Server authentication through an RH-SSO server
Authenticating Red Hat JBoss BPM Suite Intelligent Process Server through RH-SSO involves
securing the remote services provided by the Intelligent Process Server as it does not provide a
web interface for server authentication. This enables any remote Red Hat JBoss BPM Suite
service consumer (user or a service) to authenticate through RH-SSO.

Third-party client authentication through an RH-SSO server
Authenticating a third-party client through an RH-SSO server involves third-party clients to
authenticate themselves using RH-SSO to consume the remote service endpoints provided by
Business Central and Intelligent Process Server, such as the REST API or remote file system
services.

The following sections describe how to achieve RH-SSO integration through these integration points:

13.1. BUSINESS CENTRAL AUTHENTICATION THROUGH RH-SSO

To authenticate Business Central through RH-SSO:

1. Set up and run an RH-SSO server with a realm client for Business Central.

2. Install and set up the RH-SSO client adapter for EAP.

3. Secure Business Central Remote Service using RH-SSO.

4. Create an RH-SSO client and configure the RH-SSO client adapter for Dashbuilder (BAM).

13.1.1. Setting Up RH-SSO with Realm Client for Business Central

Security realms are used to restrict access for the different applications resources. It is advised to create
a new realm whether your RH-SSO instance is private or shared amongst other products. You can keep
the master realm as a place for super administrators to create and manage the realms in your system. If
you are integrating with an RH-SSO instance that is shared with other product installations to achieve
Single Sign-On with those applications, all those applications must use the same realm.
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Here is how you can install an RH-SSO server and create a security realm for Business Central:

Procedure: Setting Up RH-SSO with Realm Client

1. Download RH-SSO from the DOWNLOADS section of the Red Hat Customer Portal.

2. Install and configure a basic RH-SSO standalone server. To do this, follow the instructions in
chapter Install and Boot of the Red Hat Single Sign On Getting Started Guide . For production
environment settings, consult the Red Hat Single Sign On  Server Administration Guide.

NOTE

If you want to run both RH-SSO and Red Hat JBoss BPM Suite servers on the
same machine, ensure that you avoid port conflicts. To do so, do one of the
following:

Update the RHSSO_HOME/standalone/configuration/standalone.xml file
and set a port offset to 100. For example:

<socket-binding-group name="standard-sockets" default-
interface="public" port-offset="${jboss.socket.binding.port-offset:100}">

Use an environment variable to run the server:

bin/standalone.sh -Djboss.socket.binding.port-offset=100

3. Start the RH-SSO server using the following command from RHSSO_HOME/bin:

./standalone.sh

Once the RH-SSO server starts, open http://localhost:8180/auth/admin in a web browser and
log in using your admin credentials that you created while installing RH-SSO. When you login for
the first time, you can set up the initial user using the new user registration form.

4. In the RH-SSO Admin Console, click the Realm Settings left menu item.

5. On the Realm Settings page, click Add Realm.
The Add realm page opens.

6. On the Add realm page, provide a name for the realm and click Create.

7. Click the Clients left menu item and click Create.
The Add Client page opens.

8. On the Add Client page, provide the required information to create a new client for your realm.
For example:

Client ID: kie

Client protocol: openid-connect

Root URL: http://localhost:8080/business-central

9. Click Save to save your changes.

Once you create a new client, its Access Type is set to public by default. Change it to 
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Once you create a new client, its Access Type is set to public by default. Change it to 
confidential.

At this point, the RH-SSO server is configured with a realm with a client for Red Hat JBoss BPM
Suite applications (Business Central, in this example) and running and listening for HTTP
connections at localhost:8180. This realm provides different users, roles, and sessions for the
Red Hat JBoss BPM Suite applications.

13.1.2. Setting Up RH-SSO Client Adapter for EAP

To set up the RH-SSO client adapter for EAP:

1. Install the RH-SSO adapter for EAP.

2. Configure the Red Hat JBoss BPM Suite application and the RH-SSO client adapter.

Procedure: Installing the RH-SSO Adapter for Red Hat JBoss EAP 6 and 7

1. Install Red Hat JBoss EAP 6.4.X or 7.0.
For version 6, see chapter Installation Instructions from the Red Hat JBoss Enterprise
Application Platform Installation Guide.

For version 7, see chapter Installing JBoss EAP from the Red Hat JBoss Enterprise Application
Platform Installation Guide.

2. Install Red Hat JBoss BPM Suite in the freshly installed JBoss EAP.
If you configure RH-SSO adapter by making changes in standalone.xml, and then unzip Red
Hat JBoss BPM Suite, you may overwrite and lose the RH-SSO adapter configuration.

3. Download the EAP adapter from the Red Hat Customer Portal .

4. Unzip and install the adapter. For installation instructions, see section JBoss EAP Adapter from
the Red Hat Single Sign On Securing Applications and Services Guide .

5. For version 7, go to EAP_HOME/standalone/configuration and open the standalone.xml and 
standalone-full.xml files. Delete the <single-sign-on/> element from both of them.
You do not need to perform this step for Red Hat JBoss EAP 6.

Procedure: Configuring the RH-SSO Adapter

1. Navigate to EAP_HOME/standalone/configuration in your EAP installation and edit 
standalone.xml to add the RH-SSO subsystem configuration. For example:

<subsystem xmlns="urn:jboss:domain:keycloak:1.1">
 <secure-deployment name="business-central.war">
   <realm>demo</realm>
   <realm-public-
key>MIGfMA0GCSqGSIb3DQEBAQUAA4GNADCBiQKBgQCrVrCuTtArbgaZzL1hvh0xtL5mc
7o0NqPVnYXkLvgcwiC3BjLGw1tGEGoJaXDuSaRllobm53JBhjx33UNv+5z/UMG4kytBWxheNV
KnL6GgqlNabMaFfPLPCF8kAgKnsi79NMo+n6KnSY8YeUmec/p2vjO2NjsSAVcWEQMVhJ31L
wIDAQAB</realm-public-key>
   <auth-server-url>http://localhost:8180/auth</auth-server-url>
   <ssl-required>external</ssl-required>
   <enable-basic-auth>true</enable-basic-auth>
   <resource>kie</resource>
   <credential name="secret">759514d0-dbb1-46ba-b7e7-ff76e63c6891</credential>
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Here,

secure-deployment name: Name of your application’s WAR file.

realm: Name of the realm that you created for the applications to use.

realm-public-key: The public key of the realm you created. You can find the key in the Keys
tab in the Realm settings page of the realm you created in the RH-SSO Admin Console. If
you do not provide a value for realm-public-key, the server retrieves it automatically.

auth-server-url: The URL for the RH-SSO authentication server.

enable-basic-auth: The setting to enable basic authentication mechanism, so that the
clients can use both token-based and basic authentication approaches to perform the
requests.

resource: The name for the client that you created.

credential name: The secret key for the client you created. You can find the key in the
Credentials tab on the Clients page of the RH-SSO Admin Console.

principal-attribute: The login name of the user. If you do not provide this value, your User Id
is displayed in the application instead of your user name.

NOTE

The RH-SSO server converts the user names to lowercase. Therefore, after
integration with RH-SSO, your user name will appear in lowercase in
Business Central. If you have user names in upper-case letters hard coded in
business processes, the application may not be able to identify the upper-
case user.

2. Navigate to EAP_HOME/bin/ and start the EAP server using the following command:

./standalone.sh

NOTE

You can also configure RH-SSO adapter for EAP by updating your applications WAR file
to use the RH-SSO security subsystem. However, the recommended approach is
configuring the adapter through the RH-SSO subsystem. This means that you are
updating EAP configuration instead of applying the configuration on each WAR file.

13.1.3. Adding a New User

To add new users and assign them a role to access Business Central:

1. Log in to the RH-SSO Admin Console and open the realm to which you wish to add a user.

2. Click the Users left menu item under the Manage section.
An empty user list page called Users opens.

   <principal-attribute>preferred_username</principal-attribute>
 </secure-deployment>
</subsystem>
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3. Click the Add User button on the empty user list to start creating your new user.
An Add user page opens.

4. Provide user information on the Add user page and click Save.

5. Set a new password under the Credentials tab.

6. Assign the new user one of the roles that allow access to Business Central. For example, admin
or developer role.
Define the roles as realm roles in the Realm Roles tab under the Roles section.

7. Click Role Mappings tab on the Users page to assign roles.

You can now log in to your Red Hat JBoss BPM Suite application (in this example, Business Central)
once the server is running using the user credentials you just created.

13.1.4. Securing Business Central Remote Service Using RH-SSO

Business Central provides different remote service endpoints that can be consumed by third-party
clients using remote API. To authenticate those services through RH-SSO, you must disable a security
filter called BasicAuthSecurityFilter. To do this, follow these steps:

Procedure: Disabling BasicAuthSecurityFilter

1. Open your application deployment descriptor file (WEB-INF/web.xml) and apply the following
changes to it:

Remove the following lines to remove the servlet filter and its mapping for class 
org.uberfire.ext.security.server.BasicAuthSecurityFilter:

Add the following lines to add the security-constraint for the url-patterns that you have
removed from the filter mapping:

<filter>
  <filter-name>HTTP Basic Auth Filter</filter-name>
  <filter-class>org.uberfire.ext.security.server.BasicAuthSecurityFilter</filter-class>
  <init-param>
    <param-name>realmName</param-name>
    <param-value>KIE Workbench Realm</param-value>
  </init-param>
</filter>

<filter-mapping>
  <filter-name>HTTP Basic Auth Filter</filter-name>
  <url-pattern>/rest/*</url-pattern>
  <url-pattern>/maven2/*</url-pattern>
  <url-pattern>/ws/*</url-pattern>
</filter-mapping>

<security-constraint>
  <web-resource-collection>
    <web-resource-name>remote-services</web-resource-name>
    <url-pattern>/rest/*</url-pattern>
    <url-pattern>/maven2/*</url-pattern>
    <url-pattern>/ws/*</url-pattern>
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2. Save your changes.

13.1.5. Securing Business Central File System Services Using RH-SSO

To consume other remote services, such as file systems (for example, a remote GIT service), you need
to specify a correct RH-SSO login module. First, generate a JSON configuration file:

1. Navigate to the RH-SSO Admin Console located at http://localhost:8080/auth/admin.

2. Click the Clients left menu item.

3. Create a new client with the following settings:

Set Client ID as kie-git.

Set Access Type as confidential.

Disable the Standard Flow Enabled option.

Enable the Direct Access Grants Enabled option.

  </web-resource-collection>
  <auth-constraint>
    <role-name>rest-all</role-name>
    <role-name>rest-project</role-name>
    <role-name>rest-deployment</role-name>
    <role-name>rest-process</role-name>
    <role-name>rest-process-read-only</role-name>
    <role-name>rest-task</role-name>
    <role-name>rest-task-read-only</role-name>
    <role-name>rest-query</role-name>
    <role-name>rest-client</role-name>
  </auth-constraint>
</security-constraint>
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4. Click Save.

5. Click the Installation tab at the top of the client configuration screen and choose Keycloak
OIDC JSON as a Format Option.

6. Click Download.

7. Move the downloaded JSON file to an accessible directory in the server’s file system or add it to
the application class path.
For more information, see chapter JAAS plugin of the Keycloak Securing Applications and
Services Guide.

After you successfuly generate and download the JSON configuration file, specify the correct RH-SSO
login module in the EAP_HOME/standalone/configuration/standalone.xml file. By default, the
security domain in Business Central is set to other. Replace the default values of the login-module in
this security domain with the ones presented in the example below:

The JSON file specified in the module-option element contains a client used for securing the remote
services. Replace the $EAP_HOME/kie-git.json value of the module-option element with the absolute
path or the class path (classpath:/EXAMPLE_PATH/kie-git.json) to this JSON configuration file.

At this point, all users authenticated through the RH-SSO server can clone internal GIT repositories. In

<security-domain name="other" cache-type="default">
  <authentication>
    <login-module code="org.keycloak.adapters.jaas.DirectAccessGrantsLoginModule" 
flag="required">
      <module-option name="keycloak-config-file" value="$EAP_HOME/kie-git.json"/>
    </login-module>
  </authentication>
</security-domain>
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At this point, all users authenticated through the RH-SSO server can clone internal GIT repositories. In
the following command, change USER_NAME to a RH-SSO user, for example admin:

git clone ssh://USER_NAME@localhost:8001/system

13.1.6. Creating and Configuring RH-SSO Client Adapter for BAM

Once you have created a realm client for Business Central and set up the RH-SSO client adapter for
EAP, you can repeat the same steps to integrate BAM with RH-SSO. After successful integration of RH-
SSO with BAM, you can navigate within Business Central and BAM without having to re-login.

Procedure: Integrating RH-SSO with BAM

1. In the RH-SSO Admin Console, open the security realm that you created.

2. Click the Clients left menu item and click Create.
The Add Client page opens.

3. On the Add Client page, provide the required information to create a new BAM client for your
realm. For example:

Client ID: dashbuilder

Root URL: http://localhost:8080/dashbuilder

Client protocol: openid-connect
Once you create a new client, its Access Type is set to public by default. Change it to 
confidential.

4. Configure the RH-SSO client adapter for BAM. To do so, navigate to 
EAP_HOME/standalone/configuration in your EAP installation and edit standalone.xml to
add the RH-SSO subsystem configuration. For example:

Here,

secure-deployment name: The name of the BAM war file being deployed.

realm-public-key: The public key of the realm you created.

resource: The name of the client that you created for BAM (dashbuilder).

enable-basic-auth: The setting to enable basic authentication mechanism, so that the

<secure-deployment name="dashbuilder.war">
  <realm>demo</realm>
  <realm-public-
key>MIGfMA0GCSqGSIb3DQEBAQUAA4GNADCBiQKBgQCrVrCuTtArbgaZzL1hvh0xtL5mc
7o0NqPVnYXkLvgcwiC3BjLGw1tGEGoJaXDuSaRllobm53JBhjx33UNv+5z/UMG4kytBWxheNV
KnL6GgqlNabMaFfPLPCF8kAgKnsi79NMo+n6KnSY8YeUmec/p2vjO2NjsSAVcWEQMVhJ31L
wIDAQAB</realm-public-key>
  <auth-server-url>http://localhost:8180/auth</auth-server-url>
  <ssl-required>external</ssl-required>
  <resource>dashbuilder</resource>
  <enable-basic-auth>true</enable-basic-auth>
  <credential name="secret">e92ec68d-6177-4239-be05-28ef2f3460ff</credential>
  <principal-attribute>preferred_username</principal-attribute>
</secure-deployment>
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enable-basic-auth: The setting to enable basic authentication mechanism, so that the
clients can use both token-based and basic authentication approaches to perform the
requests.

credential name: The secret key for the client you created for BAM. You can find the key in
the Credentials tab on the Clients page of the RH-SSO Admin Console.

principal-attribute: The login name of the user. If you do not provide this value, your User Id
is displayed in the application instead of your user name.

5. Restart the EAP server and open http://localhost:8080/dashbuilder in a web browser to access
BAM. Log in to BAM using your RH-SSO admin user credentials.
You can now access both the applications (Business Central and BAM) without having to re-
login.

13.2. INTELLIGENT PROCESS SERVER AUTHENTICATION THROUGH
RH-SSO

The Red Hat JBoss BPM Suite Intelligent Process Server provides a REST API for third-party clients.
You can integrate the Intelligent Process Server with RH-SSO to delegate the third-party clients
identity management to the RH-SSO server.

Once you have created a realm client for Business Central and set up the RH-SSO client adapter for
EAP, you can repeat the same steps to integrate the Intelligent Process Server with RH-SSO.

13.2.1. Creating Client for Intelligent Process Server on RH-SSO

To create a new client on your already created realm on RH-SSO Admin Console:

Procedure: Creating a Client for the Intelligent Process Server

1. In the RH-SSO Admin Console, open the security realm that you created.

2. Click the Clients left menu item and click Create.
The Add Client page opens.

3. On the Add Client page, provide the required information to create a new client for your realm.
For example:

Client ID: kie-execution-server

Root URL: http://localhost:8080/kie-server

Client protocol: openid-connect

4. Click Save to save your changes.
Once you create a new client, its Access Type is set to public by default. Change it to 
confidential and click Save again.

5. Navigate to the Credentials tab and copy the secret key. The secret key is necessary to
configure the kie-execution-server client in the next section.

13.2.2. Installing and Setting Up Intelligent Process Server with Client Adapter

To consume the Intelligent Process Server remote service endpoints, you must first create and assign
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To consume the Intelligent Process Server remote service endpoints, you must first create and assign
the kie-server role in the RH-SSO Admin Console.

NOTE

If you deployed the Intelligent Process Server to a different application server than
Business Central, install and configure RH-SSO on your second server as well.

Procedure: Setting Up the Intelligent Process Server

1. Navigate to EAP_HOME/standalone/configuration in your EAP installation and edit 
standalone.xml to add the RH-SSO subsystem configuration. For example:

Here,

secure-deployment name: Name of your application WAR file.

realm: Name of the realm that you created for the applications to use.

realm-public-key: The public key of the realm you created. You can find the key in the Keys
tab in the Realm settings page of the realm you created in the RH-SSO Admin Console. If
you do not provide a value for this public key, the server retrieves it automatically.

auth-server-url: The URL for the RH-SSO authentication server.

resource: The name for the server client that you created.

enable-basic-auth: The setting to enable basic authentication mechanism, so that the
clients can use both token-based and basic authentication approaches to perform the
requests.

credential name: The secret key of the server client you created. You can find the key in
the Credentials tab on the Clients page of the RH-SSO Admin Console.

principal-attribute: The login name of the user. If you do not provide this value, your User Id

<subsystem xmlns="urn:jboss:domain:keycloak:1.1">
  <secure-deployment name="kie-server.war">
     <realm>demo</realm>
     <realm-public-
key>MIGfMA0GCSqGSIb3DQEBAQUAA4GNADCBiQKBgQCrVrCuTtArbgaZzL1hvh0xtL5mc
7o0NqPVnYXkLvgcwiC3BjLGw1tGEGoJaXDuSaRllobm53JBhjx33UNv+5z/UMG4kytBWxheNV
KnL6GgqlNabMaFfPLPCF8kAgKnsi79NMo+n6KnSY8YeUmec/p2vjO2NjsSAVcWEQMVhJ31L
wIDAQAB</realm-public-key>
     <auth-server-url>http://localhost:8180/auth</auth-server-url>
     <ssl-required>external</ssl-required>
     <resource>kie-execution-server</resource>
     <enable-basic-auth>true</enable-basic-auth>
     <credential name="secret">03c2b267-7f64-4647-8566-572be673f5fa</credential>
     <principal-attribute>preferred_username</principal-attribute>
  </secure-deployment>
</subsystem>

<system-properties>
  <property name="org.kie.server.sync.deploy" value="false"/>
</system-properties>
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principal-attribute: The login name of the user. If you do not provide this value, your User Id
is displayed in the application instead of your user name.

2. Save your configuration changes in standalone.xml.

3. Use the following command to restart the EAP server and run the Intelligent Process Server.

EXEC_SERVER_HOME/bin/standalone.sh -Dorg.kie.server.id=<ID> -Dorg.kie.server.user=
<USER> -Dorg.kie.server.pwd=<PWD> -Dorg.kie.server.location=<LOCATION_URL> -
Dorg.kie.server.controller=<CONTROLLER_URL> -Dorg.kie.server.controller.user=
<CONTROLLER_USER> -Dorg.kie.server.controller.pwd=<CONTOLLER_PASSWORD>

Here is an example:

EXEC_SERVER_HOME/bin/standalone.sh -Dorg.kie.server.id=kieserver1 -
Dorg.kie.server.user=kieserver -Dorg.kie.server.pwd=password -
Dorg.kie.server.location=http://localhost:8080/kie-server/services/rest/server -
Dorg.kie.server.controller=http://localhost:8080/business-central/rest/controller -
Dorg.kie.server.controller.user=kiecontroller -Dorg.kie.server.controller.pwd=password

4. Once the Intelligent Process Server is running, you can check the server status. In the following
command, kieserver is a user name with the kie-server role and password password:

curl http://kieserver:password@localhost:8080/kie-server/services/rest/server/

Token-based authorization is also supported for communication between Business Central and the
Intelligent Process Server. You can use the complete token as a system property of your application
server, instead of the user name and password, for your applications. However, you must ensure that the
token does not expire for the period of interaction between the applications, as it is not automatically
refreshed. To get the token, see Section 13.3.2, “Token-Based Authentication” .

For the Business Central to manage the Intelligent Process Server using the tokens:

Set the org.kie.server.token property.
In such case, do not set the org.kie.server.user and org.kie.server.pwd properties. The
Business Central will then use the Authorization: Bearer $TOKEN authentication method.

If you want to use the REST API using the token-based authentication:

Set the org.kie.server.controller.token property.
In such case, do not set the org.kie.server.controller.user and org.kie.server.controller.pwd
properties.

NOTE

As the Intelligent Process Server is unable to refresh the token, use a high-lifespan token.
A token’s lifespan must not exceed January 19 2038. Check with your security best
practices to see whether this is a suitable solution for your environment.

13.3. THIRD-PARTY CLIENT AUTHENTICATION THROUGH RH-SSO

To use the different remote services provided by Business Central or by the Intelligent Process Server,
your client, such as curl, wget, web browser, or a custom REST client, must authenticate through the RH-
SSO server and have a valid token to perform the requests. To use the remote services, the
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authenticated user must have assigned the following roles:

rest-all: For using the Business Central remote services.

kie-server: For using the Intelligent Process Server remote services.

Use the RH-SSO Admin Console to create these roles and assign them to the users that will consume
the remote services.

Your client can authenticate through RH-SSO using one of these options:

Basic authentication, if it is supported by the client.

Token-based authentication.

13.3.1. Basic Authentication

If you have enabled the basic authentication in the RH-SSO client adapter configuration for both
Business Central and Intelligent Process Server, you can avoid the token grant/refresh calls and call the
services as shown in the examples below:

For web based remote repositories endpoint:

 curl http://admin:password@localhost:8080/business-central/rest/repositories

For the Intelligent Process Server:

curl http://admin:password@localhost:8080/kie-server/services/rest/server/

13.3.2. Token-Based Authentication

If you want to opt for a more secure option of authentication, you can consume the remote services
from both Business Central and Intelligent Process Server using a granted token provided by RH-SSO.

Procedure: Obtaining and Using Token for Authorizing Remote Calls

1. In the RH-SSO Admin Console, click the Clients left menu item and click Create to create a new
client.
The Add Client page opens.

2. On the Add Client page, provide the required information to create a new client for your realm.
For example:

Client ID: kie-remote

Client protocol: openid-connect

3. Click Save to save your changes.

4. Change the token settings in Realm Settings:

a. In the RH-SSO Admin Console, click the Realm Settings left menu item.

b. Click the Tokens tab.

c. Change the value for Access Token Lifespan to 15 minutes.
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This gives you enough time to get a token and invoke the service before it expires.

d. Click Save to save your changes.

5. Once a public client for your remote clients is created, you can now obtain the token by making
an HTTP request to the RH-SSO server’s token endpoint using:

RESULT=`curl --data "grant_type=password&client_id=kie-
remote&username=admin&password=password" 
http://localhost:8180/auth/realms/demo/protocol/openid-connect/token`

The user used in the command above is an RH-SSO user. For further information, see
Section 13.1.3, “Adding a New User” .

6. To view the token obtained from the RH-SSO server, use the following command:

TOKEN=`echo $RESULT | sed 's/.*access_token":"//g' | sed 's/".*//g'`

You can now use this token to authorize the remote calls. For example, if you want to check the internal
Red Hat JBoss BPM Suite repositories, use the token as shown below:

curl -H "Authorization: bearer $TOKEN" http://localhost:8080/business-central/rest/repositories
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CHAPTER 14. INTEGRATION WITH SPRING

14.1. CONFIGURING RED HAT JBOSS BPM SUITE WITH SPRING

The jboss-bpms-engine.zip file contains the Spring module, which is called kie-spring-VERSION-
redhat-MINOR_VERSION.jar.

You can configure the Spring modules:

As a Self Managed Process Engine

If you require a single runtime manager instance, use the RuntimeManager API. The 
RuntimeManager API synchronizes the process engine and task service internally.

As a Shared Task Service

If you require multiple runtime manager instances, use the jBPM services.

NOTE

Do not use the shared task service if you use Spring and your process is instantiated using
the per process or per request runtime strategy.

14.1.1. Integrating Spring with Runtime Manager API

To integrate Spring with the Runtime Manager API, include the following factory beans:

org.kie.spring.factorybeans.RuntimeEnvironmentFactoryBean

org.kie.spring.factorybeans.RuntimeManagerFactoryBean

org.kie.spring.factorybeans.TaskServiceFactoryBean

NOTE

TaskServiceFactoryBean is required only for shared task service.

RuntimeEnvironmentFactoryBean
RuntimeEnvironmentFactoryBean produces RuntimeEnvironment instances consumed by 
RuntimeManager.

You can create the following types of RuntimeEnvironment instances:

DEFAULT: The default type.

EMPTY: An empty environment.

DEFAULT_IN_MEMORY: Same as DEFAULT with no persistence of the runtime engine.

DEFAULT_KJAR: Same as DEFAULT with knowledge assets taken from kJAR and identified by
releaseID or GAV (Group, Artifact, Version).

DEFAULT_KJAR_CL: Built from class path that consists of a kmodule.xml descriptor.

Knowledge information is required for all the RuntimeEnvironment types. Provide one or more of the
following:
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knowledgeBase

assets

releaseId

groupId, artifactId, version

For the DEFAULT, DEFAULT_KJAR, DEFAULT_KJAR_CL types, configure persistence using entity 
manager factory or transaction manager.

RuntimeManagerFactoryBean
RuntimeManagerFactoryBean creates RuntimeManager instances based on runtimeEnvironment.
You can create the following runtimeEnvironment instances:

SINGLETON (default)

PER_REQUEST

PER_PROCESS_INSTANCE

Every RuntimeManager instance must have a unique ID. You can dispose of any RuntimeManager
instance created by RuntimeManagerFactoryBean by calling the close() method.

TaskServiceFactoryBean
TaskServiceFactoryBean creates TaskService instance based on the given properties. Creates a
single instance only.

Properties required:

entity manager factory

transaction manager

When using the TaskServiceFactoryBean, provide the Spring transaction manager. When using a
shared entity manager from Spring, you can also provide EntityManager instance instead of entity
manager factory.

Optional properties:

userGroupCallback: MVELUserGroupCallbackImpl by default.

userInfo: DefaultUserInfo by default.

listener: List of TaskLifeCycleEventListener instances.

Sample RuntimeManager Configuration with Spring
To create a single runtime manager Spring configuration:

1. Configure the entity manager factory and the transaction manager, for example:

<bean id="jbpmEMF" 
class="org.springframework.orm.jpa.LocalContainerEntityManagerFactoryBean">
  <property name="persistenceUnitName" value="org.jbpm.persistence.spring.jta"/>
</bean>

<bean id="btmConfig" factory-method="getConfiguration" 
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This configuration provides:

JTA transaction manager, backed by Bitronix for unit tests or servlet containers.

The org.jbpm.persistence.spring.jta entity manager factory for persistence unit.

2. Configure resources you use, for example a business process:

The sample.bpmn process is included from the class path.

3. Configure RuntimeEnvironment using your entity manager, transaction manager, and
resources:

4. Create RuntimeManager:

An example of complete configuration:

class="bitronix.tm.TransactionManagerServices"></bean>

<bean id="BitronixTransactionManager" factory-method="getTransactionManager"
      class="bitronix.tm.TransactionManagerServices" depends-on="btmConfig" destroy-
method="shutdown" />

<bean id="jbpmTxManager" 
class="org.springframework.transaction.jta.JtaTransactionManager">
  <property name="transactionManager" ref="BitronixTransactionManager" />
  <property name="userTransaction" ref="BitronixTransactionManager" />
</bean>

<bean id="process" factory-method="newclass pathResource" 
class="org.kie.internal.io.ResourceFactory">
  <constructor-arg>
    <value>jbpm/processes/sample.bpmn</value>
  </constructor-arg>
</bean>

<bean id="runtimeEnvironment" 
class="org.kie.spring.factorybeans.RuntimeEnvironmentFactoryBean">
  <property name="type" value="DEFAULT"/>
  <property name="entityManagerFactory" ref="jbpmEMF"/>
  <property name="transactionManager" ref="jbpmTxManager"/>
  <property name="assets">
    <map>
      <entry key-ref="process"><util:constant static-
field="org.kie.api.io.ResourceType.BPMN2"/></entry>
    </map>
  </property>
</bean>

<bean id="runtimeManager" 
class="org.kie.spring.factorybeans.RuntimeManagerFactoryBean" destroy-method="close">
  <property name="identifier" value="spring-rm"/>
  <property name="runtimeEnvironment" ref="runtimeEnvironment"/>
</bean>
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14.1.2. Spring and jBPM Services

If you require multiple runtime managers, you can use jBPM services directly in your application. Due to
the dynamic nature of jBPM services, processes and other assets can be added and removed without
restarting your application.

To configure jBPM services:

1. Add the kie-spring Maven dependency into your pom.xml:

<?xml version="1.0" encoding="UTF-8"?>
<beans xmlns="http://www.springframework.org/schema/beans"
       xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
       xmlns:util="http://www.springframework.org/schema/util"
       xsi:schemaLocation="http://www.springframework.org/schema/beans 
http://www.springframework.org/schema/beans/spring-beans-3.0.xsd
                          http://www.springframework.org/schema/util 
http://www.springframework.org/schema/util/spring-util-3.0.xsd">

  <import resource="classpath:jbpm/configuration-template/assets.xml" />

  <bean id="jbpmEMF" 
class="org.springframework.orm.jpa.LocalContainerEntityManagerFactoryBean">
    <property name="persistenceUnitName" value="org.jbpm.persistence.spring.jta"/>
    <property name="persistenceXmlLocation" value="classpath:jbpm/persistence-jta.xml"/>
  </bean>

  <bean id="btmConfig" factory-method="getConfiguration" 
class="bitronix.tm.TransactionManagerServices"/>

  <bean id="BitronixTransactionManager" factory-method="getTransactionManager"
        class="bitronix.tm.TransactionManagerServices" depends-on="btmConfig" destroy-
method="shutdown" />

  <bean id="jbpmTxManager" class="org.springframework.transaction.jta.JtaTransactionManager">
    <property name="transactionManager" ref="BitronixTransactionManager" />
    <property name="userTransaction" ref="BitronixTransactionManager" />
  </bean>

  <bean id="runtimeEnvironment" 
class="org.kie.spring.factorybeans.RuntimeEnvironmentFactoryBean">
    <property name="type" value="DEFAULT"/>
    <property name="entityManagerFactory" ref="jbpmEMF"/>
    <property name="transactionManager" ref="jbpmTxManager"/>
    <property name="assets" ref="assets"/>
  </bean>

  <bean id="logService" class="org.jbpm.process.audit.JPAAuditLogService" depends-
on="runtimeEnvironment">
    <constructor-arg value="#{runtimeEnvironment.environment}" />
    <constructor-arg value="STANDALONE_JTA" />
  </bean>
</beans>

<dependencies>
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For the current Maven artifact version, see chapter Supported Component Versions  of the Red
Hat JBoss BPM Suite Installation Guide. 

NOTE

Depending on your implementation, other dependencies may be necessary, for example 
spring-security.

1. Implement the IdentityProvider interface:

  ...
  <dependency>
      <groupId>org.kie</groupId>
      <artifactId>kie-spring</artifactId>
      <version>6.5.0.Final-redhat-2</version>
    </dependency>
    ...
</dependencies>

import java.util.ArrayList;
import java.util.Collections;
import java.util.List;

import org.kie.internal.identity.IdentityProvider;
import org.springframework.security.core.Authentication;
import org.springframework.security.core.GrantedAuthority;
import org.springframework.security.core.context.SecurityContextHolder;

public class SpringSecurityIdentityProvider implements IdentityProvider {

 public String getName() {

  Authentication auth = SecurityContextHolder.getContext().getAuthentication();
  if (auth != null && auth.isAuthenticated()) {
   return auth.getName();
  }
  return "system";
 }

 public List<String> getRoles() {
  Authentication auth = SecurityContextHolder.getContext().getAuthentication();
  if (auth != null && auth.isAuthenticated()) {
   List<String> roles = new ArrayList<String>();

   for (GrantedAuthority ga : auth.getAuthorities()) {
    roles.add(ga.getAuthority());
   }

   return roles;
  }

  return Collections.emptyList();
 }

 public boolean hasRole(String role) {
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To configure jBPM services in a Spring application:

1. Configure the transaction manager:

2. Configure JPA and persistence:

3. Configure security providers:

4. Configure the runtime manager factory:

  return false;
 }

}

<context:annotation-config />
<tx:annotation-driven />
<tx:jta-transaction-manager />

<bean id="transactionManager" 
class="org.springframework.transaction.jta.JtaTransactionManager" />

<bean id="entityManagerFactory" 
class="org.springframework.orm.jpa.LocalContainerEntityManagerFactoryBean" depends-
on="transactionManager">
   <property name="persistenceXmlLocation" value="classpath:/META-INF/jbpm-
persistence.xml" />
</bean>

<util:properties id="roleProperties" location="classpath:/roles.properties" />

<bean id="userGroupCallback" 
class="org.jbpm.services.task.identity.JBossUserGroupCallbackImpl">
  <constructor-arg name="userGroups" ref="roleProperties"></constructor-arg>
</bean>

<bean id="identityProvider" class="org.jbpm.spring.SpringSecurityIdentityProvider"/>

<bean id="runtimeManagerFactory" 
class="org.kie.spring.manager.SpringRuntimeManagerFactoryImpl">
  <property name="transactionManager" ref="transactionManager"/>
  <property name="userGroupCallback" ref="userGroupCallback"/>
</bean>

<bean id="transactionCmdService" 
class="org.jbpm.shared.services.impl.TransactionalCommandService">
  <constructor-arg name="emf" ref="entityManagerFactory"></constructor-arg>
</bean>

<bean id="taskService" class="org.kie.spring.factorybeans.TaskServiceFactoryBean" 
destroy-method="close">
  <property name="entityManagerFactory" ref="entityManagerFactory"/>
  <property name="transactionManager" ref="transactionManager"/>
  <property name="userGroupCallback" ref="userGroupCallback"/>
  <property name="listeners">
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The runtime manager factory is Spring context aware and can interact with Spring containers.

5. Configure jBPM services as Spring beans:

    <list>
      <bean class="org.jbpm.services.task.audit.JPATaskLifeCycleEventListener">
        <constructor-arg value="true"/>
      </bean>
    </list>
  </property>
</bean>

<!-- definition service -->
<bean id="definitionService" 
class="org.jbpm.kie.services.impl.bpmn2.BPMN2DataServiceImpl"/>

<!-- runtime data service -->
<bean id="runtimeDataService" class="org.jbpm.kie.services.impl.RuntimeDataServiceImpl">
  <property name="commandService" ref="transactionCmdService"/>
  <property name="identityProvider" ref="identityProvider"/>
  <property name="taskService" ref="taskService"/>
</bean>

<!-- -- deployment service -->
<bean id="deploymentService" 
class="org.jbpm.kie.services.impl.KModuleDeploymentService" depends-
on="entityManagerFactory" init-method="onInit">
  <property name="bpmn2Service" ref="definitionService"/>
  <property name="emf" ref="entityManagerFactory"/>
  <property name="managerFactory" ref="runtimeManagerFactory"/>
  <property name="identityProvider" ref="identityProvider"/>
  <property name="runtimeDataService" ref="runtimeDataService"/>
</bean>

<!-- process service -->
<bean id="processService" class="org.jbpm.kie.services.impl.ProcessServiceImpl" depends-
on="deploymentService">
  <property name="dataService" ref="runtimeDataService"/>
  <property name="deploymentService" ref="deploymentService"/>
</bean>

<!-- user task service -->
<bean id="userTaskService" class="org.jbpm.kie.services.impl.UserTaskServiceImpl" 
depends-on="deploymentService">
  <property name="dataService" ref="runtimeDataService"/>
  <property name="deploymentService" ref="deploymentService"/>
</bean>

<!-- register runtime data service as listener on deployment service so it can receive 
notification about deployed and undeployed units -->
<bean id="data" 
class="org.springframework.beans.factory.config.MethodInvokingFactoryBean" depends-
on="deploymentService">
  <property name="targetObject" ref="deploymentService"></property>
  <property name="targetMethod"><value>addListener</value></property>
  <property name="arguments">
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  <list>
      <ref bean="runtimeDataService"/>
  </list>
  </property>
</bean>
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CHAPTER 15. INTEGRATION WITH ARIES BLUEPRINT
This chapter explains the integration elements of Red Hat JBoss BPM Suite specific to Apache Aries
Blueprint.

15.1. KIE NAMESPACE

KieModule
The <kie:kmodule> element defines a collection of a KieBase and its associated KieSessions.

Attribute Description

id The name to which other beans refer. Blueprint ID semantics applies. This
attribute is required.

Possible children:

kie:kbase

KieBase
The <kie:kbase> element has the following attributes:

Attribute Description

name The name of the KieBase. This attribute is required.

packages A comma-separated list of the resource packages to be included in the KieBase.

includes KieBase names to be included. All resources from the corresponding KieBases are
included in the parent KieBase.

default A Boolean. Sets the kbase as default. Set to false by default.

scope Possible values: prototype or singleton. Set to singleton by default.

eventProcessingMode Event Processing Mode. Possible values: STREAM or CLOUD.

equalsBehavior Possible values: IDENTITY or EQUALITY.

Possible children:

kie:ksession

The kmodule element can contain multiple kbase elements.

Example 15.1. kbase Definition Example

<kie:kmodule id="sample_module">
   <kie:kbase name="kbase1" packages="org.drools.blueprint.sample">
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When you define a kbase or a ksession, you can set the bean scope:

Set scope to prototype to instantiate a new bean instance every time the bean is called.

Set scope to singleton to use the same bean instance every time the bean is called.

KieSession
The <kie:ksession> element defines both stateful and stateless KieSessions. It has the following
parameters:

Attribute Description

name The name of the KieSession. This attribute is required.

type Possible values: stateful or stateless. Set to stateful by default.

default A Boolean. Sets the ksession as default. Set to false by default.

scope Possible values: prototype or singleton. Set to singleton by default.

clockType Possible values: REALTIME or PSEUDO.

listeners-ref Specifies the reference to the event listeners group. For more information, see
the section called “Defining a Group of Listeners”.

Example 15.2. ksession definition example

Kie:ReleaseId
The kie:releaseId element represents Maven GAV (Group ID, Artifact ID, and Version). kie:releaseId
requires the following properties:

Attribute Description

id The name to which other beans refer. Blueprint ID semantics applies.

groupId Maven groupId.

     ...
   </kie:kbase>
</kie:kmodule>

<kie:kmodule id="sample-kmodule">
  <kie:kbase name="drl_kiesample3" packages="drl_kiesample3">
    <kie:ksession name="ksession1" type="stateless"/>
    <kie:ksession name="ksession2"/>
  </kie:kbase>
</kie:kmodule>
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artifactId Maven artifactId.

version Maven version.

Attribute Description

Example 15.3. releaseId Definition Example

Kie:Import
Red Hat JBoss BPM Suite now supports kie-aries-blueprint importing KIE objects from KJARs. The 
kie:import element supports the following attributes:

Attribute Description

releaseId Reference to a bean ID. Standard Blueprint ID semantics applies.

enableScanner Enable Scanner. This attribute is used only if releaseId is specified.

scannerInterval Scanning Interval in milliseconds. This attribute is used only if releaseId is
specified.

Red Hat JBoss BPM Suite supports two modes of importing KIE objects:

Global Import

The kie:import element uses the KieServices.getKieClasspathContainer() method to import KIE
objects. For further information about KIE methods, see the KIE Api section of the Red Hat JBoss
BPM Suite Development Guide.

Global Import

Specific Import - ReleaseId

When using the releaseId-ref attribute on the import tag, only KIE objects identified by the
referenced releaseId element are initialized and imported into the Blueprint context.

KIE Objects Import Using releaseId

You can enable the KIE scanning feature, enableScanner, for KieBases imported with a specific

<kie:releaseId id="beanId" groupId="org.kie.blueprint"
            artifactId="named-artifactId" version="1.0.0-SNAPSHOT"/>

<kie:import />

<kie:import releaseId-ref="namedKieSession"/>
<kie:releaseId id="namedKieSession" groupId="org.drools"
            artifactId="named-kiesession" version="{revnumber}"/>
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You can enable the KIE scanning feature, enableScanner, for KieBases imported with a specific
releaseId. This feature is currently not available for global imports.

Import KIE Objects using a releaseId - Enable Scanner

If you define and enable a scanner, a KieScanner object is created with default values and inserted into
the Blueprint container. You can get the KieScanner object from the Blueprint container using the -
scanner suffix.

Retriving the KieScanner from a Blueprint Container

NOTE

kie-ci must be available on the classpath for the releaseId importing feature to work.

15.2. EVENT LISTENERS

Red Hat JBoss BPM Suite supports adding 3 types of listeners to KieSessions:

AgendaListener

WorkingMemoryListener

ProcessEventListener

The kie-aries-blueprint module allows you to configure the listeners for KIE sessions using XML tags.
The tags have identical names to the listener interfaces:

<kie:agendaEventListener>

<kie:ruleRuntimeEventListener>

<kie:processEventListener>

The kie-aries-blueprint module allows you to define listeners as standalone listeners or as a group.

Defining Standalone Listeners
Standalone listeners support the following parameters:

Attribute Description

ref A reference to a bean.

<kie:import releaseId-ref="namedKieSession"
            enableScanner="true" scannerInterval="1000"/>

<kie:releaseId id="namedKieSession" groupId="org.drools"
            artifactId="named-kiesession" version="{revnumber}"/>

// the implicit name would be releaseId-scanner
KieScanner releaseIdScanner = (KieScanner)container.getComponentInstance("namedKieSession-
scanner");
releaseIdScanner.scanNow();
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Example 15.4. Listener Configuration Using bean:ref

Defining Multiple Listeners of One Type
You can also define multiple listeners of one type for a KIE session.

Example 15.5. Listener Configuration: Multiple Listeners of One Type.

Defining a Group of Listeners
The kie-aries-blueprint module allows you to group listeners. This is useful when you define a set of
listeners that you want to attach to multiple sessions, or when switching from testing to production use.
The following attribute is required:

Attribute Description

ID Unique identifier

Possible children:

kie:agendaEventListener

kie:ruleRuntimeEventListener

kie:processEventListener

NOTE

<bean id="mock-agenda-listener" class="mocks.MockAgendaEventListener"/>
<bean id="mock-rr-listener" class="mocks.MockRuleRuntimeEventListener"/>
<bean id="mock-process-listener" class="mocks.MockProcessEventListener"/>

<kie:kmodule id="listeners_kmodule">
  <kie:kbase name="drl_kiesample" packages="drl_kiesample">
    <kie:ksession name="ksession2">
      <kie:agendaEventListener ref="mock-agenda-listener"/>
      <kie:processEventListener ref="mock-process-listener"/>
      <kie:ruleRuntimeEventListener ref="mock-rr-listener"/>
    </kie:ksession>
  </kie:kbase>
</kie:kmodule>

<bean id="mock-agenda-listener1" class="mocks.MockAgendaEventListener"/>
<bean id="mock-agenda-listener2" class="mocks.MockAgendaEventListener"/>

<kie:kmodule id="listeners_module">
  <kie:kbase name="drl_kiesample" packages="drl_kiesample">
    <kie:ksession name="ksession1">
      <kie:agendaEventListener ref="mock-agenda-listener1"/>
      <kie:agendaEventListener ref="mock-agenda-listener2"/>
    </kie:ksession>
  </kie:kbase>
</kie:kmodule>
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NOTE

The declaration order does not matter. Only one declaration of each type is allowed in a
group.

Example 15.6. Group of Listeners

15.3. LOGGERS

Red Hat JBoss BPM Suite supports the following loggers:

ConsoleLogger

FileLogger

The kie-aries-blueprint module allows you to configure the loggers using XML tags with identical
names:

<kie:consoleLogger>

<kie:fileLogger>

Defining a Console Logger
The <kie:consoleLogger/> element has no attributes and must be present directly under a 
<kie:ksession> element.

Example 15.7. Defining a Console Logger

<bean id="mock-agenda-listener" class="mocks.MockAgendaEventListener"/>
<bean id="mock-rr-listener" class="mocks.MockRuleRuntimeEventListener"/>
<bean id="mock-process-listener" class="mocks.MockProcessEventListener"/>

<kie:kmodule id="listeners_module">
  <kie:kbase name="drl_kiesample" packages="drl_kiesample">
    <kie:ksession name="statelessWithGroupedListeners" type="stateless"
             listeners-ref="debugListeners"/>
  </kie:kbase>
</kie:kmodule>

  <kie:eventListeners id="debugListeners">
  <kie:agendaEventListener ref="mock-agenda-listener"/>
  <kie:processEventListener ref="mock-process-listener"/>
  <kie:ruleRuntimeEventListener ref="mock-rr-listener"/>
</kie:eventListeners>

<kie:kmodule id="loggers_module">
  <kie:kbase name="drl_kiesample" packages="drl_kiesample">
    <kie:ksession name="ConsoleLogger-statefulSession" type="stateful">
      <kie:consoleLogger/>
    </kie:ksession>
  </kie:kbase>
</kie:kmodule>
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Defining a File Logger
The <kie:fileLogger/> element supports the following attributes:

Attribute Description

ID Unique identifier. This attribute is required.

file Path to the log file on the disk. This attribute is required.

threaded Possible values: true or false. Set to false by default.

interval An Integer. Specifies the interval for flushing the contents from memory to the
disk.

Example 15.8. Defining a File Logger

Closing a FileLogger
It is recommended to close the <kie:fileLogger> logger to prevent memory leaks:

Defining Batch Commands
The <kie:batch> element allows you to define a set of batch commands for a given KIE session. The 
<kie:batch> element has no attributes and must be placed under a <kie:ksession> element.

Supported Parameters for Initialization Batch Commands

insert-object

ref: String. This parameter is optional.

Anonymous bean.

set-global

identifier: String. This parameter is required.

reg: String. This parameter is optional.

<kie:kmodule id="loggers_module">
  <kie:kbase name="drl_kiesample" packages="drl_kiesample">
    <kie:ksession name="ConsoleLogger-statefulSession" type="stateful">
      <kie:fileLogger id="fl_logger" file="#{ systemProperties['java.io.tmpdir'] }/log1"/>
      <kie:fileLogger id="tfl_logger" file="#{ systemProperties['java.io.tmpdir'] }/log2"
                          threaded="true" interval="5"/>
    </kie:ksession>
  </kie:kbase>
</kie:kmodule>

LoggerAdaptor adaptor = (LoggerAdaptor) container.getComponentInstance("fl_logger");
adaptor.close();
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Anonymous bean.

fire-all-rules

max: Integer.

fire-until-halt

start-process

identifier: String. This parameter is required.

ref: String. This parameter is optional.

Anonymous bean.

signal-event

ref: String. This parameter is optional.

event-type: String. This parameter is required.

process-instance-id: Integer. This parameter is optional.

Example 15.9. Batch Commands Example

<kie:kmodule id="batch_commands_module">
  <kie:kbase name="drl_kiesample" packages="drl_kiesample">
    <kie:ksession name="ksessionForCommands" type="stateful">
      <kie:batch>
        <kie:insert-object ref="person2"/>
        <kie:set-global identifier="persons" ref="personsList"/>
        <kie:fire-all-rules max="10"/>
      </kie:batch>
    </kie:ksession>
  </kie:kbase>
</kie:kmodule>
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CHAPTER 16. CDI INTEGRATION

16.1. ABOUT CDI

Apart from the API based approach, Red Hat JBoss BPM Suite 6 also provides the Context and
Dependency Injection (CDI) to build your custom applications. CDI is a collection of component
management services for the Java EE platform that enables developers to use enterprise beans in web
applications. The benefits of CDI include a simplified architecture and more resuable code.

The jbpm-services-cdi module provides CDI wrappers of Kie Services that enable these services to be
injected in any CDI bean.

WARNING

A workaround is needed on the Oracle WebLogic Server for CDI to work. For more
information, see Additional Notes in the Red Hat JBoss BPM Suite Oracle WebLogic
Installation and Configuration Guide.

16.2. DEFINING MBEANS FOR CDI INTEGRATION

To make use of jbpm-kie-services in your system, you must provide some MBeans to satisfy all
dependencies of the services. There are several MBeans that depend on actual scenarios.

Entity manager and entity manager factory

User group callback for human tasks

Identity provider to pass authenticated user information to the services

Procedure

1. When running in a JEE environment such as JBoss Application Server, ensure that the mbean
satisfies all requirements of the jbpm-kie-services:

public class EnvironmentProducer {

    @PersistenceUnit(unitName = "org.jbpm.domain")
    private EntityManagerFactory emf;

    @Inject
    @Selectable
    private UserGroupCallback userGroupCallback;

    @Produces
    public EntityManagerFactory getEntityManagerFactory() {
        return this.emf;
    }

    @Produces
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    @RequestScoped
    public EntityManager getEntityManager() {
        EntityManager em = emf.createEntityManager();
        return em;
    }

    public void close(@Disposes EntityManager em) {
        em.close();
    }

    @Produces
    public UserGroupCallback produceSelectedUserGroupCalback() {
        return userGroupCallback;
    }
    @Produces

    public IdentityProvider produceIdentityProvider {
        return new IdentityProvider() {
             // implement IdentityProvider
        };
    }
}

2. Configure the deployments/business-central.war/WEB-INF/beans.xml file to change the
current settings of the new usergroupcallback implementation:

<beans xmlns="http://java.sun.com/xml/ns/javaee" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:schemaLocation="http://java.sun.com/xml/ns/javaee 
http://docs.jboss.org/cdi/beans_1_0.xsd">

<alternatives>
  <class>org.jbpm.services.task.identity.JAASUserGroupCallbackImpl</class>
</alternatives>

</beans>

NOTE

org.jbpm.services.task.identity.JAASUserGroupCallbackImpl is just an
example here to demonstrate the settings of the application server regardless of
what it actually is (LDAP, DB, etc).
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CHAPTER 17. PERSISTENCE
The runtime data of the Process Engine can be persisted in data stores. The persistence mechanism
saves the data using marshalling: the runtime data is converted into a binary dataset and the dataset is
saved in the data storage.

Note that persistence is not configured by default and the engine runs without persistence.

CUSTOM MARSHALLING MECHANISM

The runtime data is saved using marshalling (binary persistence). The marshalling
mechanism is a custom serialization mechanism.

Red Hat JBoss BPM Suite will persist the following when persistence is configured:

Session state : This includes the session ID, date of last modification, the session data that
business rules would need for evaluation, state of timer jobs.

Process instance state: This includes the process instance ID, process ID, date of last
modification, date of last read access, process instance start date, runtime data (the execution
status including the node being executed, variable values, etc.)and the eventtypes.

Work item runtime state : This includes the work item ID, creation date, name, process instance
ID, and the work item state itself.

Based on the persisted data, it is possible to restore the state of execution of all running process
instances in case of failure or to temporarily remove running instances from memory and restore them
later. By default, no persistence is configured.

To allow persistence, you need to add the jbpm-persistence jar files to the classpath of your application
and configure the engine to use persistence. The engine automatically stores the runtime state in the
storage when the engine reaches a safe point. Safe points are points where the process instance has
paused. When a process instance invocation reaches a safe point in the engine, the engine stores any
changes to the process instance as a snapshot of the process runtime data. However, when a process
instance is completed, the persisted snapshot of process instance runtime data is automatically deleted.

If a failure occurs and you need to restore the engine runtime from the storage, the process instances
are automatically restored and their execution resumes so there is no need to reload and trigger the
process instances manually.

The runtime persistence data is to be considered internal to the engine. You should not access persisted
runtime data or modify them directly as this might have unexpected side effects.

To obtain information about the current execution state, refer to the history log. Query the database for
runtime data only if absolutely necessary.

17.1. SESSION

Sessions are persisted as SessionInfo entities. These persist the state of the runtime KIE session, and
store the following data:

Field Description Nullable
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id primary key false

lastmodificationdate last saved to data store N/A

rulesbytearray binary dataset with session state
(binary blob

false

startdate session start  

optlock version number used to lock value
for optimistic locking

 

Field Description Nullable

17.2. PROCESS INSTANCE

Process instances are persisted as ProcessInstanceInfo entities, which persist the state of a process
instance on runtime and store the following data:

Field Description Nullable

instanceid primary key false

lastmodificationdate last saved to data store N/A

lastreaddate last read from data store N/A

processid ID of the process the instance is
based on

false

processinstancebytearray binary dataset with process
instance state (binary blob)

false

startdate Process instance start date  

optlock version number used lock value
for optimistic locking

 

state Process instance state false

ProcessInstanceInfo has a 1:N relationship to the EventTypes entity.

The EventTypes entity contains the following data:

Field Description Nullable
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instanceid reference to the Process instance
(foreign key to the 
processinstanceinfo)

false

element text field related to an event the
Process instance has undergone

 

Field Description Nullable

Pessimistic Locking Support
The default locking mechanism for persistence of processes is optimistic. With multi-thread high
concurrency to the same process instance, this locking strategy can result in bad performance.

With the release of the 6.1 version of Red Hat JBoss BPM Suite, this can be changed at runtime to allow
the user to set locking on a per process basis and to allow it to be pessimistic (the change can be made
at a per KIE Session level or Runtime Manager level as well and not just at the process level).

To set a process to use pessimistic locking, do this in the runtime environment:

import org.kie.api.runtime.Environment;
import org.kie.api.runtime.EnvironmentName;
import org.kie.api.runtime.manager.RuntimeManager;
import org.kie.api.runtime.manager.RuntimeManagerFactory;

...

// here env is an instance of org.kie.api.runtime.Environment
env.set(EnvironmentName.USE_PESSIMISTIC_LOCKING, true);

// now create your Runtime Manager using this environment
RuntimeManager manager = 
RuntimeManagerFactory.Factory.get().newPerRequestRuntimeManager(environment);

17.3. WORK ITEM

Work Items are persisted as workiteminfo entities, which persist the state of the particular work item
instance on runtime and store the following data:

Field Description Nullable

workitemid primary key false

name work item name  

processinstanceid parent Process instance id false

state integer representing work item
state

false
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optlock version number used lock value
for optimistic locking

 

workitembytearray binary dataset with work item
state (binary blob)

false

creationDate timestampe on which the work
item was created

false

Field Description Nullable

17.4. PERSISTENCE CONFIGURATION

17.4.1. Persistence configuration

Although persistence is not used by default, the dependencies needed are available in the runtime
directory as jar files.

Persistence is defined per session and you can define it either using the JBPMHelper class after you
create a session or using the JPAKnowledgeService to create your session. The latter option provides
more flexibility, while JBPMHelper has a method to create a session, and uses a configuration file to
configure this session.

17.4.2. Configuring persistence using JBPMHelper

To configure persistence of your session using JBPMHelper, do the following:

1. Define your application to use an appropriate JBPMHelper session constructor:

KieSession ksession = JBPMHelper.newKieSession(kbase);

KieSession ksession = JBPMHelper.loadKieSession(kbase, sessionId);

2. Configure the persistence in the jBPM.properties file.

Example 17.1. A sample jBPM.properties file with persistence for the in-memory H2
database

# for creating a datasource
persistence.datasource.name=jdbc/jbpm-ds
persistence.datasource.user=sa
persistence.datasource.password=
persistence.datasource.url=jdbc:h2:tcp://localhost/~/jbpm-db
persistence.datasource.driverClassName=org.h2.Driver

# for configuring persistence of the session
persistence.enabled=true
persistence.persistenceunit.name=org.jbpm.persistence.jpa
persistence.persistenceunit.dialect=org.hibernate.dialect.H2Dialect

# for configuring the human task service
taskservice.enabled=true
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taskservice.datasource.name=org.jbpm.task
taskservice.transport=mina
taskservice.usergroupcallback=org.jbpm.task.service.DefaultUserGroupCallbackImpl

Any invocations on the session will now trigger the persistence process.

Make sure the datasource is up and running on engine start. If you are running the in-memory H2
database, you can start the database from your application using the JBPMHelper.startH2Server();
method call and register it with the engine using JBPMHelper.setupDataSource(); method call.

17.4.3. Configuring persistence using JPAKnowledgeService

To create your knowledge session and configure its persistence using JPAKnowledgeService, do the
following:

1. Define your application to use the knowledge session created by JPAKnowledgeService:

a. Define the session based on a knowledge base, a knowledge session configuration, and an
environment. The environment must contain a reference to your Entity Manager Factory:

// create the entity manager factory and register it in the environment
EntityManagerFactory emf = Persistence.createEntityManagerFactory( 
"org.jbpm.persistence.jpa" );
Environment env = KnowledgeBaseFactory.newEnvironment();
env.set( EnvironmentName.ENTITY_MANAGER_FACTORY, emf );

// create a new knowledge session that uses JPA to store the runtime state
KieSession ksession = JPAKnowledgeService.newKieSession( kbase, null, env );
int sessionId = ksession.getId();

// invoke methods on your method here
ksession.startProcess( "MyProcess" );
ksession.dispose();

b. Define the session based on a specific session id.

// recreate the session from database using the sessionId
ksession = JPAKnowledgeService.loadKieSession(sessionId, kbase, null, env );

2. Configure the persistence in the META-INF/persistence.xml file: configure JPA to use
Hibernate and the respective database.
Information on how to configure data source on your application server should be available in
the documentation delivered with the application server. For this information for JBoss
Enterprise Application Platform, see the Administration and Configuration Guide  for this
product.

Example 17.2. A sample persistence.xml file with persistence for an H2 data source
jdbc/jbpm-ds

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<persistence
  version="1.0"
  xsi:schemaLocation=
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    "http://java.sun.com/xml/ns/persistence
     http://java.sun.com/xml/ns/persistence/persistence_1_0.xsd
     http://java.sun.com/xml/ns/persistence/orm
     http://java.sun.com/xml/ns/persistence/orm_1_0.xsd"
  xmlns:orm="http://java.sun.com/xml/ns/persistence/orm"
  xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
  xmlns="http://java.sun.com/xml/ns/persistence">
  <persistence-unit name="org.jbpm.persistence.jpa" transaction-type="JTA">
    <provider>org.hibernate.ejb.HibernatePersistence</provider>
    <jta-data-source>jdbc/jbpm-ds</jta-data-source>
    <mapping-file>META-INF/JBPMorm.xml</mapping-file>
    <class>org.drools.persistence.info.SessionInfo</class>
    <class>org.jbpm.persistence.processinstance.ProcessInstanceInfo</class>
    <class>org.drools.persistence.info.WorkItemInfo</class>
    <properties>
      <property name="hibernate.dialect" value="org.hibernate.dialect.H2Dialect"/>
      <property name="hibernate.max_fetch_depth" value="3"/>
      <property name="hibernate.hbm2ddl.auto" value="update"/>
      <property name="hibernate.show_sql" value="true"/>
      <property name="hibernate.transaction.manager_lookup_class"
                value="org.hibernate.transaction.BTMTransactionManagerLookup"/>
    </properties>
  </persistence-unit>
</persistence>

Any invocations on the session will now trigger the persistence process.

Make sure the datasource is up and running on engine start. If you are running the in-memory H2
database, you can start the database from your application using the JBPMHelper.startH2Server();
method call and register it with the engine using JBPMHelper.setupDataSource(); method call.

SAMPLE DATA SOURCE CONFIGURATION FOR SIMPLE JAVA
ENVIRONMENT

If you are running JBoss BPM Suite in a simple Java environment, your data source
configuration will be similar to the following:

PoolingDataSource ds = new PoolingDataSource();
ds.setUniqueName("jdbc/jbpm-ds");
ds.setClassName("bitronix.tm.resource.jdbc.lrc.LrcXADataSource");
ds.setMaxPoolSize(3);
ds.setAllowLocalTransactions(true);
ds.getDriverProperties().put("user", "sa");
ds.getDriverProperties().put("password", "sasa");
ds.getDriverProperties().put("URL", "jdbc:h2:tcp://localhost/~/jbpm-db");
ds.getDriverProperties().put("driverClassName", "org.h2.Driver");
ds.init();
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CHAPTER 18. TRANSACTIONS

18.1. TRANSACTIONS

The Process Engine supports JTA transactions: local transactions are only supported when using Spring.
Pure local transactions are not supported.

By default, each method invocation is considered a transaction. To change this behavior, for example, to
combine multiple commands into one transaction, you will need to specify transaction boundaries.

18.2. DEFINING TRANSACTIONS

To define a transaction, do the following:

1. Register the transaction manager in your environment:

Example 18.1. Code with transaction manager registration

// create the entity manager factory
EntityManagerFactory emf = 
EntityManagerFactoryManager.get().getOrCreate("org.jbpm.persistence.jpa");
TransactionManager tm = TransactionManagerServices.getTransactionManager();
Environment env = EnvironmentFactory.newEnvironment();
env.set(EnvironmentName.ENTITY_MANAGER_FACTORY, emf);
env.set(EnvironmentName.TRANSACTION_MANAGER, tm);

// setup the runtime environment
RuntimeEnvironment environment = RuntimeEnvironmentBuilder.Factory.get()
.newDefaultBuilder()
.addAsset(ResourceFactory.newClassPathResource("MyProcessDefinition.bpmn2"), 
ResourceType.BPMN2)
    .addEnvironmentEntry(EnvironmentName.TRANSACTION_MANAGER, tm)
    .addEnvironmentEntry(EnvironmentName.PERSISTENCE_CONTEXT_MANAGER, 
new JpaProcessPersistenceContextManager(env))
    
.addEnvironmentEntry(EnvironmentName.TASK_PERSISTENCE_CONTEXT_MANAGER,
new JPATaskPersistenceContextManager(env))
    .get();

2. Initialize the KieSession:

// get the KieSession
RuntimeManager manager = 
RuntimeManagerFactory.Factory.get().newPerProcessInstanceRuntimeManager(environment)
;
RuntimeEngine runtime = manager.getRuntimeEngine(ProcessInstanceIdContext.get());
KieSession ksession = runtime.getKieSession();

3. Define the transaction manager in jndi.properties:

Example 18.2. Definition of Bitronix transaction manager in jndi.properties

java.naming.factory.initial=bitronix.tm.jndi.BitronixInitialContextFactory
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USING ANOTHER TRANSACTION MANAGER

To use a different JTA transaction manager, edit the 
hibernate.transaction.manager_lookup_class, the transaction manager
property, in the persistence.xml file to load your transaction manager.

For example, if choosing JBoss Transaction Manager:

<property name="hibernate.transaction.manager_lookup_class" 
value="org.hibernate.transaction.JBossTransactionManagerLookup"/>

4. Define the start and the end of the transaction.

// start the transaction
UserTransaction ut = InitialContext.doLookup("java:comp/UserTransaction");
ut.begin();

// perform multiple commands inside one transaction
ksession.insert( new Person( "John Doe" ) );
ksession.startProcess("MyProcess");

// commit the transaction
ut.commit();

18.3. CONTAINER MANAGED TRANSACTIONS

In cases where JBoss BPM Suite is embedded inside an application that is in a container that can
manage transactions by itself (Container Managed Transactions - CMT), a special dedicated transaction
manager is provided using the org.jbpm.persistence.jta.ContainerManagerTransactionManager
class. This is because the default implementation of the transaction manager in JBoss BPM Suite is
based on the UserTransaction class getting the transaction status. However, some application servers
in a CMT mode do not allow accessing the UserTransaction instance from JNDI.

Operations executed on this manager are all no-op because they cannot affect the underlying CMT. The
ContainerManagedTransactionManager class expects that the transaction is always active (returning 
ACTIVE to the getStatus() method).

NOTE

Even though the container manages transactions, the container should be made aware of
any exceptions that happen during process instance execution. Exceptions thrown by the
engine should be propagated up to the container to properly rollback transactions.

Configuring the Transaction Manager
To configure and use the ContainerManagedTransactionManager, it needs to be inserted into the
environment before you create or load a session:

Environment env = EnvironmentFactory.newEnvironment();
env.set(EnvironmentName.ENTITY_MANAGER_FACTORY, emf);
env.set(EnvironmentName.TRANSACTION_MANAGER, new 

Red Hat JBoss BPM Suite 6.4 Administration and Configuration Guide

132



ContainerManagedTransactionManager());
env.set(EnvironmentName.PERSISTENCE_CONTEXT_MANAGER, new 
JpaProcessPersistenceContextManager(env));

Next, setup the JPA Provider in your persistence.xml file. For example, if using IBM WebSphere:

<property name="hibernate.transaction.factory_class" 
value="org.hibernate.transaction.CMTTransactionFactory"/>
<property name="hibernate.transaction.manager_lookup_class" 
value="org.hibernate.transaction.WebSphereExtendedJTATransactionLookup"/>

Disposing the KSession in a CMT
In a CMT, you should not dispose the ksession directly (by using the dispose() method). Doing so will
cause exceptions on transaction completion as the Process Engine needs to clean up the state after the
invocation has finished.

Instead, use the specialized class 
org.jbpm.persistence.jta.ContainerManagedTransactionDisposeCommand's execute() method.
Using this command ensures that the ksession will be disposed when the transaction is actually
complete.

This method checks to see if the transaction is active. If it is, it delegates the actual disposal to the 
afterDisposal phase of the transaction instead of executing it directly. If there is no active transaction,
the ksession is disposed immediately.
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CHAPTER 19. LOGGING
The logging mechanism allows you to store information about the execution of a process instance. It is
provided by a special event listener that listens to the Process Engine for any relevant events to be
logged, so that the information can be stored separately from other non-log information stored either in
the server built-in database (H2) or a connected data source using JPA or Hibernate.

The jbpm-audit module provides the event listener and also allows you to store process-related
information directly in a database using JPA or Hibernate. The data of the following entities is stored as
follows:

Process instance as processinstancelog

Element instance as nodeinstancelog

Variable instance as variableinstancelog

Table 19.1. Fields of the ProcessInstanceLog table

Field Description Nullable

id The primary key of the log entity No

end_date The end date of the process
instance

Yes

processid The name (id) of the underlying
process

Yes

processinstanceid The id of the process instance No

start_date The start date of the process
instance

Yes

status The status of the process
instance

Yes

parentProcessInstanceId The process instance id of the
parent process instance if
applicable

Yes

outcome The outcome of the process
instance (details on the process
finish, such as error code)

Yes

Table 19.2. Fields of the NodeInstanceLog table

Field Description Nullable

id The primary key of the log entity No
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log_date The date of the event Yes

nodeid The node id of the underlying
Process Element

Yes

nodeinstanceid The id of the node instance Yes

nodename The name of the underlying node Yes

processid The id of the underlying process Yes

processinstanceid The id of the parent process
instance

No

type The type of the event (0 = enter
event, 1 = exit event)

No

Field Description Nullable

Table 19.3. Fields of the VariableInstanceLog table

Field Description Nullable

id The primary key of the log entity No

log_date The date of the event Yes

processid The name (id) of the underlying
process

Yes

processinstanceid The id of the process instance No

value The value of the variable at log
time

Yes

variableid The variable id as defined in the
process definition

Yes

variableinstanceid The id of the variable instance Yes

outcome The outcome of the process
instance (details on the process
finish, such as error code)

Yes

If necessary, define your own data model of custom information and use the process event listeners to
extract the information.
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19.1. LOGGING EVENTS TO DATABASE

To log an event that occurs on runtime in a Process instance, an Element instance, or a variable instance,
you need to do the following:

1. Map the Log classes to the data source, so that the given data source accepts the log entries.
On Red Hat JBoss EAP, edit the data source properties in the persistence.xml file.

Example 19.1. The ProcessInstanceLog, NodeInstanceLog and VariableInstanceLog
classes enabled for processInstanceDS

2. Register a logger on your Kie Session.

Example 19.2. Import the Loggers

Example 19.3. Registering a Logger to a Kie Session

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<persistence  version="1.0"  xsi:schemaLocation=
    "http://java.sun.com/xml/ns/persistence
     http://java.sun.com/xml/ns/persistence/persistence_1_0.xsd
     http://java.sun.com/xml/ns/persistence/orm
     http://java.sun.com/xml/ns/persistence/orm_1_0.xsd"
  xmlns:orm="http://java.sun.com/xml/ns/persistence/orm"
  xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
  xmlns="http://java.sun.com/xml/ns/persistence">

  <persistence-unit name="org.jbpm.persistence.jpa">
    <provider>org.hibernate.ejb.HibernatePersistence</provider>
    <jta-data-source>jdbc/processInstanceDS</jta-data-source>
    <class>org.drools.persistence.info.SessionInfo</class>
    <class>org.jbpm.persistence.processinstance.ProcessInstanceInfo</class>
    <class>org.drools.persistence.info.WorkItemInfo</class>
    <class>org.jbpm.process.audit.ProcessInstanceLog</class>
    <class>org.jbpm.process.audit.NodeInstanceLog</class>
    <class>org.jbpm.process.audit.VariableInstanceLog</class>

    <properties>
      <property name="hibernate.dialect" value="org.hibernate.dialect.H2Dialect"/>
      <property name="hibernate.max_fetch_depth" value="3"/>
      <property name="hibernate.hbm2ddl.auto" value="update"/>
      <property name="hibernate.show_sql" value="true"/>
      <property name="hibernate.transaction.manager_lookup_class"
                value="org.hibernate.transaction.BTMTransactionManagerLookup"/>
    </properties>
  </persistence-unit>
</persistence>

import org.jbpm.process.audit.AuditLogService;
import org.jbpm.process.audit.AuditLoggerFactory;
import org.jbpm.process.audit.AuditLoggerFactory.Type;
import org.jbpm.process.audit.JPAAuditLogService;
...
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3. Optionally, call the method addFilter on the logger to filter out irrelevant information. Only
information accepted by all filters appears in the database.

4. Logger classes can be viewed in the Audit View:

<dependency>
 <groupId>org.jbpm</groupId>
 <artifactId>jbpm-audit</artifactId>
 <version>6.5.0.Final-redhat-2</version>
</dependency>

19.2. LOGBACK FUNCTIONALITY

Red Hat JBoss BPM Suite provides logback functionality for logging configuration.

Accordingly, everything configured is logged to the Simple Logging Facade for Java  SLF4J, which
delegates any log to Logback, Apache Commons Logging, Log4j or java.util.logging. Add a dependency
to the logging adaptor for your logging framework of choice. If you are not using any logging framework
yet, you can use Logback by adding this Maven dependency:

NOTE

slf4j-nop and slf4j-simple are ideal for a light environment.

19.3. CONFIGURING LOGGING

To configure the logging level of the packages, create a logback.xml file in business-
central.war/WEB-INF/classes/logback.xml. To set the logging level of the org.drools package to
"debug" for verbose logging, you would need to add the following line to the file:

@PersistenceUnit(unitName = PERSISTENCE_UNIT_NAME)
  private EntityManagerFactory emf;

  private AuditLogService auditLogService;
@PostConstruct
  public void configure() {

  auditLogService = new JPAAuditLogService(emf);
  ((JPAAuditLogService) 
auditLogService).setPersistenceUnitName(PERSISTENCE_UNIT_NAME);

  RuntimeEngine runtime = singletonManager.getRuntimeEngine(EmptyContext.get());
  KieSession ksession = runtime.getKieSession();
  AuditLoggerFactory.newInstance(Type.JPA, ksession, null);

  }

<dependency>
   <groupId>ch.qos.logback</groupId>
   <artifactId>logback-classic</artifactId>
   <version>1.x</version>
</dependency>
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Similarly, you can configure logging for packages such as the following:

org.guvnor

org.jbpm

org.kie

org.slf4j

org.dashbuilder

org.uberfire

org.errai

etc…

If configuring with log4j, the log4j.xml can be located at business-central.war/WEB-
INF/classes/log4j.xml and can be configured in the following way:

NOTE

Additional logging can be configured in the individual container. To configure logging for
JBoss Enterprise Application Platform, please refer to the Red Hat JBoss Enterprise
Application Platform Administration and Configuration Guide.

19.4. MANAGING LOG FILES

Red Hat JBoss BPM Suite manages most of the required maintenance. Automatically cleaned runtime
data includes:

Process instances data, which is removed upon process instance completion.

Work items data, which is removed upon work item completion.

Task instances data, which is removed upon completion of a process to which given task
belongs.

<configuration>
  <logger name="org.drools" level="debug"/>

  ...
<configuration>

<log4j:configuration xmlns:log4j="http://jakarta.apache.org/log4j/">

  <category name="org.drools">
    <priority value="debug" />
  </category>

  ...

</log4j:configuration>
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Runtime data, which may not be automatically cleaned, includes session information data. This depends
on the selected runtime strategy:

Singleton strategy ensures that session information runtime data will not be automatically
removed.

Per request strategy allows automatic removal when a given request terminates.

Per process instances will be automatically removed when process instance mapped to a given
session completes or is aborted.

Red Hat JBoss BPM Suite does not remove executor request and error information.

In order not to lose track of process instances, Red Hat JBoss BPM Suite offers audit data tables. These
are used by default and keep track of the BPM Suite environment. JBoss BPM Suite offers two ways of
how to manage and maintain the audit data tables:

Automatic clean-up

Manual clean-up

19.4.1. Automatic Clean-Up

Automatic clean-up uses the LogCleanupCommand executor command, which consists of logic to
clean up all or selected data automatically. An advantage of the automatic clean-up method is the
ability to schedule repeated clean-ups by using reoccurring job feature of the JBoss BPM Suite
executor. This means that when one job completes, it provides information to the JBoss BPM Suite
executor if and when the next instance of this job should be executed. By default, 
LogCleanupCommand is executed once a day but can be reconfigured to run on different intervals.

There are several important configuration options that can be used with the LogCleanupCommand
command:

Table 19.4. LogCleanupCommand parameters table

Name Description Is Exclusive

SkipProcessLog Indicates if the clean-up of
process instances, node instances
and variables log cleanup should
be omitted (default: false)

No, can be used with other
parameters

SkipTaskLog Indicates if the task audit and the
task event log clean-up should be
omitted (default: false)

No, can be used with other
parameters

SkipExecutorLog Indicates if the JBoss BPM Suite
executor entries clean-up should
be omitted (default: false)

No, can be used with other
parameters

SingleRun Indicates if the job routine should
run only once (default: false)

No, can be used with other
parameters
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NextRun Sets a date for the next run.

For example, 12h is set for jobs to
be executed every 12 hours. If the
option is not given, the next job
will run 24 hours after the
completion of the current job

No, can be used with other
parameters

OlderThan Causes logs older than the given
date to be removed. The date
format is YYYY-MM-DD. Usually,
this parameter is used for single
run jobs

Yes, cannot be used when the
OlderThanPeriod parameter is
used

OlderThanPeriod Causes logs older than the given
timer expression should be
removed. For example, set 30d to
remove logs older than 30 day
from current time

Yes, cannot be used when the
OlderThan parameter is used

ForProcess Specifies process definition ID for
which logs should be removed

No, can be used with other
parameters

ForDeployment Specifies deployment ID for which
logs should be removed

No, can be used with other
parameters

EmfName Persistence unit name that shall
be used to perform operation
deletion

N/A

Name Description Is Exclusive

NOTE

LogCleanupCommand does not remove any active instances, such as running process
instances, task instances, or executor jobs.

WARNING

While all audit tables have a time stamp, some may be missing other parameters,
such as process id, or deployment id. For that reason, it is recommended to use the
date parameter when managing the clean-up job routine.

19.4.2. Setting up Automatic Clean-up Job

To set up automatic clean-up job, do the following:
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1. Open Business Central in your web browser (if running locally http://localhost:8080/business-
central) and log in as a user with the admin role.

2. Go to Deploy → Jobs.

3. Click  in the top right hand corner of the page.

4. Enter a name, due date and time. Enter the following into the Type text field:

org.jbpm.executor.commands.LogCleanupCommand

5. Click on Add Parameter if you wish to use parameters listed above. In the key section, enter a
parameter name. In the value section, enter true or false, depending on the desired outcome.

6. Click Create to finalize the job creation wizard. You have successfully created an automatic
clean-up job.

19.4.3. Manual Clean-Up

You may make use of audit API to do the clean-up manually with more control over parameters and thus
more control over what will be removed. Audit API is divided into following areas:

Process audit, which is used to clean up process, node and variables logs, accessible in the 
jbpm-audit module

Task audit, which is used to clean up tasks and task events, accessible in the jbpm-human-task-
audit module

Executor jobs, which is used to clean up executor jobs and errors, accessible in the jbpm-
executor module

Modules are sorted hierarchically and can be accessed as follows:

org.jbpm.process.audit.JPAAuditLogService

org.jbpm.services.task.audit.service.TaskJPAAuditService

org.jbpm.executor.impl.jpa.ExecutorJPAAuditService

Several examples of manual clean-up follow:

Example 19.4. Removal of completed process instance logs

Example 19.5. Task audit logs removal for the org.jbpm:HR:1.0 deployment

import org.jbpm.process.audit.JPAAuditLogService;
import org.kie.internal.runtime.manager.audit.query.ProcessInstanceLogDeleteBuilder;
import org.kie.api.runtime.process.ProcessInstance;

JPAAuditLogService auditService = new JPAAuditLogService(emf);
ProcessInstanceLogDeleteBuilder updateBuilder = 
auditService.processInstanceLogDelete().status(ProcessInstance.STATE_COMPLETED);
int result = updateBuilder.build().execute();
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Example 19.6. Executor error and requests removal

NOTE

When removing executor entries, ensure that the error information is removed before the
request information because of constraints setup on database.

WARNING

Parts of the code utilize internal API. While this does not have any direct impact on
the functionality of our product, internal API is subject to change and Red Hat
cannot guarantee backward compatibility.

import org.jbpm.services.task.audit.service.TaskJPAAuditService;
import org.kie.internal.task.query.AuditTaskDeleteBuilder;

TaskJPAAuditService auditService = new TaskJPAAuditService(emf);
AuditTaskDeleteBuilder updateBuilder = 
auditService.auditTaskDelete().deploymentId("org.jbpm:HR:1.0");
int result = updateBuilder.build().execute();

import org.jbpm.executor.impl.jpa.ExecutorJPAAuditService;
import org.kie.internal.runtime.manager.audit.query.ErrorInfoDeleteBuilder;
import org.kie.internal.runtime.manager.audit.query.RequestInfoLogDeleteBuilder;

ExecutorJPAAuditService auditService = new ExecutorJPAAuditService(emf);
ErrorInfoDeleteBuilder updateBuilder = 
auditService.errorInfoLogDeleteBuilder().dateRangeEnd(new Date());
int result = updateBuilder.build().execute();

RequestInfoLogDeleteBuilder updateBuilder2 = 
auditService.requestInfoLogDeleteBuilder().dateRangeEnd(new Date());
result = updateBuilder.build().execute();
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CHAPTER 20. LOCALIZATION AND CUSTOMIZATION

20.1. AVAILABLE LANGUAGES

The Red Hat JBoss BPM Suite web user interface can be viewed in multiple languages:

United States English (en_US)

Spanish (es_ES)

Japanese (ja_JP)

Simplified Chinese (zh_CN)

Traditional Chinese (zh_TW)

Portuguese (pt_BR)

French (fr_CA)

German (de_DE)

NOTE

If a language is not specified, US English is used by default.

NOTE

Dashbuilder does not support Traditional Chinese (zh_TW).

20.2. CHANGING LANGUAGE SETTINGS

Changing the User Interface Language in Business Central
By default, Business Central uses the system locale. If you need to change it, then append the required
locale code at the end of the Business Central URL. For example, the following URL will set the locale to
Portuguese (pt_BR).

http://localhost:8080/business-central/?locale=pt_BR

Changing the User Interface Language in Dashbuilder
To change the user interface language in dashbuilder, do the following:

1. Log into the dashbuilder after the server has been successfully started by navigating to
http://localhost:8080/dashbuilder in a web browser.

2. Select the language of your choice by clicking on the available locales on the top center of the
dashbuilder user interface to change the language.

Setting a Default User Interface Language in Dashbuilder
Following is an example to set the default user interface language in dashbuilder:

Procedure: Setting the Default Language as French

1. Navigate to jboss-eap-6.4/standalone/configuration and define the following in the 
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1. Navigate to jboss-eap-6.4/standalone/configuration and define the following in the 
standalone.xml file.

<system-properties>
  <property name="org.jboss.dashboard.LocaleManager.installedLocaleIds" 
value="en,es,de,fr,ja,pt,zh"/>
  <property name="org.jboss.dashboard.LocaleManager.defaultLocaleId" value="fr"/>
</system-properties>

2. The default user interface language of the dashbuilder is now set to French.

Defining the Installed Locales in Dashbuilder
Following is an example to define the installed locales in dashbuilder:

Procedure: Defining the Installed Locale

1. Navigate to jboss-eap-6.4/standalone/configuration and define the following in the 
standalone.xml file:

<system-properties>
  <property name="org.jboss.dashboard.LocaleManager.installedLocaleIds" 
value="en,es,de,fr,ja,pt"/>
   <property name="org.jboss.dashboard.LocaleManager.defaultLocaleId" value="fr"/>
</system-properties>

In this example, the Chinese language (zh) has been removed from the list of installed locales so users
will not be able to switch the dashbuilder to Chinese. Dashbuilder will show content in French, which is
the default locale. Users will be able to select other languages that are defined (en, es, de, ja, pt) in this
file.

NOTE

Within Business Central, the application server does not need to be restarted after
changing locale if you append the "locale" parameter to the URL of Business Central.
However, with Dashbuilder, the application server should be restarted after the
configuration files have been changed.

20.3. RUNNING THE JVM WITH UTF-8 ENCODING

Red Hat JBoss BPM Suite is designed to work with UTF-8 encoding. If a different encoding system is
being used by the JVM, unexpected errors might occur.

To ensure UTF-8 is used by the JVM, use the JVM option -Dfile.encoding=UTF-8.
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PART IV. EXECUTION

PART IV. EXECUTION

145



CHAPTER 21. PROCESS EXECUTION SERVER
CONFIGURATION

21.1. ASSIGNMENT RULES

Assignment rules are rules executed automatically when a Human Task is created or completed. This
mechanism can be used to assign a Human Task automatically to a particular user of a group or prevent
a user from completing a task in case of missing data.

21.1.1. Defining Assignment Rules

To define assignment rules:

1. In the DEPLOY_DIR/standalone/deployments/business-central.war/WEB-INF/classes/
directory, create one or both of the following files and define the assignment rules in these files:

default-add-task.drl: In this file, define the rules to be checked when the Human Task is
created.

default-complete-task.drl: In this file, define the rules to be checked when the Human Task
is completed.

Example 21.1. Example default-complete-task.drl File

package defaultPackage

import org.kie.api.task.model.Task;
import org.kie.api.task.model.User;
import org.kie.api.task.model.Status;
import org.kie.api.task.model.PeopleAssignments;
import org.jbpm.services.task.rule.TaskServiceRequest;
import org.jbpm.services.task.exception.PermissionDeniedException;
import org.jbpm.services.task.impl.model.*;
import java.util.HashMap;
import java.util.List;

global TaskServiceRequest request;

rule "Don't allow Mary to complete task when rejected"
  when
    $task : Task()
    $actualOwner : User( id == 'mary') from $task.getTaskData().getActualOwner()
    $params : HashMap(this["approved"] == false)
  then
    request.setAllowed(false);
    request.setExceptionClass(PermissionDeniedException.class);
    request.addReason("Mary is not allowed to complete task without approval.");
end

If user mary is one of the potential owners of a Human Task, the task will be automatically assigned
to this user.
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21.2. MAIL SESSION

A mail session defines mail server properties and is used for sending emails, for example when using an
Email Service Task or sending and receiving email notifications of Human Task escalation.

For more information, see the Email Task Attributes  section of the Red Hat JBoss BPM Suite User
Guide.

21.2.1. Setting up Mail Session

To set up a mail session for the execution engine:

1. Open the appropriate profile configuration file, standalone.xml or host.xml.

2. Add the mail session to the urn:jboss:domain:mail:1.2 subsystem:

<subsystem xmlns="urn:jboss:domain:mail:1.2">
  <!-- omitted code -->

  <mail-session jndi-name="mail/jbpmMailSession" debug="true" 
from="bpms@company.com">
    <smtp-server outbound-socket-binding-ref="bpmsMail"/>
  </mail-session>
</subsystem>

3. Define the session outbound socket:

<outbound-socket-binding name="bpmsMail">
  <remote-destination host="localhost" port="12345"/>
</outbound-socket-binding>
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CHAPTER 22. PROCESS MONITORING

22.1. JBOSS OPERATIONS NETWORK

You can use a JBoss Operations Network plug-in to monitor rule sessions in Red Hat JBoss BPM Suite.

Due to a limitation of passing the JVM monitoring arguments via the Maven command line, all 
com.sun.management.jmxremote.* parameters must be passed to the Red Hat JBoss BPM Suite
application via the pom.xml configuration file.

See the Installation Guide of Red Hat JBoss Operations Network  for installation instructions on the Red
Hat JBoss ON server.

22.2. SUPPORTED SERVICES WITH JBOSS OPERATIONS NETWORK

The services supported by JBoss Operations Network are listed in the rhq-plugin.xml file in the
relevant JBoss Operations Network plug-in or distribution. For example, in the JBoss BRMS plug-in
pack jon-plugin-pack-brms-bpms-3.3.0.GA, you can view all supported services and corresponding
operations and metrics in drools-rhq-plugin-6.5.0.Final-redhat-2.jar/META-INF/rhq-plugin.xml:

Example rhq-plugin.xml file for the JBoss BRMS plug-in with supported services

...

<service name="Kie Containers"
        description="The Kie Container monitoring service."
        discovery="org.rhq.plugins.jmx.MBeanResourceDiscoveryComponent"
        class="org.rhq.plugins.jmx.MBeanResourceComponent">

          <runs-inside>
             <parent-resource-type name="JMX Server" plugin="JMX"/>
          </runs-inside>

          <plugin-configuration>
             <c:simple-property name="objectName" readOnly="true" 
default="org.kie:kcontainerId=%kcontainerId%"/>
             <c:simple-property name="nameTemplate" readOnly="true" default="KieContainer 
{kcontainerId}"/>
             <c:simple-property name="descriptionTemplate" readOnly="true" default="A JMX bean for Kie 
Container {kcontainerId}"/>
             <c:simple-property name="kcontainerId" type="string" readOnly="true" description="The Kie 
Container Id"/>
          </plugin-configuration>

        <metric property="ConfiguredReleaseIdStr"
                description="The RelaseId configured while creating the KieContainer"
                displayName="Configured ReleaseId"
                dataType="trait"
                displayType="summary" />

        <metric property="ResolvedReleaseIdStr"
                description="The actual resolved ReleaseId"
                displayName="Resolved ReleaseId"
                dataType="trait"
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                displayType="summary" />

       <service name="Kie Bases"
                description="The Kie Base monitoring service."
                discovery="org.drools.rhq.plugin.ExposeKCIDValueFromParentDiscoveryComponent"
                class="org.rhq.plugins.jmx.MBeanResourceComponent">

          <plugin-configuration>
             <c:simple-property name="objectName" readOnly="true" default="org.kie:kcontainerId=
{kcontainerId},kbaseId=%kbaseId%"/>
             <c:simple-property name="nameTemplate" readOnly="true" default="KieBase {kbaseId}"/>
             <c:simple-property name="descriptionTemplate" readOnly="true" default="A JMX bean for Kie 
Base {kbaseId}"/>
             <c:simple-property name="kbaseId" type="string" readOnly="true" description="The Kie Base 
Id"/>
          </plugin-configuration>

          <operation name="startInternalMBeans"
                     displayName="Start Internal MBeans"
                     description="Starts all the internal dependent MBeans.">
          </operation>

          <operation name="stopInternalMBeans"
                     displayName="Stop Internal MBeans"
                     description="Stops all the internal dependent MBeans.">
          </operation>

           <service name="Kie Sessions"
                    description="The Kie Session monitoring service."
                    discovery="org.rhq.plugins.jmx.MBeanResourceDiscoveryComponent"
                    class="org.rhq.plugins.jmx.MBeanResourceComponent">

              <plugin-configuration>
                 <c:simple-property name="objectName" readOnly="true" default="org.kie:kcontainerId=
{kcId},kbaseId={kbaseId},ksessionType=Stateful,ksessionName=%sessionId%"/>
                 <c:simple-property name="nameTemplate" readOnly="true" default="KieSession 
{sessionId}"/>
                 <c:simple-property name="descriptionTemplate" readOnly="true" default="A JMX bean for 
Kie Base {kbaseId}, Kie session {sessionId}"/>
                 <c:simple-property name="kbaseId" type="string" readOnly="true" description="The Kie 
Base Id"/>
                 <c:simple-property name="sessionId" type="string" readOnly="true" description="The Kie 
Session Id"/>
              </plugin-configuration>

              <operation name="reset" displayName="Reset Metrics" description="Reset all metric 
counters."/>

              <operation name="getStatsForRule"
                         displayName="Get statistics for rule"
                         description="Get and return the statistics for a specific rule.">
                  <parameters>
                      <c:simple-property name="ruleName" displayName="Rule Name" required="true"/>
                  </parameters>
                  <results>
                      <c:simple-property name="stats"/>
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                  </results>
              </operation>

              <operation name="getStatsForProcess"
                         displayName="Get statistics for process"
                         description="Get and return the statistics for a specific process.">
                  <parameters>
                      <c:simple-property name="processId" displayName="Process ID" required="true"/>
                  </parameters>
                  <results>
                      <c:simple-property name="stats"/>
                  </results>
              </operation>

              <metric displayName="Total Fact Count" property="TotalFactCount"
                      description="The total number of facts in memory"
                      category="utilization" displayType="summary" measurementType="dynamic"/>

              <metric displayName="Total Matches Created" property="TotalMatchesCreated"
                      description="The total number of matches created since reset"
                      category="throughput" displayType="summary" measurementType="trendsup"/>

              <metric displayName="Total Matches Fired" property="TotalMatchesFired"
                      description="The total number of matches fired since reset"
                      category="throughput" displayType="summary" measurementType="trendsup"/>

              <metric displayName="Total Matches Cancelled" property="TotalMatchesCancelled"
                      description="The total number of matches cancelled since reset"
                      category="throughput" displayType="summary" measurementType="trendsup"/>

              <metric displayName="Total Firing Time" property="TotalFiringTime" units="milliseconds"
                      description="The total time spent firing rules since reset"
                      category="performance" displayType="summary" measurementType="trendsup"/>

              <metric displayName="Total Process Instances Started" 
property="TotalProcessInstancesStarted"
                      description="The total number of process instances started since reset"
                      category="throughput" displayType="summary" measurementType="trendsup"/>

              <metric displayName="Total Process Instances Completed" 
property="TotalProcessInstancesCompleted"
                      description="The total number of process instances completed since reset"
                      category="throughput" displayType="summary" measurementType="trendsup"/>

              <metric property="LastReset"
                      description="The timestamp of the last reset operation"
                      displayName="Last Reset"
                      dataType="trait"
                      displayType="summary" />

           </service>  <!-- /Kie Sessions -->

           <service name="Stateless Kie Sessions"
                    description="The stateless Kie Session monitoring service."
                    discovery="org.rhq.plugins.jmx.MBeanResourceDiscoveryComponent"
                    class="org.rhq.plugins.jmx.MBeanResourceComponent">
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              <plugin-configuration>
                 <c:simple-property name="objectName" readOnly="true" default="org.kie:kcontainerId=
{kcId},kbaseId={kbaseId},ksessionType=Stateless,ksessionName=%sessionId%"/>
                 <c:simple-property name="nameTemplate" readOnly="true" default="KieSession 
{sessionId}"/>
                 <c:simple-property name="descriptionTemplate" readOnly="true" default="A JMX bean for 
Kie Base {kbaseId}, Kie session {sessionId}"/>
                 <c:simple-property name="kbaseId" type="string" readOnly="true" description="The Kie 
Base Id"/>
                 <c:simple-property name="sessionId" type="string" readOnly="true" description="The Kie 
Session Id"/>
              </plugin-configuration>

              <operation name="reset" displayName="Reset Metrics" description="Reset all metric 
counters."/>

              <operation name="getStatsForRule"
                         displayName="Get statistics for rule"
                         description="Get and return the statistics for a specific rule.">
                  <parameters>
                      <c:simple-property name="ruleName" displayName="Rule Name" required="true"/>
                  </parameters>
                  <results>
                      <c:simple-property name="stats"/>
                  </results>
              </operation>

              <operation name="getStatsForProcess"
                         displayName="Get statistics for process"
                         description="Get and return the statistics for a specific process.">
                  <parameters>
                      <c:simple-property name="processId" displayName="Process ID" required="true"/>
                  </parameters>
                  <results>
                      <c:simple-property name="stats"/>
                  </results>
              </operation>

              <metric displayName="Total Objects Inserted" property="TotalObjectsInserted"
                      description="The total number of objects inserted on all sessions"
                      category="throughput" displayType="summary" measurementType="trendsup"/>
              <metric displayName="Total Objects Deleted" property="TotalObjectsDeleted"
                      description="The total number of objects deleted on all sessions"
                      category="throughput" displayType="summary" measurementType="trendsup"/>

              <metric displayName="Total Matches Created" property="TotalMatchesCreated"
                      description="The total number of matches created since reset"
                      category="throughput" displayType="summary" measurementType="trendsup"/>

              <metric displayName="Total Matches Fired" property="TotalMatchesFired"
                      description="The total number of matches fired since reset"
                      category="throughput" displayType="summary" measurementType="trendsup"/>

              <metric displayName="Total Matches Cancelled" property="TotalMatchesCancelled"
                      description="The total number of matches cancelled since reset"
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This example rhq-plugin.xml file for the JBoss BRMS plug-in contains the following services:

Kie Containers

Kie Bases

Kie Sessions

Stateless Kie Sessions

Each service contains operations and metrics that can be monitored as part of the service. For example,
the Kie Sessions service supports the operations reset, getStatsForRule, and getStatsForProcess,
and supports metrics such as Total Fact Count, Total Matches Created, and Total Matches Fired.

The specific services supported depend on the JBoss Operations Network plug-in or distribution that
you use.

22.3. INSTALLING THE JBOSS BRMS PLUG-IN INTO JBOSS ON

You can install the Red Hat JBoss BRMS plug-in for JBoss Operations Network either by copying the
plug-in JAR files to the JBoss Operations Network plug-in directory or through the JBoss Operations
Network GUI.

To copy the plug-in JAR files to the JBoss Operations Network plug-in directory, use the following
procedure:

Procedure: Copying the JBoss BRMS plug-in JAR files

1. Extract the JBoss BRMS plug-in pack archive to a temporary location. This creates a

                      category="throughput" displayType="summary" measurementType="trendsup"/>

              <metric displayName="Total Firing Time" property="TotalFiringTime" units="milliseconds"
                      description="The total time spent firing rules since reset"
                      category="performance" displayType="summary" measurementType="trendsup"/>

              <metric displayName="Total Process Instances Started" 
property="TotalProcessInstancesStarted"
                      description="The total number of process instances started since reset"
                      category="throughput" displayType="summary" measurementType="trendsup"/>

              <metric displayName="Total Process Instances Completed" 
property="TotalProcessInstancesCompleted"
                      description="The total number of process instances completed since reset"
                      category="throughput" displayType="summary" measurementType="trendsup"/>

              <metric property="LastReset"
                      description="The timestamp of the last reset operation"
                      displayName="Last Reset"
                      dataType="trait"
                      displayType="summary" />

           </service>  <!-- /Stateless Kie Sessions -->

       </service>  <!-- /Kie Bases -->

     </service>  <!-- /Kie Containers -->
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1. Extract the JBoss BRMS plug-in pack archive to a temporary location. This creates a
subdirectory with the name jon-plugin-pack-brms-bpms-3.3.0.GA. For example:

[root@server rhq-agent]# unzip jon-plugin-pack-brms-bpms-3.3.0.GA.zip -d /tmp

2. Copy the extracted JBoss BRMS plug-in JAR files from the jon-plugin-pack-brms-bpms-
3.3.0.GA/ directory to the JBoss ON server plug-in directory. For example:

[root@server rhq-agent]# cp /tmp/jon-plugin-pack-brms-bpms-3.3.0.GA/*.jar /opt/jon/jon-
server-3.3.0.GA/plugins

3. Start the JBoss Operations Network server to update the JBoss BRMS plug-in.

To upload the JBoss BRMS plug-in through the JBoss Operations Network GUI, use the following
procedure:

Procedure: Uploading the JBoss BRMS plug-in through GUI

1. Start the JBoss Operations Network Server and Log in to access the GUI.

2. In the top navigation of the GUI, open the Administration menu.

3. In the Configuration area on the left, select the Agent Plugins link.

4. At the bottom of the list of loaded agent plug-ins, click the Upload a plugin button and choose
the BRMS plugin.

5. The JBoss BRMS plug-in for JBoss Operations Network is now uploaded.

22.4. MONITORING KIE BASES AND KIE SESSIONS

In order for JBoss Operations Network to monitor KieBases and KieSessions, MBeans must be enabled.

MBeans can be enabled either by passing the parameter: -kie.mbeans = enabled or via the API:

KieBaseConfiguration kbconf = KieServices.Factory.get().newKieBaseConfiguration();
kbconf.setOption(MBeansOption.ENABLED);

NOTE

Kie Services have been implemented for JBoss BRMS 6; for JBoss BRMS 5, Drools 
Services was the naming convention used and it had different measurements on
sessions. For example, activation → match renaming occurred in the updated version.

Please refer to the Resource Monitoring and Operations Reference guide  of the Red Hat JBoss
Operations Network for information on importing Kie Sessions into the Inventory View for monitoring
purposes.
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CHAPTER 23. MANAGING SECURITY FOR RED HAT JBOSS
BPM SUITE DASHBUILDER

23.1. ACCESSING RED HAT JBOSS BPM SUITE DASHBUILDER

Dashbuilder is the Red Hat JBoss BPM Suite web-based user interface for Business Activity
Monitoring. To access the Dashbuilder from Business Central, go to Dashboards → Process & Task
Dashboards.

The displayed dashboard provides statistics on runtime data selected on the left. You can create your
own dashboard in the Dashbuilder. To do so, display the Dashbuilder by clicking Dashboards → Business
Dashboards.

23.2. MANAGING SECURITY

To manage security, you can define custom authorization policies to grant or deny access to workspace,
page, or panel instances per role.

Defined below is a list of the available roles for Dashbuilder:

admin: Administrates the Red Hat JBoss BPM Suite system. Has full access rights to make any
changes necessary. Also has the ability to add and remove users from the system.

developer: Implements code required for process to work. Mostly uses the JBDS connection to
view processes, but may use the web tool occasionally.:

analyst: Responsible for creating and designing processes into the system. Creates process
flows and handles process change requests. Needs to test processes that they create. Also
creates forms and dashboards.

user: Daily user of the system to take actions on business tasks that are required for the
processes to continue forward. Works primarily with the task lists.

manager: Viewer of the system that is interested in statistics around the business processes
and their performance, business indicators, and other reporting of the system and people who
interact with the system.

Thanks to the permissions system, you can build a workspace structure with several pages, menus, and
panels and define what pages and panels within a page will be visible for each role. You can also define
special types of users and give them restricted access to certain tooling features, or even restricted
access to a page subset.

23.3. WORKSPACE PERMISSIONS

Procedure: Accessing Workspace Permissions

1. Log into Business Dashboards from Business Central (as described in the Accessing Red Hat
JBoss BPM Suite Dashbuilder topic).

2. Select the appropriate Dashboard from the Wokspace drop-down:

Figure 23.1. Dashbuilder Workspace
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Figure 23.1. Dashbuilder Workspace

3. Click the  button to access the Workspace Dashboard.

4. Click the Permissions label to view the permission management screen.

Figure 23.2. Permissions Screen
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Figure 23.2. Permissions Screen

Under the Permissions section is a list of allowed actions that are applied to the selected role:

Access: Permission to login into the application.

Administrate: Permission to access the toolbar and system configuration features.

Create pages: Ability to create new project pages.

Edit: Permission to change the workspace properties.

Clear: Ability to delete the workspace.

Edit permissions: Ability to grant/deny permissions.

Change allowed panels: Permission to restrict the type of panels that can be used in this
workspace.

To assign a permission, you must select the target role and the list of actions allowed over the selected
resource:

Figure 23.3. Permissions assignment
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Figure 23.3. Permissions assignment

Target roles (who): What user will be granted/denied with the permissions defined.

Allowed actions : Depending on the type of the resource we can enable/disable what the user
can do on this resource.

Reverse (optional): When we have a set of roles and we want to grant/deny a permission to all
the roles but one.

NOTE

By default, the full set of permissions go to the role admin. This makes it easy to create a
user that can do everything as long as the role admin is assigned.

23.4. PAGE PERMISSIONS

1. To access Page permissions, locate the Pages drop-down under the jBPM Dashboard (or
whatever Dashboard you selected).

2. After expanding Pages, expand the Process dashboard option.

3. Select the Page permissions option.

Figure 23.4. Page Permissions
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Figure 23.4. Page Permissions

Under the Permissions section is a list of allowed actions that are applied to the selected role:

Visualize: Permission to make the page visible.

Edit: Ability to change the page properties.

Clear: Ability to delete the page.

Edit permissions: Ability to grant/deny permissions for the page.

23.5. PANEL PERMISSIONS

1. To access the Panel permissions page, expand the Panel instances option under the jBPM
Dashboard (or whatever Dashboard you are using).

2. Expand the Dashboard option and then expand the Process dashboard.

3. Expand the Panels choice and select the appropriate process.

4. Open the Panel permissions page.

Below is a screenshot of the permission management screen for a given panel (in this example, the
Process dashboard):

Figure 23.5. Panel permissions configuration screen
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Figure 23.5. Panel permissions configuration screen

Allowed actions are the following:

Visualize: Make the panel visible.

Edit: Change the panel properties.

Edit permissions: Ability to grant/deny permissions for the panel.
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APPENDIX A. CONFIGURATION PROPERTIES
This chapter contains all public system properties and KIE environment entries that you can use to
configure your deployment of Red Hat JBoss BPM Suite.

A.1. SYSTEM PROPERTIES

System properties configure the entire JVM Red Hat JBoss BPM Suite runs on. You can either provide
them at runtime, or set them in the configuration XML file for your deployment.

A.1.1. Runtime Configuration

To set a particular property at runtime, add a flag -D with the property’s name and value when starting
the server. You can list multiple such properties at the same time.

Configuring System Properties at Runtime (Standalone deployments)

1. Navigate to SERVER_HOME/bin.

2. Run the server with the desired flags:

./standalone.sh -Dorg.kie.custom.property=value -Dorg.uberfire.switch=false

NOTE

On Windows, run standalone.bat instead of standalone.sh.

A.1.2. XML Configuration

To set a property in Red Hat JBoss BPM Suite configuration, add an entry under the <system-
properties> section in the standalone.xml file:

When running Red Hat JBoss BPM Suite in domain mode, add the entries in the <system-properties>
element of the appropriate node in the host.xml file.

A.1.3. List of System Properties

This section contains the alphabetically sorted list of all recognized system properties in Red Hat JBoss
BPM Suite 6.4.

Red Hat JBoss BPM Suite System Properties

btm.root

Root directory for Bitronix Transaction Manager. The discovery of configuration and other files starts
in this location.

<system-properties>
  <property name="org.kie.custom.property" value="random_value"/>
  <property name="org.uberfire.switch" value="false"/>
  ...
</system-properties>
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Values Default

String N/A

drools.propertySpecific

Sets property reactivity behavior of the Red Hat JBoss BPM Suite engine. Options are following:

DISABLED: Property reactivity turned off.

ALLOWED: Property reactivity allowed.

ALWAYS: Property reactivity always on.

Values Default

DISABLED, ALLOWED, or ALWAYS ALLOWED

drools.ruleEngine

Specifies which algorithm the Red Hat JBoss BPM Suite rule engine should use.

Values Default

phreak or reteoo phreak

drools.sequential

Enables sequential mode for stateless sessions.

Values Default

true or false false

drools.sequential.agenda

Selects static or dynamic agenda with sequential mode.

Values Default

static or dynamic static for standard mode, dynamic for sequential
mode

jboss.node.name

A node name unique in a Red Hat JBoss BPM Suite cluster.

Values Default

String N/A
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jbpm.audit.jms.connection.factory

A link to a JMS connection factory instance.

Values Default

A javax.jms.ConnectionFactory instance N/A

jbpm.audit.jms.connection.factory.jndi

The JNDI name of the connection factory to look up.

Values Default

String N/A

jbpm.audit.jms.enabled

Indicates if audit mode is set to JMS.

Values Default

true if Audit mode is set to JMS, otherwise false N/A

jbpm.audit.jms.queue

A JMS Queue instance to be used when creating JMS AuditLogger.

Values Default

A javax.jms.Queue instance N/A

jbpm.audit.jms.queue.jndi

The JNDI name of the JMS queue to look up.

Values Default

String N/A

jbpm.audit.jms.transacted

Determines if the JMS session is transacted.

Values Default

true or false true

jbpm.business.calendar.properties

The location of the configuration file with Business Calendar properties.
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Values Default

Path /jbpm.business.calendar.properties

jbpm.data.dir

The location where data files produced by Red Hat JBoss BPM Suite must be stored.

Values Default

${jboss.server.data.dir} if available, otherwise 
${java.io.tmpdir}

${java.io.tmpdir}

org.jbpm.ejb.timer.tx

Marks if the EJB timer service is transactional. If set to true, the EJB time service starts participating
in the transactions. Note that this property is available only in Red Hat JBoss BPM Suite 6.4.2 and
later.

Values Default

true or false false

jbpm.enable.multi.con

Allows Web Designer to use multiple incoming or outgoing connections for tasks. If not enabled, the
tasks are marked as invalid.

Values Default

true or false false

jbpm.loop.level.disabled

Enables or disables loop iteration tracking to allow advanced loop support when using XOR gateways.

Values Default

true or false true

jbpm.overdue.timer.delay

Specifies the delay for overdue timers to allow proper initialization, in milliseconds.

Values Default

Number (Long) 2000

jbpm.overdue.timer.wait

A time period in which the timer execution service allows overdue timers to start, in milliseconds.

Red Hat JBoss BPM Suite 6.4 Administration and Configuration Guide

164



Values Default

Number (Long) 20000

jbpm.process.name.comparator

An alternative comparator class to empower the Start Process by Name feature.

Values Default

Fully qualified name org.jbpm.process.instance.StartProcessHel
per.NumberVersionComparator

jbpm.tm.jndi.lookup

Allows setting a specific TransactionManager JNDI lookup name as a fallback in case a standard
JNDI name is not used. If java:comp/UserTransaction does not implement the 
org.drools.persistence.TransactionManager interface, these names are used, in this order:

1. java:comp/TransactionManager

2. java:appserver/TransactionManager

3. java:pm/TransactionManager

4. java:TransactionManager

5. Value of this property

Values Default

JNDI name N/A

jbpm.usergroup.callback.properties

The location of the usegroup callback property file when org.jbpm.ht.callback is set to jaas or db.

Values Default

Path classpath:/jbpm.usergroup.callback.propert
ies

jbpm.user.group.mapping

An alternative classpath location of user info configuration (used by LDAPUserInfoImpl).

Values Default

Path ${jboss.server.config.dir}/roles.properties
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jbpm.user.info.properties

An alternative classpath location for user group callback implementation (LDAP, DB). For more
information, see org.jbpm.ht.userinfo.

Values Default

Path classpath:/userinfo.properties

jbpm.ut.jndi.lookup

An alternative JNDI name to be used when there is no access to the default one for user transactions
(java:comp/UserTransaction).

Values Default

JNDI name N/A

jbpm.v5.id.strategy

When enabled, Red Hat JBoss BPM Suite will use the process ID generation strategy from version 5
when migrating to version 6 and newer.

Values Default

true or false false

kie.maven.settings.custom

The location of a custom settings.xml file for Maven configuration.

Values Default

Path N/A

kie.server.jms.queues.response

The JNDI name of response queue for JMS.

Values Default

String queue/KIE.SERVER.RESPONSE

org.drools.server.ext.disabled

When set to true, disables the BRM support (for example rules support).

Values Default

true or false false
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org.drools.server.filter.classes

When set to true, the Drools Intelligent Process Server extension accepts custom classes annotated
by XmlRootElement or Remotable annotations only.

Values Default

true or false false

org.guvnor.inbox.disabled

When set to true, this system property disables the Inbox feature and the Inbox mechanism of
tracking changes to files is turned off. Doing this enables faster response to file system operations.

Values Default

true or false false

org.guvnor.m2repo.dir

The location where Maven artifacts are stored. When you build and deploy a project, it is stored in this
directory. Change the setting, for example, to allow easier backup of your maven repository.

Values Default

Path EAP_HOME/repositories/kie

org.guvnor.project.gav.check.disabled

Disables a duplicate GroupId, ArtifactId, and Version (GAV) detection. When you build and deploy a
project, Business Central scans the Maven repository for an artifact with the same GAV values. If set
to true, Business Central silently overrides any previous project. If set to false, the user is required to
confirm overriding the old project.

Values Default

true or false false

org.jbpm.deploy.sync.enabled

When enabled, Red Hat JBoss BPM Suite synchronizes KJAR deployments across Business Central
nodes in a cluster, and automatically loads previous deployments on restart.

Values Default

true or false true

org.jbpm.deploy.sync.int

Interval of KJAR deployment synchronization, in seconds.
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Values Default

Number (Integer) 3

org.jbpm.executor.service.ejb-jndi

Set this property in the application server in case your application uses EJBs. This property enables
you to configure the executor service JNDI name. For example, to have executor available from ejb-
services application (the deployed war application that uses EJBs), set this system property to 
jndi:java:global/ejb-services/ExecutorServiceEJBImpl.

Values Default

String jndi:java:module/ExecutorServiceEJBImpl

org.jbpm.ht.callback

Specifies the implementation of user group callback to be used:

mvel: Default; mostly used for testing.

ldap: LDAP; requires additional configuration in the jbpm.usergroup.callback.properties
file.

db: Database; requires additional configuration in the jbpm.usergroup.callback.properties
file.

jaas: JAAS; delegates to the container to fetch information about user data.

props: A simple property file; requires additional file that will keep all information (users and
groups).

custom: A custom implementation; you must specify the fully qualified name of the class in
the org.jbpm.ht.custom.callback.

Values Default

mvel, ldap, db, jaas, props, or custom jaas

org.jbpm.ht.custom.callback

A custom implementation of the UserGroupCallback interface in case the org.jbpm.ht.callback
property is set to custom.

Values Default

Fully qualified name N/A

org.jbpm.ht.custom.userinfo
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A custom implementation of the UserInfo interface in case the org.jbpm.ht.userinfo property is set
to custom.

Values Default

Fully qualified name N/A

org.jbpm.ht.userinfo

Specifies what implementation of the UserInfo interface to use for user or group information
providers.

ldap: LDAP; needs to be configured in the file specified in jbpm-user.info.properties.

db: Database; needs to be configured in the file specified in jbpm-user.info.properties.

props: A simple property file; set the property jbpm.user.info.properties to specify the
path to the file.

custom: A custom implementation; you must specify the fully qualified name of the class in
the org.jbpm.ht.custom.userinfo property.

Values Default

ldap, db, props, or custom N/A

org.jbpm.ht.user.separator

An alternative separator when loading actors and groups for user tasks from a String.

Values Default

String , (comma)

org.jbpm.rule.task.waitstate

When set to false, a business rule task automatically fires all rules instead of waiting to be triggered
from the process event listener or an outside call. This behavior prevents errors during heavy
multithreaded usage, however if org.jbpm.rule.task.waitstate is set to false, the business task is no
longer a safe point.
For information about safe points, see Chapter 17, Persistence.

NOTE

Starting with Red Hat JBoss BPM Suite 6.4 the default for 
org.jbpm.rule.task.waitstate is false. For more information, see the Red Hat JBoss
BPM Suite 6.4 Release Notes.
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Values Default

true or false false

org.jbpm.runtime.manager.class

A custom implementation of the org.kie.api.runtime.manager.RuntimeManagerFactory interface.

Values Default

Fully qualified name org.jbpm.runtime.manager.impl.RuntimeMa
nagerFactoryImpl

org.jbpm.server.ext.disabled

When set to true, disables the BPM support (for example, processes support).

Values Default

true or false true

org.jbpm.task.bam.enabled

Enables the BAMTaskEventListener class, which populates the BAMTASKSUMMARY table to
allow the BAM module to query tasks.

Values Default

true or false true

org.jbpm.task.cleanup.enabled

Enables the TaskCleanUpProcessEventListener class, which archives and removes completed
tasks with the associated process ID.

Values Default

true or false true

org.jbpm.ui.server.ext.disabled

When set to true, disables the Intelligent Process Server UI extension.

Values Default

true or false true

org.kie.auto.deploy.enabled

When enabled, issuing a Build & Deploy operation in Business Central always deploys to runtime.
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Values Default

true or false true

org.kie.build.disable-project-explorer

Disables automatic build of the selected project in Project Explorer.

Values Default

true or false false

org.kie.dd.mergemode

Selects the method for overriding hierarchical merge mode behavior when managing deployment
descriptors.

Values Default

MERGE_COLLECTIONS, KEEP_ALL, 
OVERRIDE_ALL, or OVERRIDE_EMPTY

MERGE_COLLECTIONS

org.kie.demo

Enables external cloning of a demo application from GitHub. This System Property takes precedence
over org.kie.example.

Values Default

true or false true

org.kie.example

When set to true, creates an example organization unit and repository. This system property allows
you to create projects and assets without creating your custom organization unit and repository. It is
useful, for example, to simplify the getting started experience.

Values Default

true or false false

org.kie.example.repositories

Sets the path to the directory containing example repositories. If you set this system property,
repositories in the specified directory are automatically cloned into Business Central during startup.
This property overrides org.kie.example and org.kie.demo.
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WARNING

You must download the example repositories from the Customer Portal and
extract them to this directory before setting this system property.

Values Default

Path N/A

org.kie.executor.disabled

Disables the Red Hat JBoss BPM Suite executor.

Values Default

true or false false

org.kie.executor.initial.delay

The initial delay before the Red Hat JBoss BPM Suite executor starts a job, in milliseconds.

Values Default

Number (Integer) 100

org.kie.executor.interval

The time between the moment the Red Hat JBoss BPM Suite executor finishes a job and the
moment it starts a new one, in a time unit specified in org.kie.executor.timeunit.

Values Default

Number (Integer) 3

org.kie.executor.pool.size

The number of threads used by the Red Hat JBoss BPM Suite executor.

Values Default

Number (Integer) 1

org.kie.executor.retry.count

The number of retries the Red Hat JBoss BPM Suite executor attempts on a failed job.
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Values Default

Number (Integer) 3

org.kie.executor.timeunit

The time unit in which the org.kie.executor.interval is specified.

Values Default

A java.util.concurrent.TimeUnit constant SECONDS

org.kie.git.deployments.enabled

When enabled, Red Hat JBoss BPM Suite uses a Git repository for storing deployments instead of a
database.

Values Default

true or false false

org.kie.mail.debug

When enabled, EmailWorkItemHandler produces debug logging for javax.mail.Session.

Values Default

true or false false

org.kie.mail.session

The JNDI name of the mail session as registered in the application server, for use by 
EmailWorkItemHandler.

Values Default

String mail/jbpmMailSession

org.kie.override.deploy.enabled

Allows overwriting deployments with the same GAV (not allowed by default).

Values Default

true or false false

org.kie.server.bypass.auth.user

Allows to bypass the authenticated user for task-related operations, for example queries.
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Values Default

true or false false

org.kie.server.controller

A comma-separated list of URLs to controller REST endpoints, for example 
http://localhost:8080/business-central/rest/controller. This property is required when using a
controller.

Values Default

Comma-separated list N/A

org.kie.server.controller.connect

The waiting time between repeated attempts to connect Intelligent Process Server to the controller
when Intelligent Process Server starts up, in milliseconds.

Values Default

Number (Long) 10000

org.kie.server.controller.pwd

The password to connect to the controller REST API. This property is required when using a
controller.

Values Default

String kieserver1!

org.kie.server.controller.token

This property allows you to use a token-based authentication between the KIE server and the
controller instead of the basic user name/password authentication. The KIE server sends the token
as a parameter in the request header. Note that long-lived access tokens are required as the tokens
are not refreshed.

Values Default

String N/A

org.kie.server.controller.user

The user name to connect to the controller REST API. This property is required when using a
controller.

Values Default

String kieserver
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org.kie.server.domain

The JAAS LoginContext domain used to authenticate users when using JMS.

Values Default

String N/A

org.kie.server.id

An arbitrary ID to be assigned to this server. If a remote controller is configured, this is the ID under
which the server will connect to the controller to fetch the KIE container configurations. If not
provided, the ID is automatically generated.

Values Default

String N/A

org.kie.server.location

The URL of the Intelligent Process Server instance used by the controller to call back on this server,
for example: http://localhost:8230/kie-server/services/rest/server. This property is required when
using a controller.

Values Default

URL N/A

org.kie.server.persistence.dialect

The Hibernate dialect to be used. You must set this property when enabling BPM support.

Values Default

String N/A

org.kie.server.persistence.ds

A data source JNDI name. You must set this property when enabling BPM support.

Values Default

String N/A

org.kie.server.persistence.schema

The database schema to be used.

Values Default

String N/A
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org.kie.server.persistence.tm

A transaction manager platform for Hibernate properties set. You must set this property when
enabling BPM support.

Values Default

String N/A

org.kie.server.pwd

The password used to connect with the KIE server from the controller, required when running in
managed mode. You must set this property in Business Central system properties, and it is required
when using a controller.

Values Default

String kieserver1!

org.kie.server.repo

The location where Intelligent Process Server state files will be stored.

Values Default

Path .

org.kie.server.sync.deploy

Instructs the KIE server to hold the deployment until the controller provides the containers
deployment configuration. This property affects only the KIE servers running in managed mode. The
options are as follows:

false; the connection to the controller is asynchronous. The application starts, connects to
the controller and once successful, deploys the containers. The application accepts requests
even before the containers are available.

true; the deployment of the KIE server application joins the controller connection thread with
the main deployment and awaits its completion.
This option can lead to a potential deadlock in case more applications are on the same server
instance. It is strongly recommended to use only one application (the KIE server) on one
server instance.

Values Default

true or false false

org.kie.server.token

This property allows you to use a token-based authentication between the controller and the KIE
server instead of the basic user name/password authentication. The controller sends the token as a
parameter in the request header. Note that long-lived access tokens are required as the tokens are
not refreshed.
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Values Default

String N/A

org.kie.server.user

The user name used to connect with the KIE server from the controller, required when running in
managed mode. This property need to be set in Business Central system properties and is required
when using a controller.

Values Default

String kieserver

org.kie.task.insecure

Allows an authenticated user to work on tasks on behalf of other users through the Business Central
runtime remote API.

Values Default

true or false false

org.kie.timer.ejb.disabled

If you select the Singleton runtime strategy and use the EJB executor of your application server to
handle timer events, a race condition may occur since the EJB executor completes a transaction
outside the KieSession. Set this property to true to use the EJB executor bundled with Red Hat
JBoss BPM Suite, which prevents this situation from happening.

Values Default

true or false false

org.kie.verification.disable-dtable-realtime-verification

Disables Business Central’s decision table verification and validation feature.

Values Default

true or false false

org.optaplanner.server.ext.disabled

When set to true, disables the BRP support (for example planner support).

Values Default

true or false false
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org.quartz.properties

The location of the Quartz configuration file to activate the Quartz timer service.

Values Default

Path N/A

org.uberfire.cluster.autostart

Delays VFS clustering until the application is fully initialized to avoid conflicts when all cluster
members create local clones.

Values Default

true or false false

org.uberfire.cluster.id

The name of the Helix cluster, for example: kie-cluster. You must set this property to the same value
as defined in the Helix Controller.

Values Default

String N/A

org.uberfire.cluster.local.id

The unique ID of the Helix cluster node. Note that ':' is replaced with '_', for example node1_12345.

Values Default

String N/A

org.uberfire.cluster.vfs.lock

The name of the resource defined on the Helix cluster, for example: kie-vfs.

Values Default

String N/A

org.uberfire.cluster.zk

The location of the Zookeeper servers.

Values Default

String of the form 
host1:port1,host2:port2,host3:port3,…

N/A
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org.uberfire.domain

The security domain name for Business Central. For more information about security domains, see
chapter Use a Security Domain in Your Application  of the Red Hat JBoss EAP Security Guide .

Values Default

String ApplicationRealm

org.uberfire.metadata.index.dir

The location of the .index directory, which Apache Lucene uses when indexing and searching.

Values Default

Path Current working directory

org.uberfire.nio.git.daemon.enabled

Enables the Git daemon.

Values Default

true or false true

org.uberfire.nio.git.daemon.host

If the Git daemon is enabled, it uses this property as the localhost identifier.

Values Default

URL localhost

org.uberfire.nio.git.daemon.port

If the Git daemon is enabled, it uses this property as the port number.

Values Default

Port number 9418

org.uberfire.nio.git.dir

The location of the directory .niogit. Change the value for example for backup purposes.

Values Default

Path Current working directory

org.uberfire.nio.git.hooks

The location where default Git hook files are stored. These files will be copied to newly created Git
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The location where default Git hook files are stored. These files will be copied to newly created Git
repositories.

Values Default

Path N/A

org.uberfire.nio.git.ssh.cert.dir

The location of the directory .security. Local certificates are stored here.

Values Default

Path Current working directory

org.uberfire.nio.git.ssh.enabled

Enables the SSH daemon.

Values Default

true or false true

org.uberfire.nio.git.ssh.host

If the SSH daemon is enabled, it uses this property as the localhost identifier.

Values Default

URL localhost

org.uberfire.nio.git.ssh.passphrase

The passphrase to access your operating system’s public keystore when cloning Git repositories with
scp-style URLs, for example git@github.com:user/repository.git.

Values Default

String N/A

org.uberfire.nio.git.ssh.port

If the SSH daemon is enabled, it uses this property as the port number.

Values Default

Port number 8001

org.uberfire.secure.alg

The crypto algorithm used by password encryption.
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Values Default

String PBEWithMD5AndDES

org.uberfire.secure.key

A secret password used by password encryption.

Values Default

String org.uberfire.admin

org.uberfire.sys.repo.monitor.disabled

Disables the configuration monitor.

WARNING

Do not use unless you are certain what you are doing.

Values Default

true or false false

A.2. ENVIRONMENT PROPERTIES

As opposed to system properties, environment properties are passed to an individual KieSession,
allowing you to control its behaviour independently on the rest of the deployment.

The properties available to you are the constants of the class org.kie.api.runtime.EnvironmentName.

A.2.1. Configuration

To set the environment properties on a KieSession, you can create a new session with an instance of
the Environment or RuntimeEnvironment interface:

Setting Environment Property using Environment interface

Setting Environment Property using RuntimeEnvironment interface



Environment env = EnvironmentFactory.newEnvironment();
env.set(EnvironmentName.SAMPLE_PROPERTY, true);
kbase.newKieSession(null, env);
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A.2.2. List of Environment Properties

This section contains the alphabetically sorted list of all recognized environment properties in Red Hat
JBoss BPM Suite 6.4.

Red Hat JBoss BPM Suite Environment Properties

APP_SCOPED_ENTITY_MANAGER

The entity manager used for persistence of SessionInfo. You can specify it when using Spring with
local transactions and a shared entity manager.

Values Default

An instance of EntityManager Automatically created from the provided 
EntityManagerFactory

CALENDARS

This property is not used.

CMD_SCOPED_ENTITY_MANAGER

The entity manager used for persistence of entities (process instances, tasks, work items). You can
specify it when using Spring with local transactions and a shared entity manager.

Values Default

An instance of EntityManager Automatically created from the provided 
EntityManagerFactory

DATE_FORMATS

This property is not used.

ENTITY_MANAGER_FACTORY

The EntityManagerFactory used in the Red Hat JBoss BPM Suite engine.

Values Default

An instance of EntityManagerFactory N/A

GLOBALS

RuntimeEnvironment environment = RuntimeEnvironmentBuilder.Factory.get()
.newDefaultBuilder()
....

environment.getEnvironment().set(EnvironmentName.SAMPLE_PROPERTY, true);
singletonManager = 
RuntimeManagerFactory.Factory.get().newSingletonRuntimeManager(environment);
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Values Default

Any object declared in DRL or BPMN N/A

OBJECT_MARSHALLING_STRATEGIES

Enable use of pluggable variable persistence strategies. Allows storing variables in different data
stores.

Values Default

An instance of 
org.kie.api.marshalling.ObjectMarshallingSt
rategy

Dependent on the engine configuration. If no other
strategy is available, 
org.drools.core.marshalling.impl.Serializabl
ePlaceholderResolvingStrategy is used.

PERSISTENCE_CONTEXT_MANAGER

The ProcessPersistenceContextManager instance used for process persistence.

Values Default

An instance of 
org.jbpm.persistence.ProcessPersistenceC
ontextManager

An instance of 
org.jbpm.persistence.JpaProcessPersisten
ceContextManager

TASK_PERSISTENCE_CONTEXT_MANAGER

The TaskPersistenceContextManager instance used for task persistence.

Values Default

An instance of 
org.kie.internal.task.api.TaskPersistenceCo
ntextManager

An instance of 
org.jbpm.services.task.persistence.JPATas
kPersistenceContextManager

TASK_USER_GROUP_CALLBACK

Get the UserGroupCallback instance from the environment or context. For example:

Values Default

Configured by Red Hat JBoss BPM Suite An instance of 
org.kie.internal.task.api.UserGroupCallback

TASK_USER_INFO

Get the UserInfo instance from the environment or context. For example:

callback = context.get(EnvironmentName.TASK_USER_GROUP_CALLBACK)
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Values Default

Configured by Red Hat JBoss BPM Suite An instance of 
org.kie.internal.task.api.UserInfo

TRANSACTION

Optional property if UserTransaction can not be obtained using JNDI lookup.

Values Default

An instance of UserTransaction null

TRANSACTION_MANAGER

Get the TransactionManager instance from the environment or context. For example:

Values Default

An instance of TransactionManager Depends on your configuration

TRANSACTION_SYNCHRONIZATION_REGISTRY

Allows access to and control of the active transaction. Used by Red Hat JBoss BPM Suite to
efficiently manage persistence.

Values Default

An instance of 
TransactionSynchronizationRegistry

Taken from the environment—usually JNDI lookup
in JTA environments

USE_LOCAL_TRANSACTIONS

When enabled, Red Hat JBoss BPM Suite uses local transactions as opposed to JTA.

Values Default

true or false false

USE_PESSIMISTIC_LOCKING

When enabled, a database resource can only be accessed by one transaction at a time.

info = context.get(EnvironmentName.TASK_USER_INFO)

info = context.get(EnvironmentName.TRANSACTION_MANAGER)
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Values Default

true or false false
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APPENDIX B. VERSIONING INFORMATION
Documentation last updated on: Monday, May 13, 2019.
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